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Important precautions

Translation policy

i-2

WARNING

This Service Manual is available in English only.

English

If a customer’s service provider requires a language otherthan English, it
is the customer’s responsibility to provide translation services.

Do not attempt to service the equipment unless this Service Manual has
been consulted and is understood.

Failure to heed this Warning may result in injury to the service provider,
operatoror patient from electric shock, mechanical or other hazards.

AVERTISSEMENT

Ce manuel de maintenance estdisponible en anglais uniquement.

Siun client de la personne responsable de lamaintenance demande une
langue autre que l'anglais, il estde la responsabilité du client de fournirles
services de traduction.

N'essayez pas d'effectuer vous-méme lamaintenance de I'équipement
avant d'avoir préalablementlu et compris le manuel de maintenance.

Le non-respect cetavertissement peut entrainer des blessures duesaun
choc électrique, une défaillance mécanique ou a d'autres éléments
dangereux chezlapersonne en charge de la maintenance, I'opérateurou
le patient.

ADVERTENCIA

Este Manual de servicio esta disponible enidioma inglés Gnicamente.

Espariol

(ES)

Siun proveedorde servicio del cliente requiere unidioma distinto, es
responsabilidad del cliente ofrecer servicios de traduccion.

No intente reparar el equipo a menos que haya consultadoy comprendido
este Manual de servicio.

Sino prestaatencion a esta Advertencia, se pueden ocasionar lesiones al
proveedor de servicio, al operador o al paciente por descarga eléctrica,
por riesgos mecanicos o de otra indole.

;z System view Versana Premier — Basic Service Manual
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WARNUNG

Dieses Wartungshandbuch ist nur auf Englisch verfigbar.

Deutsch

(DE)

Wenn der Kundendiensttechniker eines Kunden eine andere Sprache als
Englisch bendtigt, unterliegt es der Verantwortung des Kunden eine
Ubersetzung anfertigen zu lassen.

Warten Sie das Gerat nur, wenn Sie dieses Wartungshandbuch gelesen
und verstanden haben.

Die Nichtbeachtung dieses Warnhinweises kann zu Verletzungen des
Kundendiensttechnikers, Anwenders oder Patienten durch Stromschlage,
mechanische oderandere Gefahren fuhren.

AVVERTENZA

Il presente Manuale diassistenza & disponibile solo in inglese.

3 jtaliano

Seil fornitore di servizidi un cliente ne richiede una copia in una lingua
diversadall'inglese, & responsabilita del cliente fornire il servizio di
traduzione.

Non tentare di riparare |'apparecchio se questo Manuale di assistenzanon
e statoletto e compreso.

Il mancato rispetto di questa avvertenza pud comportare il rischio di
lesioni al fornitore di servizi, all'operatore o al paziente causate da scosse
elettriche o da pericoli di origine meccanica o di altro tipo.

WAARSCHUWING

Deze servicehandleidingis alleen beschikbaarin het Engels.

Z Nederlands

Als de serviceleverancier van een klantvraagt om eenandere taaldan
Engels, is hetde verantwoordelijkheid van de klant om eenvertaalde
versie te bieden.

Probeergeen onderhoud aan de apparatuur uit te voeren tenzijdeze
servicehandleidingis geraadpleegd en begrepen.

Het niet opvolgen van deze waarschuwing kan bij de serviceleverancier,de
operator of de patiéntleiden tot letsel door elektrische schokken,
mechanische of andere gevaren.
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ADVERTENCIA

Este Manual de Manutencdo esta disponivel apenas em Inglés.

»n e Casoumprestadorde servicos do cliente solicite 0 manual emidioma
‘g diferente doinglés, é de responsabilidade do cliente o fornecimento de
o servicos de traduc3o.
'é * N3o tente realizara manutencdo do equipamento antesde lere
o compreender este Manual de manutenc3o.
o ¢ O ndo cumprimento destaadverténcia pode resultar em danos por choque
(PT-BR) elétrico e riscos mecanicos para o prestador de servicos, operadorou
paciente.
HOIATUS!
Service Manual (Hooldusjuhend) on saadaval ainult ingliskeelsena.
— e Kuikliendi teenusepakkujandue on, etjuhend oleks mGnes muus keeles,
b7 korraldab juhenditdlkimise klient.
LQL)I e Tutvuge enne seadme hooldustddde tegemist kindlasti juhendiga Service
Manual (Hooldusjuhend).
(ET) e Selle n6ude eiramise korral voib teenindaja, kasutaja vOi patsient saada
elektrilo6gi, samuti voivad kaasneda muud ohud.
OPOZORILO
g Ta servisni prirocnik je na voljo samov angles¢ini.
‘O ¢ Ceponudnik servisnih storitev za stranko potrebuje navodilav drugem
’8 jeziku, morastranka sama poskrbetiza prevajanje.
() * Neposkusajte servisiratiopreme, ne da bi prej prebrali in razumeli servisni
8 eriroénik.
n e Cetegaopozorila ne upostevate, obstaja nevarnost elektricnega udara,
mehanskih ali drugih nevarnostiin posledi¢nih poskodb ponudnika
(St) servisnih storitev, uporabnika opreme ali pacienta.
% System view Versana Premier — Basic Service Manual
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VARNING

Den hér servicehandboken finns endast pa engelska.
e Om enkunds servicetekniker kraver ettannat sprak &n engelska ar det
kundens ansvar att tillhandahélla en versatt version.
* Forsokinte att utféra service pa utrustningen om du inte har last
igenom och forstatt den héar servicehandboken.
e Omduinte tar hansyntill denhar varningen kan serviceteknikern,
(sV) operatdren eller patienten utsattas for elektriska stotar eller
mekaniska eller andra faror, vilketkan leda till personskador.
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NPEAYNPEXAEHUE

[laHHOE PYKOBOACTBO N0 06CAYHKUBAHUIO JOCTYNHO TONBKO HAa aHTMIACKOM

A3bIKE.

e ECAM CNEUMANUCTy N0 TEXHUUECKOMY 06CAYHMBAHUIO KNMeHTa TpebyeTca
ZAOKYMEHTaUMA Ha KAKOM-NMDBO0 APYrom A3blKe, OTBETCTBEHHOCTb 33
BbINONHEHWE NePEBOAa BO3NAraeTCA Ha KAMEHTA.

® Mpuctynaiite K 06cAyRMBaHUIO 060PYA0BaHMA TONBKO NOCAE TOTO, KaK
U3yunTe AaHHOE PYKOBOACTBO N0 06CAYKMBAHMIO U NOAHOCTBIO NOMMETE
ero cofiepiKaHue.

* HecobnwogeHue faHHOTO Tpe6OBaHUA MOKET NPUBECTU K TDABMUPOBAHUIO
CNEeuManmcTa no TEXHMUYECKOMY 0BCNYKMBAHMIO, NONB30BATENA UNU
NauueHTa BCNEACTBUE NOPAKEHUA SNEKTPUUECKUM TOKOM, MEXaHUUECKUX
1 NPOUYMX NOBPEKAEHUN.

OSTRZEZENIE

Niniejszy podrecznik serwisowy jest dostepny wytacznie w jezyku angielskim.

e Jezelidostawcaustugklienta postuguje sie jezykiem innym niz angielski, za
zapewnienie ustug ttumaczeniowych odpowiadaklient.

® Przed przystapieniem do czynnosciserwisowych nalezy zapoznacsie z
informacjamizawartymi w niniejszym podreczniku serwisowymije
zrozumiec.

e W przeciwnym wypadku dostawca ustug, operator lub pacjentmoga
odniesc¢ obrazeniaspowodowane porazeniem pragdem elektrycznym,
dziataniem elementéw mechanicznych lub innymizagrozeniami.

System view Versana Premier — Basic Service Manual
5789130-100 English Rev.5



MPOEIAOMNOIHZH

To mapov Eyxelpidio o£pPig SratiBetat povo ota AyyAKda.

® EQv O apoyogo£pPLg TOU MEAQTN MALTEL YAWOOW EKTOG TWV AYYALKWY, N

TP OXN LETADPACTIKWV UTNNPECLWY AmoTeAEL euBUVN TOU TEEAATN.

MnV ETUXELPNOETE VA ETULOKEUAOETE TOV £EOMALOWO £QvV tpwta Sev

OUMPBOUAEUTELTE KAULKATAVONOETE TO T POV Eyxetpidio o£ppLc.

®  J=TEPUTTWON KN THPNONGTNG A poUoagPOELSomoinong, evaEXsTaLva

(EL) TPOKANBEL TPUUHATIONOE OTOV TAPOXO GEPPLG, TO XELPLOTH 1 ToV acBevn
e€autiagnAekTpomAngiag KaBwe Kot LNYaviKwy ) AAwv KEUvwv.

EAANVIKG

FIGYELMEZTETES

A szervizkézikényv kizardlag angol nyelven érhetd el.

a e Amennyiben az tgyfélszolgaltatéjanak nemfelelmegaz angol nyelvi

3 dokumentacio, ugy a forditasrol az tgyfélnek kell gondoskodnia.

© e Kizarolag ugy lasson hozza a berendezés karbantartasahoz, hogy elolvasta
= ésmegértette aszervizkézikonyvben foglaltakat.
(HU) e Ezenfigyelmeztetés figyelmen kivil hagyasa esetén aszolgaltato, a kezeld

vagy a paciens dramutést, mechanikus séralést vagy mas veszély altal
okozottszemélyisérulést szenvedhet.

VAROVANIE

Tato servisna prirucka je dostupnaiba v anglickom jazyku.

* Akposkytovatel'sluZieb zakaznikom vyzadujeiny jazyk ako anglicky jazyk,
jeho povinnostou je zabezpecit prekladatelské sluzby.

* Zariadenie nepouiivajte bez precitania a porozumeniatejto servisnej
prirucky.

* NedodrZanie tejto vystrahy méze viest k zraneniu poskytovatelasluZieb,
operatoraalebo pacienta spdsobeného elektrickym Sokom, mechanickym
aleboinym nebezpecenstvom.

Z Slovenéina
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esky

0
(Cz)

= Turkge

VYSTRAHA

Tato servisnipfirucka je k dispozici pouze v anglictiné.

* Pokud poskytovatelsluzby zakaznikovipozaduje jiny jazyk neZ anglictinu,
je odpovédnostizakaznika poskytnout sluzby prekladu.

* Nepokousejtese provadétservis zafizeni, dokud sineprostudujete a
neporozumite servisnipfirucce.

e Nevénovanipozornostitéto vystraze mizZe zphsobit poskytovatelisluzeb,
obsluze nebo pacientoviuraz elektrickym proudem, mechanickad nebo jina
nebezpedi.

UYARI

Servis Kilavuzu yalnizca ingilizce olarak mevcuttur.

e Miusterinin servis saglayicisi icin kilavuzun ingilizce diginda bagka bir dile
cevrilmesigerekiyorsa ceviri hizmetisaglamak musterinin sorumlulugudur.

® Bu ServisKilavuzu'na bakip talimatlari anlamadan ekipmanikullanmaya
caligmayin.

® Bu Uyarinin gz ardi edilmesiservis saglayicisinin, operatériinveya
hastanin, elektrik carpmasi, mekanik ariza ya da diger tehlikeler nedeniyle
yaralanmasina neden olabilir.

ADVARSEL

Denne servicemanual fas kun pa engelsk.
® Hvis en kundes tjenesteudbyder kraever etandet sprogend engelsk, erdet

= kundensansvar at sgrge for oversaettelsesydelserne.
8 * Forsggikke at udfgre service pa udstyret, medmindre denne
© servicemanualer laest og forstaet.
= * Manglende overholdelse af denne advarsel kan medfore skade pa
(DA) serviceudbyderen, operatgren eller patienten som fglge af elektrisk stad,
mekaniske ellerandre farer.
% System view Versana Premier — Basic Service Manual
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ADVARSEL

Denne servicehandboken er bare tilgjengelig pa engelsk.

® Hvis en kundes tjenestetilbyder krever etannet sprak enn engelsk, erdet
kundens ansvar 4 tilby oversettelsestjenester.

e |kke forsgk a utfere service pa utstyretfor denne servicehandboken er lest
og forstatt.
Dersom detikke tas hensyntil denne advarselen, kan detfore tilskader pa
tjenestetilbyderen, operatgren eller pasienten fra elektrisk stat,
mekaniske ellerandre farer.

Norsk

(NO)

VAKAVA VAROITUS

Tama huolto-opas on saatavana vain englanniksi.
e Josasiakkaan palveluntarjoaja tarvitsee oppaan jollain muulla kielella,
kaannospalveluiden hankkiminen on asiakkaan vastuulla.

e Laitetta eisaa huoltaa ellei huolto-oppaaseen ole sita ennen tutustuttu

1)) huolellisesti.

(FI) e Jostata varoitustaei noudateta, palveluntarjoaja, kayttaja taipotilas
saattaa saada sahkdiskun, ja saattaa aiheutua mekaanisia tai muita
vaurioita.

NPEAYMPEXAEHVE

HacToAwoTo Cepsu3HO PbKOBOACTEO C& NPeAnara camo Ha aHrMICKU e3UK.

®  AKOOCTaBUYMKDT HA CEPBU3HM YCAYTM HA KNNEHTa U3UCKBA PbKOBOACTBO
Ha e3MK, KOMTO Ce Pa3nnyasa OT aHIUICKUA, KNMEHTBT MMa OTFOBOPHOCT
[a OCUrypu afieKBaTeH Npeso .

* He npasete onuTu 3a cepeuns Ha obopyaeaHeTo, 6e3aa nposepuTe U 4a
pasbepeTe cbBeTUTe B CEPBU3HOTO PHKOBOACTEO.

* Hecna3eaHeTo Ha TOBa NpeaynpeXaeHUe MosKe A4a 10Be e 10

(BG) HapaHABaHe Ha 0CTaBUYMKA Ha CePBU3HM YCAYTW, ONepaTopa uam

nauueHTa BCIeACTBUE HAa TOKOB yAap, MEXaHUYHA UM APYTY ONacHOCTH.

Bbvnrapcku
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AVERTISMENT

Acestmanual de service este disponibil doar in engleza.
e Daca furnizorul de servicii al unui client solicita alta limba decatengleza,

)

<§ este responsabilitatea clientuluisa ofere servicii de traducere.

= ® Nuincercati sa efectuatilucrari de service asupra echipamentului, in afara

o) de cazul cand ati consultat acest manual de service si l-ati inteles.

o * Nerespectareaacestuiavertisment poate aveacarezultat ranirea
(RO) furnizorului de servicii, a operatoruluisau a pacientuluica urmare a

electrocutarii, pericolelor mecanice sau a altor pericole.
UPOZORENIJE
Ovaj servisniprirucnik dostupan je samo na engleskom jeziku.

- e Akoklijentov serviser zahtijeva jezik kojinije engleski, odgovornostklijenta
% je pruZiti usluge prijevoda.

© * Nemojte pokusavatiservisiratiopremu ako niste procitali i razumjeli

E servisniprirucnik.
I * Akone postujete ovo upozorenje, moZe docido ozljede servisera,
(HR) operateraili pacijenta prouzrocene strujnim udarom, mehanickimidrugim

opasnostima.
|SPEJIMAS

Y Sis prieZiGros vadovas galimas tik angly kalba.

=5 e Jeiklientopaslaugy teikéjas reikalauja kitos kalbos nei angly, klientas
> atsako uZ vertimo paslaugos teikima.

= e Atlikite jrangos prieZilra tik gerai susipaZine su prieZiaros vadovuir jj
-g suprate.

Nesilaikant Sio jspéjimo galimas paslaugos teikéjo, operatoriaus ar
(LtT) paciento suzeidimas dél elektros Soko, mechaninio ar kito pavojaus.
% System view Versana Premier — Basic Service Manual
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Latviski

(Lv)

Srpski

(SR)

Portugués
(Portugal)

o
I,
o

&l

BRIDINAJUMS

Siapkalpes rokasgramata ir pieejama tikai anglu valoda.

Ja klienta pakalpojumu sniedz&jam ir nepiecieSama cita valoda, kas nav
anglu valoda, klienta pienakums ir nodrosinat tulkojumu.
Neméginietapkalpot aprikojumu, ja apkalpes rokasgramata navizlasita un
izprasta.

Ja Sis bridinajums netiek ievérots, pakalpojumu sniedzéjs, operators vai
pacients var gut traumas no elektroSoka vaivar rasties mehanisks vai cita
veidaapdraudéjums.

UPOZORENIJE

Ovaj prirucnik za servisiranje dostupan je samo na engleskom jeziku.

Ako klijentov serviser zahteva jezik koji nije engleski, odgovornostje na
klijentu da pruZi usluge prevodenja.

Nemojte da pokusavate daservisirate opremu ako prethodno niste
procitali i razumeli ovaj prirucnik.

Ako ne postujete ovo upozorenje, moZe docido povredivanja servisera,
operateraili pacijenta uzrokovanog elektricnim udarom, mehanickimi
drugim opasnostima.

AVISO

Este manual de assisténcia esta disponivelapenas em inglés.

Se o prestador de servicos de assisténcia do cliente necessitar do manual
noutroidioma, a disponibilizacdo dos servicos de traducéo é da
responsabilidade do cliente.

N3o tente reparar o equipamento se n3o tiver consultado e compreendido
este manual de assisténcia.

O ndo cumprimento das instrugdes constantes neste aviso pode resultar
em ferimentos no prestador de servicos de assisténcia, no operadorou no
paciente devido a choques eléctricos, perigos mecanicos ou outros
problemas.

Versana Premier — Basic Service Manual . System view
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YKpaiHCbKa

(UK)

Bahasa
Indonesia

(1D)

MNONEPEAMEHHA

Llei nocibHMK i3 TexHiUHOro 06cnyrosyBaHHA AOCTYNHUIA TULLE aHTNTMCHKOK
MOBOHO.

AKLWO NOCTayanbHUKY NOCAYT i3 TeXHIYHOro obcnyroeyBaHHA NoTpiGHa
iHbopMaLia MOBOI, BIAMIHHOKO Bif, aHINIMCbKOI, BIANOBIAANbHICTb 33
HaZaHHA NOCAYr NepeKknay Hece Kopu1cTysad.

TexHiuHe o6cnyrosysaHHA 061a4HAHHA MOXKHAE BUKOHYBaTU IULLE NiCA
03HaMOMNEHHA 3 NOCIBHMKOM i3 TeXHIUHOro 06cnyroByBaHHATa
yCBIAOMAEHHA MOro 3MICTy.

He0TpyMaHHA UbOro nonepeayKeHHA MOXKe NPpU3BecTn 40 Tpasm
nocTayanbHMKa nocayr, onepartopaabo naujeHTa, CNpUYMHEHUX AiEr0
€N1eKTPUYHOIO CTPYMY, MeXaHiuHMX ab0 IHWKMX NOLWKOAMXKEHD.

PERINGATAN

Panduan Servis ini hanya tersedia dalam Bahasa Inggris.

Jika penyedialayanan pelanggan memerlukan bahasadi luar Bahasa
Inggris, maka pelanggan bertanggung jawab untuk memberikan layanan
tersebut.

Jangan mencoba menyervis peralatan ini, kecuali Panduan Servis ini telah
dijadikan rujukan dan dipahami dengan baik.

Kelalaian memperhatikan Peringatan ini dapat menyebabkan cedera
terhadap penyedialayanan, operator, atau pasien akibat bahaya kejutan
listrik, mekanik, dan bahaya lainnya.

o A
AUADH

DIDTDI IO =MD INUINITT

o ® wing Wusn1sua9gnAtAaIn1saiu M manuaniuiiaaInamaing
o anArAauniugsuinsaulumsaninsgagiagasiigeatiunla
= P o W oim . v e . P
(TH) e Tlspadrdasirgalnsailnalaifinm uasninaaailagiiagdasiigail
e winlidjiamaaniavitatadanaludmusnis dldevansa
wiadlaglasuuiniduanlvlvhian aunsrgannalnuasaunsal
WsaduAsEAL 9
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Ti

(vi)

Kasak TiniHge

(KK)

Tagalog

(Ty)
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CANH BAO

Hudéng din s& dung dich vu nay chi sin dung bingtiéng Anh.

e NE&unha cungcap dich vu ciia khach hang yéu cau ngdn nglt khac ngoai
ti€ng Anh, thi khach hang phai co trach nhiém cung cdp cac dich vu dich
thuat.

e Khéngduoc tim cach stra chira thi€tbi trir khi d3 tham khao va hi€uro
Huwéng dan s dungdich vunay.

e BO qua l&i cAnh bao nay co thé gy thwongtich cho nhacung cap dich vu,
nhan vién van hanh hoac bénh nhan do séc dién, nhirng nguy hiém vé may
moc hoac yéutd khac.

ECKEPTY

OcCbl KbI3MeT KepCeTy HYCKaY/1blfbl TEK aFblALWbIH TINIHAE KONXKeTIMAI.

Erep TyTbiHYLWbINAPAbIH KbI3METTEP e TKI3YLWICi aFblLWbIH TiniHeH 6acka
TinAiTanan eTce, ayaapy KbiameTTepiMmeH KaMTamacbi3 eTy TYTbIHYLWbIHbIH
}ayankepuwiniriHe Kipeai.

Ocbl KbI3MET KBPCETY HYCKayNblFblH TYCIHIN, 0N Typanbl KeHeCcanManblHLWa
KabaplKKa KbI3MET KepceTyre TbipblCnaHbi3.

Ocbl eckepTyAi OpbIHAAMAY 3NEKTP TOrbIHbIH COFYbl, MEXaHWUKA/bIK HEMece
6acka ga KayinTep canzapblHaH KbI3METTEep MeTKI3yLWICiHIH, onepaTopabiH,
Hemece eMAenyWiHiH }KapakaTTaHyblHa anbin Kenyi MyMKiH.

BABALA

Available lamang sa Ingles ang Manwal ng Serbisyongito.

* Kungang kailangan lamang ng tagabigay ng serbisyo ng kustomer ng wika
maliban sa Ingles, responsibilidad ng kustomer na magbigay ng serbisyo sa
pagsasalin wika nito.

® Huwag subukan naiserbisyo ang mga kasangkapan maliban kung
nakonsultaang nauunawaan itong Manwal ng Serbisyo.

Ang pagkabigong maunawaan ang Babalang ito ay maaring maging resulta
ng pinsala sa tagabigay ng serbisyo, nagpapagana o pasyente mulasa
pagkakakoryente, mekanikal o iba pang peligro.
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Damage in transportation

All packages should be closely examined at time of delivery. If
damage is apparent, write “Damage In Shipment” on ALL copies
of the freight or express bill BEFORE delivery is accepted or
“signed for” by a GE representative or hospital receiving agent.
Whether noted or concealed, damage MUST be reported to the
carrier immediately upon discovery, or in any event, within 14
days after receipt, and the contents and containers held for
inspection by the carrier. A transportation company will not pay a
claim for damage if an inspection is not requested within this 14
day period.

Certified electrical contractor statement - For USA Only

All electrical Installations that are preliminary to positioning of
the equipment at the site prepared for the equipment shall be
performed by licensed electrical contractors. Other connections
between pieces of electrical equipment, calibrations and testing
shall be performed by qualified GE personnel. In performing all
electrical work on these products, GE will use its own specially
trained field engineers. All of GE’s electrical work on these
products will comply with the requirements of the applicable
electrical codes.

The purchaser of GE equipment shall only utilize qualified
personnel (i.e., GE’s field engineers, personnel of third-party
service companies with equivalent training, or licensed
electricians) to perform electrical servicing on the equipment.

i-14 ; System view Versana Premier — Basic Service Manual
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Omission and errors

Mail the
information to:

If there are any omissions, errors or suggestions for improving
this documentation, contact the GE Global Documentation
Group with specific information listing the system type, manual
title, part number, revision number, page number and
suggestion details.

GE Medical Systems (China) Co., Ltd.

No. 19 Changjiang Road

Wuxi National Hi-Tech Dev. Zone

214028 Jiangsu, China

TEL: +86 510 85225888; FAX: +86 510 85226688

GE employees should use TrackWise to report service
documentation issues.

These issues will then be in the internal problem reporting tool
and communicated to the writer.

Service Safety Considerations

f DANGER
ﬁ WARNING

Versana Premier — Basic Service Manual
5789130-100 English Rev.5

DANGEROUS VOLTAGES, CAPABLE OF CAUSING DEATH,
ARE PRESENT IN THIS EQUIPMENT. USE EXTREME
CAUTION WHEN HANDLING, TESTING AND ADJUSTING.

Use all Personal Protection Equipment (PPE) such as gloves,
safety shoes, safety glasses, and kneeling pad, to reduce the
risk of injury.

For a complete review of all safety requirements, refer to
Chapter 1 in the Service Manual.
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Legal notes

Proprietary to GE

Trademarks

Copyrights

The contents of this publication may not be copied or duplicated
in any form, in whole or in part, without prior written permission
of GE.

GE may revise this publication from time to time without written
notice.

Permission to use this Advanced Service Software and related
documentation (herein called the material) by persons other
than GE employees is provided only under an Advanced
Service Package License relating specifically to this Proprietary
Material. This is a different agreement from the one under which
operating and basic service software is licensed. A license to
use operating or basic service software does not extend to or
cover this software or related documentation.

If you are a GE employee or a customer who has entered into
such a license agreement with GE to use this proprietary
software, you are authorized to use this Material according to
the conditions stated in your license agreement.

However, you do not have the permission of GE to alter,
decompose or reverse-assemble the software, and unless you
are a GE employee, you may not copy the Material. The
Material is protected by Copyright and Trade Secret laws; the
violation of which can result in civil damages and criminal
prosecution.

If you are not party to such a license agreement or a GE
Employee, you must exit this Material now.

All products and their name brands are trademarks of their
respective holders.

All Material Copyright © 2018-2019 by
General Electric Company Inc. All Rights Reserved.

5789130-100 English Rev.5
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Chapter 1

Introduction

This chapter describes important issues related to
safely servicing the Ultrasound system. The service
provider must read and understand all the information
presented here before installing or servicing the units.

Versana Premier — Basic Service Manual System view
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Introduction

1-1 Overview

1-1-1 Contents in this chapter

* 1-1‘Overview’ on page 1-2

* 1-2 ‘Manual Overview’ on page 1-3

* 1-3 ‘Important conventions’ on page 1-7

* 1-4 ‘Product icons’ on page 1-11

* 1-5‘Labels locations’ on page 1-12

* 1-6 ‘Safety considerations’ on page 1-14

» 1-7 ‘Dangerous procedure warnings’ on page 1-22

* 1-8 ‘Lockout/Tagout (LOTO) requirements’ on page 71-23
* 1-9 ‘Returning probes and repair parts’ on page 1-24
* 1-10 ‘EMC, EMI and ESD’ on page 1-25

* 1-11 ‘Customer assistance’ on page 1-27
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Manual Overview

1-2 Manual Overview

This manual provides installation and service information for the
Versana Premier Ultrasound system. It is divided in ten chapters
as shown below.

1-2-1 Contents in this manual

The manual is divided into ten chapters.

In the beginning of the manual, before chapter 1, you will find
the Revision overview, the Important precautions including
Translation policy, Damage in transportation, Certified electrical
contractor statement, Omission & errors, Service safety
considerations and Legal notes, and the Table of Contents
(TOC).

An Index has been included after Chapter 10.

Table 1-1:  Contents in this manual

Chapter Chapter title Description
number
1. Introduction Contains a content summary and warnings.
2. Site preparations Contains pre-setup requirements for the Versana
Premier.
3. System Setup Contains setup procedure with procedure
checklist for the system.
4. General Procedures | Contains functional checks that must be
and Functional performed as part of the installation, or as
Checks required during servicing and periodic
maintenance.
5. Components and Contains block diagrams and functional
Functions (Theory) explanations of the electronics.
6. Service Adjustments | Contains instructions on how to make any

available adjustments to the Versana Premier.

Versana Premier — Basic Service Manual
5789130-100 English Rev.5
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Introduction

Table 1-1:  Contents in this manual (Continued)

Chapter Chapter title Description

number

7. Diagnostics/ Provides procedures for running diagnostic or
Troubleshooting related routines for the Versana Premier.

8. Replacement Provides disassembly procedures and
procedures reassembly procedures for all changeable FRU.

9. Renewal Parts Contains a complete list of replacement parts for

Versana Premier.

10. Care & Maintenance | Provides periodic maintenance procedures for
Versana Premier.

N/A Index A quick way to the topic you're looking for.

1-2-2 Typical users of the Proprietary Service Manual

*  GEHC Service Personnel (setup, maintenance, etc.)
*  GEHC Online Center Personnel
» Licensed Hospital's Service Providers

1-2-3 Purpose of Operator Manual(s)

The Operator Manual(s) should be fully read and understood
before operating the Versana Premier and also kept near the
unit for quick reference.

NOTE:  Probe information displayed on screen does not necessarily

reflect the probes available on your ultrasound system. Please
refer to the probe list for available probes and features.
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Manual Overview

1-2-4 Versana Premier models covered by this manual

Table 1-2:  Versana Premier Model Designations

Model Name System SW
Versana Premier VA R1.x.x
Versana Premier VS R1.x.x

NOTE: When not otherwise specified, the contents of this manual
applies to all Versana Premier models.
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Introduction

1-2-5 Smart Manual Function

On each page of this Proprietary Service Manual, there is a

smart manual icon to bring you back to Overview of Versana
Premier. By clicking on the system overview list, you can be
brought to the FRU list directly.

. - .- .- . S . .
;, : System view E
.- - e = . . -

~

8-3-3 Overview of Versana Premier -

Figure 8-1. System Overview 1

- Manitor Assy ‘fersana Premier KBD Speaker Cover

1 5.
2 Keyboard Assy B. Versana Premier Probe holder
3. ‘ersana Premier Body 4FF Front Cover 7. Versana Premier Frame Handle
4. Bass Aszy 8. Versana Premier Gel halder
8. Versana Premier Body Top Cover Assy
Figure 1-1.  Smart Manual Icon
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Important conventions

1-3 Important conventions

1-3-1 Conventions used in book

Important conventions, used in this document, are described
next.

1-3-1-1 Model designations

This manual covers the Versana Premier Ultrasound systems
listed in:

1-2-4 ‘VVersana Premier models covered by this manual’ on
page 1-5.

1-3-1-2 Icons

Pictures, or icons, are used wherever they will reinforce the
printed message. The icons, labels, and conventions used on
the product and in the service information are described in this
chapter.

Versana Premier — Basic Service Manual
5789130-100 English Rev.5
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Introduction

1-3-1-3 Safety precaution messages

Various levels of safety precaution messages may be found on
the equipment and in the service information. The different
levels of concern are identified by a flag word that precedes the
precautionary message. Known or potential hazards to
personnel are labeled in one of three ways:

+  DANGER

«  WARNING
+ CAUTION

cause severe personal injury or death if the instructions are

f DANGER Danger is used to indicate the presence of a hazard that will
ignored.

cause severe personal injury and property damage if

f WARNING Warning is used to indicate the presence of a hazard that can
instructions are ignored.

CAUTION Caution is used to indicate the presence of a hazard that will or
can cause minor personal injury and property damage if
instructions are ignored. Equipment damage possible.

NOTE: Notes are used to provide important information about an item
or a procedure.

NOTE: Be sure to read the notes; the information contained in a note
can often save you time or effort.
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Important conventions

1-3-2 Standard hazard icons

Important information will always be preceded by either the
exclamation point (!) contained within a triangle, or the symbols
for “Danger”, “Warning” or “Caution”, as seen throughout this
chapter. In addition to text, several different graphical icons
(symbols) may be used to make you aware of specific types of
hazards that could possibly cause harm.

Table 1-3:  Standard hazard icons

6 ELECTRICAL
& MECHANICAL
. . RADIATION

®

a

LASER

LASER

LIGHT

f HEAT

i i PINCH

NOTE: Even if a symbol isn’t used on the product or in this manual, it
may be included for your reference.

Versana Premier — Basic Service Manual System view 1-9
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Introduction

1-3-2-1 Standard Icons that indicate that a special procedure is to be used

Some others icons make you aware of specific procedures that
should be followed.

Table 1-4:  Standard Icons that indicates that a special procedure is to be used

Avoid Static Electricity Tag and Lock Out Wear Eye Protection

EYE
PROTECTION

AN

Hand Protection Foot Protection Wear Eye Protection

5]

Be sure to read the notes; the information contained in a note
can often save you time or effort.

1-10 é System view Versana Premier — Basic Service Manual
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Product icons

1-4 Product icons

It is important to refer to the current revision of the Ultrasound
system’s Basic User Manual for a full list of product labels prior
to servicing the system.

Versana Premier — Basic Service Manual
5789130-100 English Rev.5
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Introduction

1-5 Labels locations

It is important to refer to the current revision of the Ultrasound

system’s Basic User Manual for a full list of product labels prior
to servicing the system.

1-5-1 Rating Plate Location

Versana Premier labels are provided in English.

The labels are at the rear of the system. The label content may

be different for different regions. Please refer to the labels on the
system for the actual content.

©AAR®
L BZE) R Aih

A CAUTION o iR
This machine should be used in compliance with law.
Some jurisdictions resirict cenain uses, such as
gender determination

CISPR 11 / EN 55011
CLASS:A GROUP:1
CLASSE:A GROUPE:1

wal GE MEDICAL SYSTEMS (CHINA) CO.,LTD.
NO.19, CHANGJIANG ROAD WUXI

NATIONAL HI-TECH DEV.ZONE 214028

JIANGSU CHINA
C Emav

Versana Premier

& EEE

NPUT: 100-240V~,50/60Hz,450VA

i

(01)0 0840662 14114 7 (11) 180305 (21) 1100000WX 1

g

Figure 1-2. Versana Premier Label Location

1-12 ;, System view Versana Premier — Basic Service Manual
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Labels locations

1-5-1 Rating Plate Location(continued)

1. Rating Plate

Table 1-5: Label Icons

Label/lcon

Purpose/Meaning

Location

(01)0 0840682 10692 4 (11) 160513 (21) 000022WX5

Every system has a unique
marking for identification, the
Unique Device Identification
(UDI) Label. The UDI label
consists of a series of
alpha-numeric characters and
barcode which uniquely identify
the Versana Premier system as a
medical device manufactured by
General Electric. Scan or enter
the UDI information into the
patient health record as required
by country-specific laws.

Rating plate

SN

Serial Number.

Rating plate

NOTE:

If the new label is needed during the service activities, please

click “Ask an Expert” to submit the case in the support central:
http.//supportcentral.ge.com/products/sup_products.asp?prod_
id=44177.

Versana Premier — Basic Service Manual

5789130-100 English Rev.5
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Introduction

1-6 Safety considerations

1-6-1 Contents in this section

* 1-6-2 ‘Introduction’ on page 71-14

* 1-6-3 ‘Human Safety’ on page 1-14

* 1-6-4 ‘Mechanical safety’ on page 1-17
* 1-6-5 ‘Electrical safety’ on page 71-20

1-6-2 Introduction

The following safety precautions must be observed during all
phases of operation, service and repair of this equipment.
Failure to comply with these precautions or with specific
warnings elsewhere in this manual, violates safety standards of
design, manufacture and intended use of the equipment.

1-6-3 Human Safety

*  Operating personnel must not remove the system covers.
»  Servicing should be performed by authorized personnel
only.

Only personnel who have participated in a Versana Premier
Training Seminar are authorized to service the equipment.

1-14 ; System view Versana Premier — Basic Service Manual
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Safety considerations

1-6-3 Human Safety(continued)

field, placing people in awkward positions, GE has limited the
liting weight for one person in the field to 16 KG (35 LBS).
Anything over 16 KG (35 LBS) requires 2 people.

f WARNING Because of the limited access to cabinets and equipment in the

WARNING Eaveltwo people available to deliver and unpack the Versana
f i E remier.

Attempts to move the Ultrasound system considerable
distances or on an incline by one person could result in injury
or damage or both.

[ 3 [ ]

fat

f WARNING Ensure that the Ultrasound system is turned off and unplugged.

Wait for at least 20 seconds for capacitors to discharge as
there are no test points to verify isolation. The amber light on
the OP panel ON/OFF button will turn off.

Ultrasound system components may be energized. Always
refer to the Ultrasound system's Proprietary Service Manual for
LOTO warnings and cautions.

Versana Premier — Basic Service Manual
5789130-100 English Rev.5
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Introduction

1-6-3 Human Safety(continued)

and disconnected from power source. Cord must be controlled

f WARNING Risk of electrical shock, Ultrasound system must be turned off
at all times.

Wait for at least 20 seconds for capacitors to discharge as
there are no test points to verify isolation. The amber light on
the OP panel on/off button will turn off.

Ultrasound System components may be energized. Always
refer to the Ultrasound system's Proprietary Service Manual for
LOTO warnings and cautions

WARNING Use all Personal Protection Equipment I(PPE) such as gloves,
safety shoes, safety glasses, and kneeling pad, to reduce the

risk of injury.

WARNING Beware of possible sharp edges on all mechanical parts. If
sharp edges are encountered, the appropriate PPE should be

used to reduce the risk of injury.

f WARNING \l\/AVSgrSaII PPE including gloves as indicated in the chemical

1-16 ; System view Versana Premier — Basic Service Manual
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Safety considerations

1-6-4 Mechanical safety

data, you should save any patient data, images, system setups
to removable media or hardcopy before doing a software
upgrade.

f WARNING While the software install procedure is designed to preserve

WARNING Ultrasound probes are highly sepsitive medicall instruments
that can easily be damaged by improper handling. Use care

when handling and protect from damage when not in use. Do
NOT use a damaged or defective probe. Failure to follow these
precautions can result in serious injury and equipment
damage.

WARNING Nevgr use a probe that has fallen to the floor. Even if it looks
OK, it may be damaged.

along any incline, use extreme caution since it may become

f WARNING When the Ultrasound system is raised for a repair or moved
unstable and tip over.

CAUTION Take extra care when moving the system.

The Versana Premier weighs approximately 70 kg (140 Ibs) or
more, depending on installed peripherals, when ready for use.
To avoid possible injury and equipment damage when
transporting from one area of use to another:

» Be sure the pathway is clear.

* Limit movement to a slow careful walk.

+ Use two or more persons to move the equipment on
inclines or long distance.

sure to lock the monitor arm firmly and flip down the monitor to

f CAUTION Before you move or transport the Ultrasound system, make
prevent damage to the Ultrasound system.

Versana Premier — Basic Service Manual
5789130-100 English Rev.5
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Introduction

1-6-4 Mechanical safety(continued)

CAUTION
CAUTION
ﬁAUTION
CAUTION

CAUTION

é CAUTION

To avoid injury when you move the monitor and the monitor
arm, do not put your finger, hand, or object on the joint of the
monitor or the monitor arm.

Ensure that nobody touches the console arm when moving the
operator panel.

Do not move the Ultrasound system if the Operator Panel is in
unlocked position.

Do not transport Versana Premier in a vehicle without locking
the casters (wheels) and securing it as described in chapter 4.

Use protective glasses during drilling, filing smooth surfaces,
and during all other work where eyes need protection.

Use safety shoes when doing work where there is any chance
of foot injury.

5789130-100 English Rev.5
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Safety considerations

1-6-4 Mechanical safety(continued)

directed to wear PPE during a removal/replacement procedure.

f CAUTION Use protective gloves when working with sharp edges or when

f CAUTION Be careful not to pinch any of the cables.

NOTE:  Special care should be taken when transporting the Ultrasound
system in a vehicle:

Versana Premier — Basic Service Manual

5789130-100 English Rev.5

Before transporting, place the system in its special storage
case.

Lock the wheels (brake).

Ensure that the system is firmly secured while inside the
vehicle.

Secure system with straps or as directed otherwise to
prevent motion during transport.

Prevent vibration damage by driving cautiously. Avoid
unpaved roads, excessive speeds, and erratic stops or
starts.

System view 1-19
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1-6-5 Electrical safety
1-6-5-1 Safe practices

Follow these guidelines to minimize shock hazards whenever
you are using the Ultrasound system:

» To minimize shock hazard, the equipment chassis must be
connected to an electrical ground.

* The Ultrasound system is equipped with a three-conductor

AC power cable. This must be plugged into an approved
electrical outlet with safety ground.

* The power outlet used for this equipment should not be
shared with other types of equipment.

* Both the system power cable and the power connector must
meet international electrical standards.

WARNING Connecting a Versana Premier to the wrong voltage level will
most likely destroy it.

WARNING DO NOT SERVICE OR DISASSEMBLE PARTS UNDER FRU
UNIT LEVEL AT ANY CIRCUMSTANCES.

1-20 ; System view Versana Premier — Basic Service Manual
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Safety considerations

1-6-5-2 Probes

Follow these guidelines before connecting a probe to the
Ultrasound system:

* Inspect the probe prior to each use for damage or
degradation to the:
* housing
* cable strain relief
* lens
* seal
*  connector pins
* locking mechanism

* Do not use a damaged or defective probe.

* Never immerse the probe connector or adapter into any
liquid.

* The system has more than one type of probe port. Use the
appropriate probe port designed for the probe you are
connecting.

1-6-5-3 Peripherals

Refer to the Patient Safety Environment section of the User’s
Manual for peripheral isolation information.

Versana Premier — Basic Service Manual System view 1-21
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1-7 Dangerous procedure warnings

DANGER

ﬁ WARNING
é WARNING

ﬁ WARNING

ﬁ WARNING
ﬁ WARNING

Warnings, such as the example below, precede potentially
dangerous procedures throughout this manual. Instructions
contained in the warnings must be followed.

DEATH, ARE PRESENT IN THIS EQUIPMENT. USE
EXTREME CAUTION WHEN HANDLING, TESTING
AND ADJUSTING.

f DANGEROUS VOLTAGES, CAPABLE OF CAUSING

If the covers are removed from an operating Versana Premier,
some metal surfaces may be warm enough to pose a potential
heat hazard if touched, even while in shutdown mode.

Explosion Warning

DO NOT operate the equipment in an explosive atmosphere.
Operation of any electrical equipment in such an environment
constitutes a definite safety hazard.

DO NOT substitute parts or modify equipment

Because of the danger of introducing additional hazards, ONLY
install GE approved parts. DO NOT perform any unauthorized
modification of the equipment.

SHUT DOWN FORCEDLY OR PLUG IN/OUT ACDC
INVALID MAY CAUSE THE DAMAGE OF SYSTEM
FILES.

AFTER UNPLUG POWER CORD, WAIT FOR AT LEAST
20 SECONDS FOR CAPACITORS TO DISCHARGE AS
THERE ARE NO TEST POINTS TO VERIFY
ISOLATION.

5789130-100 English Rev.5
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Lockout/Tagout (LOTQO) requirements

1-8 Lockout/Tagout (LOTO)

requirements

Follow Lockout/Tagout requirements by ensuring you are in total
control of the AC power plug at all times during the service
process.

To apply Lockout/Tagout (LOTO):

No ok owbdh=

Plan and prepare for shutdown.

Shutdown the equipment.

Isolate the equipment.
Remove/disconnect the battery, if present.
Apply Lockout/Tagout Devices.

Control all stored and residual energy.
Verify isolation.

All potentially hazardous stored or residual energy is relieved.

f WARNING Energy Control and Power Lockout for Versana Premier.

When servicing parts of the Ultrasound system where there is
exposure to voltage greater than 30 volts:

1.

A

Follow LOCK OUT/TAG OUT procedures.

Turn off the breaker.

Unplug the Ultrasound system.

Maintain control of the Ultrasound system power plug.

Wait for at least 30 seconds for capacitors to discharge as
there are no test points to verify isolation.

Ultrasound System components may be energized.

Versana Premier — Basic Service Manual
5789130-100 English Rev.5
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1-9 Returning probes and repair

NOTE:

NOTE:

parts

Equipment being returned must be clean and free of blood and
other infectious substances. GE policy states that body fluids
must be properly removed from any part or equipment prior to
shipment. GE employees, as well as customers, are responsible
for ensuring that parts/equipment have been properly
decontaminated prior to shipment. Under no circumstance
should a part or equipment with visible body fluids be taken or
shipped from a clinic or site (for example, body coils or an
ultrasound probe).

The purpose of the regulation is to protect employees in the
transportation industry, as well as the people who will receive or
open this package.

The US Department of Transportation (DOT) has ruled that
‘items that were saturated and/or dripping with human blood
that are now caked with dried blood; or which were used or
intended for use in patient care” are “regulated medical waste”
for transportation purposes and must be transported as a
hazardous material.

The USER/SERVICE staff should dispose of all the waste
properly, per federal, state, and local waste disposal regulations.

The Ultrasound system is not meant to be used for long-term
storage of patient data orimages. The user is responsible for the
data on the system and a regular backup is highly
recommended.

If the system is sent for repair, please ensure that any patient
information is backed up and erased from the system before
shipping. It is always possible during system failure and repair to
lose patient data. GE is not responsible for the loss of this data.

If PHI (Patient Healthcare Information) data needs to be sent to
GE employees for service purposes, GE will ascertain
agreement from the customer. Patient information shall only be
transferred by approved service processes, tools and devices
restricting access, protecting or encrypting data where required,
and providing traceability in the form of paper or electronic
documents at each stage of the procedure while maintaining
compliance with cross-border restrictions of patient information
transfers.

5789130-100 English Rev.5
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EMC, EMI and ESD

1-10 EMC, EMI and ESD

1-10-1 Electromagnetic Compatibility (EMC)

Electromagnetic compatibility describes a level of performance
of a device within its electromagnetic environment. This
environment consists of the device itself and its surroundings
including other equipment, power sources and persons with
which the device must interface. Inadequate compatibility results
when a susceptible device fails to perform as intended due
interference from its environment or when the device produces
unacceptable levels of emission to its environment. This
interference is often referred to as radio—frequency or
electromagnetic interference (RFI/EMI) and can be radiated
through space or conducted over interconnecting power of
signal cables. In addition to electromagnetic energy, EMC also
includes possible effects from electrical fields, magnetic fields,
electrostatic discharge and disturbances in the electrical power

supply.

1-10-2 CE Compliance

NOTE:

Versana Premier — Basic Service Manual
5789130-100 English Rev.5

Versana Premier conforms to all applicable conducted and
radiated emission limits and to immunity from electrostatic
discharge, radiated and conducted RF fields, magnetic fields
and power line transient requirements.

For applicable standards, refer to the Safety Chapter of the
Ultrasound system User’s Manual.

For CE Compliance, it is critical that all covers, screws,
shielding, gaskets, mesh, clamps, are in good condition,
installed tightly without skew or stress. Proper installation
following all comments noted in this service manual is required
in order to achieve full EMC performance.
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1-10-3 Electrostatic discharge (ESD) prevention

WARNING DQ NOT touch any boards with int_egrated circuits prior to
taking the necessary ESD precautions.

Always connect yourself, via an arm-wrist strap, to the advised
ESD connection point located on the rear of the Ultrasound
system (near the power connector).

Follow general guidelines for handling of electrostatic sensitive

M equipment.

Avoid all contact with electrical contacts, conductors and
components. Always use non-conductive handles designed for
the removal and replacement of ESD sensitive parts. All parts
that have the potential for storing energy must be discharged or
isolated before making contact.

f WARNING Risk of electrical shock, Ultrasound system must be turned off.

1-26 ; System view Versana Premier — Basic Service Manual
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Customer assistance

1-11 Customer assistance

1-11-1 Contact information

If this equipment does not work as indicated in this service
manual or in the basic user manual, or if you require additional
assistance, please contact the local distributor or appropriate
support resource, as listed below.

Before you call, identify the following information, and acquire
log (Alt+D) to send to the Customer Care team:

1. System ID / serial number.

Software version.

Date and time of occurrence.

Sequence of events leading to issue.

Is the issue repeatable?

Imaging mode, probe, preset/application.

Media brand, speed, capacity, type.

Save secondary image capture, cine loop.

® N~ ®ODN

NOTE:  Restart the application before resuming clinical scanning.

NOTE: The serial number can be found at the rear of the system.

Versana Premier — Basic Service Manual
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1-11-2 Phone numbers for Customer Assistance

Table 1-6:  Phone numbers for Customer Assistance

LOCATION PHONE NUMBER
USA Service: On-site 1-800-437-1171
GE Healthcare - GE Medical Systems -
Ultrasound Service Engineering Service Parts 1-800-558-2040

9900 Innovation Drive

Wauwatosa, WI 53226 Application Support | 1-800-682-5327 or

1-262-524-5698

Canada Phone: 1-800-668-0732
Latin America Service 1-800-321-7937
Application Support | 1-262-524-5698
Europe (OLC-EMEA) OLC - EMEA
GE Ultraschall Deutschland Gmbh & Co. KG Phone: +49 (0) 212 2802 - 652
Beethovenstralte 239 +33 1 3083 1300
Postfach 11 05 60, D-42655 Solingen
Germany Fax: +49 (0) 2122-8024-31
Online Services Ultrasound Asia Phone:
* Australia +(61) 1-800-647-855
* China +(86) 800-810-8188
* India +(91) 1800-425-8025
* Japan +(81) 42-648-2940
» Korea +(82) 2620 13585
* Singapore +(95) 6277-3444

1-11-3 System manufacturer

Table 1-7:  System manufacturer

MANUFACTURER PHONE NUMBER FAX NUMBER

GE Medical Systems (China) Co., Ltd. +86 510 85225888 +86 510 85226688
No.19 Changjiang Road

WuXi National Hi-Tech Dev.Zone
214028 Jiangsu

China

1-28 ; System view Versana Premier — Basic Service Manual
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Customer assistance

1-11-4 Authorized Representative

Table 1-8:  Authorized Representative

TELEPHONE / FAX

AUTHORIZED REPRESENTATIVE NUMBER
The location of the CE marking is shown in the Safety chapter of the Basic User
Manual.

EC | REP
Authorized EU Representative:
GE Medical Systems SCS
283 rue de la Miniére 78530 BUC, France
1-11-5 Factory Site
Table 1-9:  Factory Site
TELEPHONE / FAX
Factory Site NUMBER

GE Medical Systems (China) Co., Ltd. TEL: +86 510-85225888
No.19, Changjiang Road, Wuxi National Hi-Tech Dev.Zone, FAX: +86 510-85226688
214028 Jiangsu, China

Versana Premier — Basic Service Manual
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Chapter 2

Site Preparations

This chapter provides the information required to plan
and prepare for the setup of an Ultrasound system.
Included the descriptions of the facility and electrical
needs to be met by the purchaser of the units.

Versana Premier — Basic Service Manual System view 2-1
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Site Preparations

2-1 Overview

2-1-1 Contents in this chapter

*  2-1‘Overview’ on page 2-2

e 2-2 ‘General Ultrasound system requirements’ on page 2-3
»  2-3 ‘Facility needs’ on page 2-12

*  2-4 ‘Environmental Dangers’ on page 2-21

2-2 é System view Versana Premier — Basic Service Manual
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General Ultrasound system requirements

2-2 General Ultrasound system

2-2-1 Contents in this section

2-2-2 Ultrasound system environmental requirements

2-2-2-1 If the Ultrasound system is very cold or hot

f CAUTION

requirements

«  2-2-2 ‘Ultrasound system environmental requirements’ on

page 2-3
»  2-2-3 ‘Electrical requirements’ on page 2-6
e 2-2-4 ‘EMI limitations’ on page 2-9
*  2-2-5'Probes environmental requirements’ on page 2-11

e 2-2-6 ‘Time and manpower requirements’ on page 2-11

When unpacking the Ultrasound system, allow the temperature
of the Ultrasound system to stabilize before powering up. The
following table describes guidelines for reaching operational
temperatures from storage or transport temperatures.

If the Ultrasound system is very cold or hot, do not turn on its

power until it has had a chance to acclimate to its operating

environment.

Table 2-1:  System Acclimation Time Chart
DegreeC | 45 | -2 0.5 3 40 42.5 45 47.5 50 55 60
Degree F | 239 | 2844 | 329 | 374 | 104 | 1085 | 113 | 117.5 | 122 | 131 140
hours 3 2 1 0 0 1 2 3 4 6 8
Versana Premier — Basic Service Manual System view 2-3
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Site Preparations

2-2-2-2 Environmental specifications for Ultrasound system

The system should be operated, stored, or transported within
the parameters outlined below. Either its operational
environment must be constantly maintained or the unit must be

turned off.

Table 2-2:

System Environmental Requirements

Operational (Versana
Premier with probe)

Storage (Versana
Premier)

Transport (Versana
Premier)

Temperature | 3- 40° C (without -5-50°C -5-50°C
battery) 23-122°F 23-122°F
37.4-104°F
10 - 30° C (with battery)

50 - 86° F

Humidity 30 - 80% 10 - 90% 10 - 90%
non-condensing non-condensing non-condensing

Pressure 700 - 1060hPa 700 - 1060hPa 700 - 1060hPa

f CAUTION
f CAUTION

liquid.

2-4 é System view

Ensure that the probe face temperature does not exceed the
normal operation temperature range.

The Versana Premier system and probe connector is not
waterproof. Do not expose the device to water or any kind of

Versana Premier — Basic Service Manual
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General Ultrasound system requirements

2-2-2-3 Cooling

The cooling requirement for a console Ultrasound system with
monitor and on board peripherals, is up to 3800 BTU/h. This
figure does not include cooling needed for lights, people, or
other equipment in the room.

NOTE:  Each person in the room places an additional 300 BTU/h
demand on the cooling system.

2-2-2-4 Lighting

Bright light is needed for Ultrasound system installation, updates
and repairs. However, operator and patient comfort may be
optimized if the room light is subdued and indirect. Therefore a
combination lighting system (dim/bright) is recommended. Keep
in mind that lighting controls and dimmers can be a source of
EMI which could degrade image quality. These controls should
be selected to minimize possible interference.

Versana Premier — Basic Service Manual
5789130-100 English Rev.5
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Site Preparations

2-2-3 Electrical requirements

2-2-3-1 General requirements

NOTE:

NOTE:

GE requires a dedicated power and ground for the proper
operation of its Ultrasound equipment. This dedicated power
shall originate at the last distribution panel before the Ultrasound
system.

Sites with a mains power system with defined Neutral and Live:

The dedicated line shall consist of one phase, a neutral (not
shared with any other circuit), and a full size ground wire from
the distribution panel to the Ultrasound outlet.

Sites with a mains power system without a defined Neutral:

The dedicated line shall consist of one phase (two lines), not
shared with any other circuit, and a full size ground wire from the
distribution panel to the Ultrasound outlet.

Please note that image artifacts can occur, if at any time within
the facility, the ground from the main facility's incoming power
source to the Ultrasound system is only a conduit.

2-2-3-2 Electrical requirements for the Ultrasound system

In the table below, the electrical specifications for the Ultrasound
system includes monitor and on board peripherals.

Table 2-3:  Electrical Specifications for Versana Premier system
Voltage Tolerance Power Consumption Frequency
100-240 VAC +10% Max. 450VA 50/ 60HZ

2-2-3-3 Site power outlets

2-6 é System view

A dedicated AC power outlet must be within reach of the
Ultrasound system without extension cords. Other outlets
adequate for the external peripherals, medical and test
equipment needed to support this Ultrasound system must also
be present within 1 m (3.2 ft.) of the Ultrasound system.
Electrical installation must meet all current local, state, and
national electrical codes.

Versana Premier — Basic Service Manual
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General Ultrasound system requirements

2-2-3-4 Site circuit breaker

It is recommended that the branch circuit breaker for the
Ultrasound system be readily accessible.

The Versana Premier requires a dedicated single branch
circuit. To avoid circuit overload and possible loss of critical
care equipment, make sure you DO NOT have any other
equipment operating on the same circuit.

f CAUTION POWER OUTAGE MAY OCCURE.

2-2-3-5 Site power outlets

A dedicated AC power outlet must be within reach of the
Ultrasound system without extension cords. Other outlets
adequate for the external peripherals, medical and test
equipment needed to support this Ultrasound system must also
be present within 1 m (3.2 ft.) of the Ultrasound system.
Electrical installation must meet all current local, state, and
national electrical codes.

2-2-3-6 Unit power plug

If the Ultrasound system arrives without a power plug, or with
the wrong plug, you must contact your GE dealer or the
installation engineer must supply what is locally required.

Versana Premier — Basic Service Manual
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2-2-3-7 Power stability requirement

IEC 61000-4-11

Voltage dips, short
interruptions and
voltage variations
on mains supply

Table 2-4:  Power stability requirement
<5%T (> 95% dip) for <5%T (> 95% dip) for
0.5 cycle; 0.5 cycle;

40%T (60% dip) for 5 40%T (60% dip) for 5
cycles; cycles;

70%T (30 dip) for 25 70%T (30 dip) for 25
cycles; cycles;
<5%T (>95% dip) for 5 <5%T (>95% dip) for 5

sec

sec

Mains power
quality should be
that of a typical
commercial or
hospital
environment.

Versana Premier — Basic Service Manual
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General Ultrasound system requirements

2-2-4 EMI limitations

Ultrasound systems are susceptible to Electromagnetic
Interference (EMI) from radio frequencies, magnetic fields, and
transients in the air or wiring. They also generate EMI. The
Ultrasound system complies with limits as stated on the EMC
label. However there is no guarantee that interference will not
occur in a particular installation.

Possible EMI sources should be identified before the Ultrasound
system is installed.

Electrical and electronic equipment may produce EMI
unintentionally as the result of a defect. Some of these sources
include:

* medical lasers

e scanners

* cauterizing guns

e computers

* monitors

« fans

* gel warmers

* microwave ovens

* light dimmers

*  mobile phones

* in-house wireless phones (DECT phones)

* wireless computer keyboard and mouse

* air conditioning system

* High Frequency (HF) surgery equipment

» general AC/DC adapters

* portable phones

The presence of a broadcast station or broadcast van may also
cause interference.

See: 2-2-4-1 ‘EMI prevention/abatement’ on page 2-10 for EMI
prevention tips.

Versana Premier — Basic Service Manual
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Site Preparations

2-2-4-1 EMI prevention/abatement

Table 2-5:  EMI prevention/abatement

EMI RULE

DETAILS

Be aware of Radio
Frequency sources

+ Keep the Ultrasound system at least 5 meters (15 feet) away from other EMI
sources.

« Special shielding may be required to eliminate interference problems caused by
high frequency, high powered radio or video broadcast signals.

Ground the
Ultrasound system

Poor grounding is the most likely reason an Ultrasound system will have noisy
images. Check grounding of the power cord and power outlet.

Replace all screws,
Radio Frequency
gaskets, covers,
cores

« After you finish repairing or updating the Ultrasound system, replace all covers
and tighten all screws.

» Any cable with an external connection requires a magnet wrap at each end.

« Install all covers. Loose or missing covers or Radio Frequency gaskets allow
radio frequencies to interfere with the ultrasound signals.

Replace broken
Radio Frequency
gaskets

If more than 20% or a pair of the fingers on an Radio Frequency gasket are
broken, replace the gasket. Do not turn on the Ultrasound system until any loose
metallic part is removed.

Do not place labels
where Radio
Frequency gaskets
touch metal

Where applicable, never place a label where Radio Frequency gaskets meet the
Ultrasound system. Otherwise, the gap created will permit Radio Frequency
leakage. Or, if a label has been found in such a position, move the label.

Use GE specified
harnesses and
peripherals

The interconnect cables are grounded and require ferrite beads and other
shielding. Also, cable length, material, and routing are all important; do not change
from what is specified.

Take care with
cellular phones

Cellular phones may transmit a 5 V/m signal; that could cause image artifacts.

Properly route
peripheral cables

Where applicable, do not allow cables to lie across the top of the Card Rack or
hang out of the peripheral bays. Loop the excess length for peripheral cables
inside the peripheral bays. Attach the monitor cables to the frame.

Versana Premier — Basic Service Manual
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General Ultrasound system requirements

2-2-5 Probes environmental requirements

2-2-5-1 Operation, storage and transport temperatures for probes

Probes should be operated, stored, or transported within the
parameters outlined below.

Ensure that the probe face temperature does not exceed the
normal operation temperature range.

f CAUTION

Table 2-6:  Probe Environmental Requirements
Operational Storage Transport
Temperature 10°-40°C -5°-50°C -5°-50°C
50° - 104° F 23°-122°F 23°-122°F
Humidity 30- 80% 10 - 90% 10 - 90%
non-condensing non-condensing non-condensing
Pressure 700 - 1060hPa 700 - 1060hPa 700 - 1060hPa

Check the room temperature before you use the probe.

f CAUTION
é CAUTION

NOTE:

Ensure that the probe face temperature does not exceed the
normal operation temperature range.

Refer to Table 2-1 on page 2-3 to determine the needed
settlement time.

2-2-6 Time and manpower requirements

Site preparation takes time. Begin site preparation checks as
soon as possible, if possible, six weeks before delivery, to allow
enough time to make any changes.

Versana Premier — Basic Service Manual
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Site Preparations

2-3 Facility needs

2-3-1 Contents in this section

» 2-3-2 ‘Purchaser responsibilities’ on page 2-13

»  2-3-3 ‘Required facility needs’ on page 2-14

»  2-3-4 ‘Desirable features’ on page 2-15

«  2-3-5 ‘Minimal floor plan suggestion’ on page 2-16

» 2-3-6 ‘Recommended floor plan suggestion’ on page 2-17

*  2-3-7 ‘Suggested floor plan, Ultrasound system, and
EchoPAC PC in same room’ on page 2-18

»  2-3-8 ‘Networking setup requirements’ on page 2-18
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Facility needs

2-3-2 Purchaser responsibilities

The work and materials needed to prepare the site is the
responsibility of the purchaser. Delay, confusion, and waste of
manpower can be avoided by completing pre-installation work
before delivery. Purchaser responsibility includes:

*  Procuring the materials required

*  Completing the preparations before delivery of the
Ultrasound system

» Paying the costs for any alterations and modifications not
specifically provided in the sales contract

NOTE:  All electrical installations that are preliminary to the positioning
of the equipment at the site prepared for the equipment must be
performed by licensed electrical contractors. Other connections
between pieces of electrical equipment, calibrations, and testing
must also be performed by qualified personnel. The products
involved (and the accompanying electrical installations) are
highly sophisticated and special engineering competence is
required. All electrical work on these products must comply with
the requirements of applicable electrical codes. The purchaser
of GE equipment must only utilize qualified personnel to perform
electrical servicing on the equipment.

The desire to use a non-listed or customer provided product or
to place an approved product further from the Ultrasound
system than the interface kit allows, presents challenges to the
installation team. To avoid delays during installation, such
variances should be made known to the individuals or group
performing the installation at the earliest possible date
(preferably prior to the purchase).

The ultrasound suite must be clean prior to delivery of the
Ultrasound system. Carpet is not recommended because it
collects dust and creates static. Potential sources of EMI
(electromagnetic interference) should also be investigated
before delivery. Dirt, static, and EMI can negatively impact
Ultrasound system reliability.

Versana Premier — Basic Service Manual
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2-3-3 Required facility needs

NOTE:

GE requires a dedicated power and ground for the proper
operation of jts Ultrasound equipment. This dedicated power
shall originate at the last distribution panel before the Ultrasound
system.

Sites with a mains power system with defined Neutral and Live:

The dedicated line shall consist of one phase, a neutral (not
shared with any other circuit), and a full size ground wire from
the distribution panel to the Ultrasound outlet.

Sites with a mains power system without a defined Neutral:

The dedicated line shall consist of one phase (two lines), not
shared with any other circuit, and a full size ground wire from the
distribution panel to the Ulfrasound outlet.

5789130-100 English Rev.5
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2-3-3 Required facility needs(continued)

NOTE:  Please note that image artifacts can occur, if at any time within
the facility, the ground from the main facility's incoming power
source to the Ultrasound unit is only a conduit.

For

Dedicated single branch power outlet of adequate
amperage meeting all local and national codes which is
located less than 2.5 m (8 ft.) from the unit’s proposed
location

Door opening is at least 76 cm (30 in) wide

Proposed location for unit is at least 0.5m (1.5 ft.) from the
wall for cooling

Power outlet and place for any external peripheral are within
2 m (6.5 ft.) of each other with peripheral within 1 m of the
unit to connect cables.

Power outlets for other medical equipment.

Power outlets for test equipment within 1 m (3.2 ft.) of
Ultrasound system.

Clean and protected space to store probes (in their cases or
on a rack)

Material to safely clean probes (done with a plastic
container, never metal)

the amperage requirements, see: 2-2-3 ‘Electrical

requirements’ on page 2-6.

2-3-4 Desirable features

Versana Premier — Basic Service Manual

5789130-100 English Rev.5

Door is at least 92 cm (3 ft.) wide

Circuit breaker for dedicated power outlet is easily
accessible

Sink with hot and cold water

Receptacle for bio—hazardous waste, like used probe
sheaths

Emergency oxygen supply

Storage for linens and equipment

Nearby waiting room, lavatory, and dressing room
Dual level lighting (bright and dim)

Lockable cabinet ordered by GE for its software and
proprietary manuals

System view 2-15
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2-3-5 Minimal floor plan suggestion
CSI 8x10

Scale:
Each square equals one square
foot (app. 31 x 31 cm)

3

1. Door — at least 762 mm (30 6. Examination Table — 1930 x 12. Network Interface

inches) 610 mm (76 x 24 inches) 13. 457 mm (18 inches) distance
2. Film Viewer 7. Footswitch of Ultrasound system from
3. Counter Top, Sink with hot 8. Stool wall or objects
and cold water and Supplies 9. Ultrasound system 14. GE Cabinet for Software and
Storage 10. External Peripherals Manuals
4. Linen Supply 11. Dedicated Power Outlet -
5. Probes/Supplies Circuit Breaker protected and

easily accessible

Figure 2-1. Minimal floor plan, 2.5 m x 3 m (8 by 10 foot)
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2-3-6 Recommended floor plan suggestion
CSl 14x17

| @ .

\
\ 17
/ 6 AN \
/ \ ( C] \\ (@)
am L
Scale: Each square equals one square foot (app. 31 x 31 cm)
1. Secretaries or Doctors Desk 8. Suction Line 14. Footswitch
2. File Cabinet 9. Ultrasound system 15. Storage for Linens and
3. Film Viewer 10. Dedicated Power Outlet - Equipment
4. Counter Top Circuit Breaker protected and 16. Examination Table — 1930 x
5. Counter Top and Sink with easily accessible 610 mm (76 x 24 inches)
hot and cold water 11. Network Interface 17. Lavatory and Dressing Room
6. Overhead Lights Dimmer - 12. 457 mm (18 inches) distance 18. Door — at least 762 mm (30
Dual Level Lighting (bright of Ultrasound system from inches)
and dim) wall or objects
7. Emergency Oxygen 13. Stool

Figure 2-2. A 14 by 17 foot recommended floor plan

5789130-100 English Rev.5
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2-3-7 Suggested floor plan, Ultrasound system, and EchoPAC PC in

same room

Asere ¢

=

/ OF§> [3

609.6 cm -
1. EchoPAC PC workstation 4. 3x mains power outlets 7. Ethernet network wall outlet
parts 5. Hot and Cold water
2. UPS 6. Dedicated mains power out-

3. Ethernet network wall outlet let

Figure 2-3. Suggested Room with EchoPAC PC workstation and Ultrasound Scanner
2-3-8 Networking setup requirements

2-3-8-1 Stand alone Ultrasound system (without network connection)

None.

2-3-8-2 Scanner connected to hospital’s network

Supported networks:
100/1000 Mbit Ethernet/DICOM network (option)

2-3-8-3 InSite requirements

InSite requires an Ethernet connection via:
+ 100/1000 Mbit Interface

2-18 ; System view Versana Premier — Basic Service Manual
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2-3-8-4 Purpose of the DICOM network function

DICOM services provide the operator with clinically useful
features for moving images and patient information over a
hospital network.

Examples of DICOM services include the transfer of images to
workstations for viewing or transferring images to remote
printers.

As an added benéefit, transferring images in this manner frees up
the on-board monitor and peripherals, enabling viewing to be
done while scanning continues.

With DICOM, images can be archived, stored, and retrieved
faster, easier, and at a lower cost.

Versana Premier — Basic Service Manual System view 2-19
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Site Preparations

2-3-8-5 DICOM option setup requirements

To configure the Ultrasound system to work with other network
connections, the site’s network administrator must provide
information to complete the form “Worksheet for DICOM
Network Information”. Ensure that there are no spaces in any
field of the form.

See:
Entries must include:

* A host name, local port number, AE Title, IP address and
Net Mask for the Ultrasound system.

* The IP addresses for the default gateway and other routers
at the site for ROUTING INFORMATION.

* The host name, IP address, port and AE Title for each
device the site wants connected to the Ultrasound system
for DICOM APPLICATION INFORMATION. A field for the
make (manufacturer) and the revision of the device, is also
included. This information may be useful for error solving.

Dataflow

Service

imeout (sec)

Properties

ort Num

Figure 2-4. Worksheet for DICOM Network Information
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Environmental Dangers

2-4 Environmental Dangers

Commercial devices such as laser cameras, printers, VCRs and external monitors,
usually exceed allowable leakage current limits and, when plugged into separate AC
outlets, are in violation of patient safety standards. Suitable electrical isolation of such
external AC outlets, or providing the device with extra protective earth, will be required
in order to meet UL60601-1 and IEC60601-1 / IEC60601-1-1 standards for electrical
leakage.

2-4-1 Patient Vicinity UL60601-1 (USA)

2.12.20DV (UL60601-1:2003)

In area in which patients are normally cared for, the patient vicinity is the space with
surfaces likely to be contacted by the patient or attendant who can touch the patient.
This encloses a space within the room 1.83 m (6 ft.) beyond the perimeter of the bed
(examination table, dental chair, treatment booth, and the like) in its intended location,
and extending vertically 2.29 m (7.5 ft.) above the floor.

1. Patient environment

Versana Premier — Basic Service Manual
5789130-100 English Rev.5
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2-4-2 Patient Environment IEC60601-1 and ANSI AAMI ES60601-1

Sub Clause 3.79 and figure A.9 (IEC60601-1:2005 and ANSI AAMI
ES60601-1:2005)

Such an area is an environment in which medical diagnosis, monitoring or treatment is
carried out. It is very difficult to attach unique dimensions to the PATIENT
ENVIROMENT.

In practice a distance of 2,5 m (8.2 ft.) above the floor on which the medical personnel
stand and a horizontal distance of 1,5 m (4.9 ft.) have justified themselves as
indicative of the dimensions of the Patient Environment.

The patient environment/vicinity will be depicted as a dashed line in this procedure.
See example below.

,/’ =\,
<&
’I | ,\?3 \\
! l
1 |
o~ ]H’é'i)n |
= )
\ /
A \\‘ ‘,/

1. Patient environment

Figure 2-5. Patient environment
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Chapter 3
System Setup

This chapter contains information needed to install
Versana Premier system.

Included is a procedure that describes how to receive
and unpack the equipment and how to file a damage or
loss claim.

How to prepare the facility and unit of the actual
installation, and how to check and test the unit, probes,
and external peripherals for electrical safety are also
included in this procedure.

Versana Premier — Basic Service Manual System view 3-1
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System Setup

3-1 Overview

3-1-1 Contents in this chapter

*  3-1‘Overview’ on page 3-2

*  3-2 ‘Setup reminders’ on page 3-3

»  3-3 ‘Receiving and unpacking the equipment’ on page 3-6
*  3-5 ‘Preparing for setup’ on page 3-19

* 3-6 ‘Completing the setup’ on page 3-20

« 3-7 ‘System Configuration’ on page 3-25

»  3-8-3 ‘Peripherals Installation Instructions’ on page 3-31

*  3-9 ‘Connectivity setup’ on page 3-67

*  3-11 ‘Paperwork after setup’ on page 3-99
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Setup reminders

3-2 Setup reminders

3-2-1 Average setup time

* Unpacking the Versana Premier: 30 minutes
* Set up Versana Premier options: 30 minutes

* DICOM Network Configuration: 30 minutes or more,
depending on the configuration

¢ Install Insite: 0.5 hour
The Versana Premier installation and functional checkout will

take approximately 1 hour. Versana Premier consoles with
optional equipment may take slightly longer.

3-2-2 Setup warnings

é DANGER

f CAUTION
f CAUTION
é CAUTION

Versana Premier — Basic Service Manual
5789130-100 English Rev.5

WHEN USING ANY TEST INSTRUMENT THAT IS CAPABLE
OF OPENING THE AC GROUND LINE (l.E., METER’S
GROUND SWITCH IS OPEN), DON'T TOUCH THE
ULTRASOUND SYSTEM!

To prevent electrical shock, connect the unit to a properly
grounded power outlet. DO NOT use a three to two prong
adapter. This defeats safety grounding.

DO NOT wear the ESD wrist strap when you work on live
circuits and more than 30 V peak is present.

DO NOT operate this unit unless all board covers and frame
panels are securely in place. System performance and cooling
require this.

System view 3-3
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System Setup

3-2-2 Setup warnings(continued)

f DANGEF

NOTE:

é CAUTION

1. There are no operator serviceable components. To prevent
shock, do not remove any covers or panels. Should
problems or malfunctions occur, unplug the power cord.
Only qualified service personnel should carry out servicing.

For information regarding packing labels, refer to LABELS
ON PACKAGE.

2. After being transported, the unit may be very cold or hot. If
this is the case, allow the unit to acclimate before you turn it
on. It requires one hour for each 2.5°C increment it's
temperature is below 3°C or above 40°C.

Equipment damage possibility. Turning the system on without
acclimation after arriving at site may cause the system to be
damaged.

If the Ultrasound system is very cold or hot, do not turn on its power
until it has had a chance to acclimate to its operating environment.

The following table describes guidelines for reaching operational
temperatures from storage or transport temperatures.

Table 3-1:  System Acclimation Time Chart

Degree C | 50 45 40 35 30 |26 |20 |15 |10 |5 0 -5
Degree F | 122 | 113 | 104 | 95 8 |77 |68 |59 |50 |41 |23 |23
hours 4 2 0 0 0 0 0 0 0 2 4 6

5789130-100 English Rev.5
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3-2-2 Setup warnings(continued)

CAUTION Operator Manual(s)
The User Manual(s) should be fully read and understood

before operating the Versana Premier and kept near the
Ultrasound system for quick reference.

CAUTION Acoustic Output Hazard
Although the ultrasound energy transmitted from the Versana

Premier probe is within AIUM/NEMA standards, avoid
unnecessary exposure. ultrasound energy can produce heat
and mechanical damage.

111

Versana Premier — Basic Service Manual
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System Setup

3-3 Receiving and unpacking the

equipment

3-3-1 Purpose of this section

This section describes how to receive and unpack Versana
Premier.

3-3-2 Contents in this section

e 3-3-3 ‘Warnings for receiving and unpacking’ on page 3-6
* 3-3-4 ‘The Tilt indicator’ on page 3-7

*  3-3-5 ‘Receiving the Versana Premier’ on page 3-8

»  3-3-6 ‘Unpacking the Versana Premier’ on page 3-14

3-3-3 Warnings for receiving and unpacking
because of its weight. Attempts to move the Ultrasound system

considerable distances or on an incline by one person could
result in injury or damage or both.

f CAUTION Two people are needed to unpack the Ultrasound system

Two people are required whenever a part weighing 16 KG (35
LBS) or more must be lifted.

(PPE) during packing and unpacking. Check with your local

f CAUTION Remember to use relevant personal protecting equipment
EHS representative.

3-6 ; System view Versana Premier — Basic Service Manual
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Receiving and unpacking the equipment

3-3-4 The Tilt indicator

3-3-4-1 Overview

Improper handling during transportation may harm the
equipment inside the package even if the package itself is
undamaged.

To make it easier to detect if the handling during transportation
has been improper, a set of Tilt indicator has been attached to
the transportation box.

Table 3-2:  Tilt Watch

Description

lllustration

Tilt Watch

MONTORED SH" corvorn

&

5789130-100 English Rev.5
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3-3-5 Receiving the Versana Premier

3-3-5-1 Examine all packages

Examine package closely at time of delivery, as described in the
procedure below.

Table 3-3: Examine all packages

Step Task lllustrations

1. Is damage apparent?

« If YES; continue with the instructions in
3-3-5-4 ‘Damage in transportation’ on
page 3-11.

« If NO; continue with the next step.

2. Is the Tilt Indicator red colored inside the
middle of the indicator? —
< If YES: The Tilt Indicator has been | 770
activated. Continue with the instructions in
3-3-5-4 ‘Damage in transportation’ on
page 3-11 before you continue with the next
step.

« If NO: continue with the next step. 1
1- Red Color
3. Continue with the instructions in
3-3-6 ‘Unpacking the Versana Premier’ on
page 3-14.
3-8 ; System view Versana Premier — Basic Service Manual
= 5789130-100 English Rev.5

=~



Receiving and unpacking the equipment

3-3-5-2 Position of the Tilt indicator

The Tilt indicator has been attached to the transportation box as
illustrated in the figure below.

=

Figure 3-1. Tilt indicator

1. Tilt Indicator

NOTE: Before cutting the straps, check Tilt Tag to make sure it has not
been triggered. If damaged, report it to the carrier. If not, then
cut the straps around the crate.

Versana Premier — Basic Service Manual é System view 3-9
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3-3-5-3 If Tilt Indicator has triggered or is missing

The purpose of the tilt indicator label is to alert people handling a
product that it is sensitive to tipping and it must remain upright at
all times. It is basically an active "Up Arrow" that changes color if
the package is tipped 89 degrees or more from horizontal.
These labels can be false activated if tipped less than 89
degrees, and shocked or vibrated at the same time. This event
does occur, but is considered uncommon. If a package is
received with an activated tilt indicator label, there is high
degree of certainty it tipped 89 degrees or more from horizontal
during shipment.

An activated tilt indicator label does not indicate if the package
was simply “Tipped” (laid down with no impact shock) or “Tipped
Over” (free fall, with an impact shock). Using both shock
indicator labels and tilt indicator labels will help identify if a Tip
Over impact shock occurred.

Table 3-4:  Tilt Indicator has triggered or is missing

Step Task

1. If the Tilt Indicator is missing:

Note on the shipping papers at the time of
receipt that the Tilt Indicator label is missing.

If the Tilt Indicator has triggered:

Note on the shipping papers at the time of
receipt that the Tilt Indicator label was activated.

2. Inspect the product for possible concealed
damage.

3-10 ; System view Versana Premier — Basic Service Manual
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Receiving and unpacking the equipment

3-3-5-4 Damage in transportation

Follow this procedure if damage is apparent:

1. Write “Damage In Shipment” on ALL copies of the freight or
express bill BEFORE delivery is accepted or “signed for “by
a GE representative or hospital receiving agent.

2. Report the damage to the carrier.
*  Whether noted or concealed, damage MUST be
reported to the carrier immediately upon discovery, orin

any event, within 14 days after receipt, and the contents
and containers held for inspection by the carrier.

* A transportation company will not pay a claim for
damage if an inspection is not requested within this 14
day period.

3-3-5-5 Versana Premier transportation box label

The Versana Premier transportation box label is located at the
front of the transportation box.

=
-~
11 =

=k S Tam HEMEREIR

—
—

1060hpa

90%
50°C
‘
5C

10% 700hpa

IRERR || RERR || SERR

Figure 3-2. Versana Premier transportation box label 1

Figure 3-3. Versana Premier transportation box label 2

]
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i
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3-3-5-5 Versana Premier transportation box label(continued)

Table 3-5: Package Label Icons

Label/lcon Purpose/Meaning Location
Keep this way up. Package
[k
Fragile. Package
ZIEEY/E
Package
i Keep it away from rain.
‘! l‘ /
T
2 levels at most. Package
3-12 é System view Versana Premier — Basic Service Manual
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Receiving and unpacking the equipment

Table 3-5: Package Label Icons

Label/lcon Purpose/Meaning Location
Humidity Limitation Package
90%
7
10%
AR PR
Temperature Limitation Package
50°C
5°C
N=|
i FE AR PR
Pressure Limitation Package
1060hpa
700hpa
=
SERBR
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System Setup

3-3-6 Unpacking the Versana Premier

é CAUTION
f CAUTION
f CAUTION

NOTE:

When a new system arrives, check that any components are not
damaged and are not in short supply. If shipping damage or
shortage occurs, contact the address shown in Chapter 1.

Please carefully unpack the system, and do not dispose the
package of Versana Premier, so that it can be reused for
service.

Do not lift the unit by the Keyboard. Equipment damage may
result.

The crate with the Versana Premier weighs approximately
50kg. Be prepared for a sudden shift of weight as the unit is
removed from its base (pallet).

Please check the Versana Premier console is well assembly
after unpacking the system.

Table 3-6:  Unpacking the Versana Premier

Step

Description Corresponding Graphic

1 Tear off the "stop open" mark.

3-14 ;, System view Versana Premier — Basic Service Manual
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Receiving and unpacking the equipment

Table 3-6: Unpacking the Versana Premier

Step Description Corresponding Graphic

2 Cut off the two packing straps around the crate.

M N T
T — G

Note: To avoid injury, hold the strap clasp with
one hand when cultting the strap.

3 Remove the top cover.

4 Remove the three plastic locks.

Note: Rotate the inside plastic lock
counterclockwise to remove it and then remove
the outside lock.

5 Remove the outside shipping box.

Versana Premier — Basic Service Manual 5, System view 3-15
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Table 3-6: Unpacking the Versana Premier

Step Description Corresponding Graphic

6 Remove the 2 foams beside the system.
Note: There is no foam if the system is
transported by air. Ignore this step if there is no
foam.

7 Remove the clear plastic (wrapped around the
Versana Premier) from the unit.

8 Cut the cable ties around the four wheels.

3-16 Versana Premier — Basic Service Manual
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Receiving and unpacking the equipment

Table 3-6: Unpacking the Versana Premier

Step Description Corresponding Graphic

9 Remove the barrier bag from the unit.

Note: Remove the PE bag if the system is
transported by air.

10 Remove the foams beside the monitor.

11 Remove any additional packing material
surrounding the system.

12 Unlock the wheels, and then hold the control
panel at the front side to move the system until
the front two wheels on the ground and then
slowly move the whole system on the ground.

3-3-6-1 Moving into Position
Please refer to Basic User Manual on how to move the system.

3-3-7 Packing the Equipment

Please pack Versana Premier in the reverse order of unpacking.

Versana Premier — Basic Service Manual % System view 3-17
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3-4 Packing materials - recycling

information

The packing materials for Versana Premier are recyclable:

3-18 é System view

The Transportation Box is made of spruce or similar
material. (“PHYTOSANITARY CERTIFICATE” included in all
shipments to The People's Republic of China.)

Lever lockings (hinges) are made of zinc plated steel.

The inner reinforcements are made of Ethafoam
(Polyethylene foam).

The plastic foil is made of LDPE (Low Density
Polyethylene).
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3-5 Preparing for setup

3-5-1 Verify customer order

Compare items received by the customer to that which is listed
on the delivery order. Report any items that are missing, back
ordered, or damaged.

3-5-2 Physical inspection

Verify that the system arrived intact (visual inspection).

If the system has been damaged, please refer to ‘Damage in
transportation’ on page i-14 in the beginning of this manual.

3-5-3 EMI protection

The Versana Premier has been designed to minimize the effects
of Electro-Magnetic Interference (EMI). Many of the covers,
shields, and screws are provided primarily to protect the system
from image artifacts caused by this interference. For this reason,
it is imperative that all covers and hardware are installed and
secured before the unit is put into operation.

See 2-2-4 ‘EMI limitations’ on page 2-9 for more information
about EMI protection.
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3-6 Completing the setup

3-6-1 Purpose of this section

This section describes how to complete the installation of
Versana Premier.

3-6-2 Contents in this section

» 3-6-3 ‘System specifications’ on page 3-20

» 3-6-4 ‘Electrical specifications’ on page 3-21

* 3-6-6 ‘Connections on the 1/0 Rear Panel’ on page 3-24
*  3-6-7 ‘Connecting probes’ on page 3-24

* 3-6-8 ‘Powering the system’ on page 3-24

3-6-3 System specifications
3-6-3-1 System requirements verification

»  Verify that the site meets the requirements listed in
Chapter 2.

(See: 2-3 ‘Facility needs’ on page 2-12.)

»  Verify that the specifications below don’t conflict with any
on-site conditions.

3-6-3-2 Physical dimensions

Table 3-7:  Physical dimensions of Versana Premier

Height Width Depth Unit
less than 1780 less than 620 less than 810 mm
less than 70 less than 24.4 less than 31.8 Inches

3-6-3-3 Console Weight

*  Weight: approx. 70 kg (154.3 Ibs)
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Completing the setup

3-6-4 Electrical specifications

WARNING Conne_cting a Versa!na Premier to the wrong voltage level will
most likely destroy it.

3-6-4-1 Verification of the system’s voltage setting

Verify that the mains voltage specified for the Versana Premier
is available on-site.

Refer to the latest revision of the Basic User Manual for a full list
of product labels prior to serving the system.

3-6-4-2 Electrical specifications for Versana Premier

In the table below, the electrical specifications for Versana
Premier includes monitor and on board peripherals.

Table 3-8: Electrical specifications for Versana Premier

Power
Model Name Voltage Tolerances consumption Frequency
Versana Premier VA
100-240V +10% Max.450VA 50/60 Hz
Versana Premier VS
Versana Premier — Basic Service Manual System view 3-21

5789130-100 English Rev.5

1-iem
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3-6-5 Peripherals/Accessories Connector Panel

Versana Premier peripherals and accessories can be properly
connected using the side connector panel.

1
o

OC 12V 1.5A Out

HOMI

R Bludio Out |

©
B

Figure 3-4. Rear Connector Panel

100-240V~
50/60Hz 450VA
Input Fuse TI0AH 250VP

Power out port

DC 12V 1.5A Out (Only for Digital Box in China)

2. Diagnostic LED Diagnostic LED 1, Diagnostic LED 2, Diagnostic LED 3
3. Dual USB port USB for use
4. Ethernet 10/100MBase-T for LAN connectivity
5. USB port USB 3.0 Port for use
6. HDMI port For video port (Resolution 1920x1080)
7. VGA VGA Video Out
8. Audio Line Out Audio Line Out
9. S-Video S-Video Out
10. Composite Out Composited Video Out
11. Circuit breaker Circuit breaker
12. AC Inlet 100-240V
13. GND Ground terminal
3-22 Versana Premier — Basic Service Manual
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3-6-5-1 Pin assignment for each connector

Table 3-9:  Pin Assignments of External VGA

Pin No. Signal Pin No. Signal

1 RED 9 NC

2 GREEN 10 NC

3 BLUE 11 NC

4 NC 12 NC

5 NC 13 HSY

6 GND 14 VSY

7 GND 15 NC

8 GND

Table 3-10:  Pin Assignments of USB

Pin No. Signal
1 +5VDC
2 DATA
3 DATA
4 GND

Table 3-11:  Pin Assignment of S-Video

Pin No. Output Signal Pin No. Output Signal
1 GND 3 Y
2 GND 4 C

Table 3-12:  Pin Assignment of Composite Video Out

Output
Pin No. Output Signal Pin No. Signal
1 Composite Out 2 GND
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3-6-6 Connections on the I/O Rear Panel

NOTE:  Accessory equipment connected to the analog and digital
interfaces must be certified according to the respective IEC
standards (e.g. IEC60950 for data processing equipment and
IEC60601-1 for medical equipment). Furthermore, all complete
configurations shall comply with the valid version of the system
standard IEC60601-1. Everybody who connects additional
equipment to the signal input part or signal output part of
Versana Premier, configures a medical system, and is therefore
responsible that the Ultrasound system complies with the
requirements of the valid version of IEC60601-1. If in doubt,
consult the technical service department or your local
representative for GE.

3-6-6-1 Connect Ethernet

Connect the network cable to the Ethernet connector on the I/O
Rear Panel.

The connector is located on the rear side of Versana Premier.

3-6-6-2 Connect USB Flash Drive

NOTE: USB Flash Drive approved for Versana Premier are verified for
EMC performance according to EN55011 class B. The use of
any other USB Flash Drive will compromise this verification, and
may cause interference on Versana Premier itself, or on other
electronic devices.

For approved models, please refer to Chapter 9.

Insert the USB Flash Drive in one of the USB ports on the
Versana Premier.

3-6-7 Connecting probes

Please refer to Basic User Manual on how to connect/
disconnect a probe.

3-6-8 Powering the system

Please refer to Basic User Manual on how to power the system.
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3-7 System Configuration

3-7-1 Purpose of this section

This section describes how to configure the Versana Premier.

3-7-2 Versana Premier configuration

For complete instructions, refer to the latest revision of the
Versana Premier Basic User Manual, Chapter 16.

Information includes Entering Location, Adjusting Date and
Time, Selecting User interface Language, Selecting Online
Manual Language, Selecting Unites of Measure.
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3-7-2-1 User Configurable Key

When the system is received, please check the software option
installed on the system.
* Power on the system.

«  Enter Utility -> Admin -> System Admin -> Option
Information to check the option status.

System Admin

Product ) .
formation

Service
nable Au

En:

Protecting Health Information(PHI)
P Writi 3

Disk Encryption
Disk Encryption
Change System Password

Chan

Figure 3-5. Check SW Option Status
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3-7-2-1 User Configurable Key(continued)

To configure user configurable key, enter Utility-> System->
User Configurable Key and assign the user configurable key.

General System Imaging System Measure Backup/Restore Peripherals | User Configurable Key About

Keyboard Key User Defined Key

Enable

Figure 3-6. Assign User Configurable Key
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3-8 Peripherals Installation

3-8-1 Overview

This section describes how to install and configure the
peripherals validated for the Versana Premier.

About the operation check-out of peripherals, See
4-4-33 ‘Peripheral checks’ on page 4-65 for more information.

Table 3-13:  Versana Premier Peripherals

Description Control Model
B/W USB Printer USB port Sony UP-D898MD Printer
USB Printer USB port Sony UP-D898DC Printer
Color USB Printer USB port Sony UP-D25MD Printer
3-Pedal Footswitch USB port Footswitch MKF 2-MED USB GP26
1-Pedal Footswitch USB port Whanam FSU-1000
USB Stick USB port USB stick
USB HDD USB port 1TB mobile USB HDD
ECG ECG Port USB ECG Module
Wireless Adaptor USB port Wireless Adaptor
Bluetooth Adaptor USB port Bluetooth Adaptor
DVD RW USB port DVDRW kit with SW
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3-8-2 Furnished materials

This section describes the materials with the Peripherals and
with the system.

Retain the original carton and packing materials in case
transport is needed in the future.

B/W USB Printer

Table 3-14:

Materials furnished with B/W Printer

Item Description Quantity Note
1 Sony UP-D898DC Printer 1
2 Sony UP-D898MD Printer 1
3 Paper Roll 1
4 USB cable 1

¢« Color USB Printer
Table 3-15:

Materials furnished with Color USB Printer

Item Description Quantity Note
1 Sony UP-D25MD Printer 1
2 Paper Roll 1
3 AC Power Cord (local purchase) 1
4 USB cable 1
*  Printer Shelf
Table 3-16:  Materials furnished with the Printer Shelf
Item Description Quantity Note
1 898DC Printer Shelf 1
2 898MD Printer Shelf 1
*  Printer USB Isolator
Table 3-17:  Materials furnished with printer USB Isolatior
Item Description Quantity Note
1 Printer USB Isolator 1
« USB Stick
Table 3-18:  Materials furnished with USB Stick
Item Description Quantity Note
1 USB Stick 1

Versana Premier — Basic Service Manual
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3-8-2 Furnished materials(continued)

3-30

+ USBHDD
Table 3-19:  Materials furnished with the USB HDD
Item Description Quantity Note
1 USB HDD 1
2 USB Cable 1
*  Wireless Adaptor
Table 3-20: Materials furnished with the Wireless Adaptor
Item Description Quantity Note
1 1 Wireless Adaptor 1
*  Bluetooth Adaptor
Table 3-21:  Materials furnished with the Bluetooth Adaptor
Item Description Quantity Note
1 1 Bluetooth Adaptor 1
»  Footswitch
Table 3-22: Materials furnished with the Footswitch
Item Description Quantity Note
1 1 Pedal Footswitch 1
2 3 Pedal Footswitch 1
+ DVDRW
Table 3-23:  Materials furnished with the DVD RW
Item Description Quantity Note
1 DVD RW 1
2 USB cable 1
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3-8-3 Peripherals Installation Instructions
3-8-3-1 Sony UP-D898MD Printer Installation

3-8-3-1-1 Tools
Common Phillips screwdrivers

3-8-3-1-2 Manpower
One person 20 minutes + travel.

3-8-3-1-3 Preparations
1. Unpack B/W Printer.
2. Ensure no physical damage.
3. Shut down the system and disconnect the power cord.

3-8-3-2 Installation Procedure

NOTE: The printer driver is customized for the Versana Premier at the
factory, you do not need to change the settings.

1. Put the AC printer shelf on the bottom of the printer, and
then screw 4 screws to fix the printer shelf.

Figure 3-7. Install printer to printer shelf
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3-8-3-2 Installation Procedure(continued)

2. Remove the body left and right cover.

Figure 3-8. Remove body left and right cover

3. Remove both the printer cover and ECG cover.

0 - -NLLA.@]_.--

Figure 3-9. Remove printer and ECG cover
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3-8-3-2 Installation Procedure(continued)

4. Unscrew the 1 screw on each side, then remove the body
4PP/3PP cover assy.

e, v

Figure 3-10. Remove body 4PP/3PP cover assy
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3-8-3-2 Installation Procedure(continued)

5. Cutthe cable clip and connect the USB cable connector and
the AC power cable connector.

AC Power
Cable Connector

USB Printer cable

Figure 3-11. Connect printer power cable and USB cable

6. Put the AC printer into the printer box.
)

Figure 3-12. Insert AC printer
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3-8-3-2 Installation Procedure(continued)

7. Screw the 2 screws to fix the printer.

Figure 3-13. Push the printer assembly

8. Mount the body covers and the ECG cover in the reverse
order of step 2 - 4.
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3-8-3-2 Installation Procedure(continued)

9. Power on the system.
10. Press Utility on the Control Panel.
11. Select Connectivity-> Service, add Standard Print.

Dataflow Button Removable Media Miscella s  Bluetooth Tricefy

Properties

Name Standard

Figure 3-14. Connectivity->Service

12. Highlight Standard Print in the Service list. Select the
printer from the Printer pull-down Properties menu. Type the
printer name in the Name Filed. This name is used on the
Button screen. Press Save.

in (mm)

in (mm)

Properties

Figure 3-15. Select the Printer
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3-8-3-2 Installation Procedure(continued)

TCP/P Device

Physical Print Buttons
Print1
Print1
P
['.\

Still Images

Active Images Page

Standard Print = Stal

Versana Premier — Basic Service Manual
5789130-100 English Rev.5

Figure 3-16.

13. Select Button. Select the appropriate print key (Print,
Print3...) from the Physical Print Buttons selection. Select
the printer from MyComputer column and press >> to move
it to the Printflow View column. PressSave.

Removable Media | llaneous  Bluetooth Tricefy

= Printflow View

USB Quick Save
fyDevice
Trice Archive
-=2 Trice Patient
NewDevice
=2 Dicom Image Storage|

Select Button
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3-8-3-3 Installation Procedure

Follow these steps to set up the paper size of the printer, take
Sony UP-D898 as an example.

*  Press Utility-->System-->Peripherals. Select the UP-D898
from the pull-down menu under. Then Click Properties.

General System Imaging Measu Backup/R: e Peripherals Us:

Print and Store Options Standard Printer Properties
Removable Media Sony UP-D: C

Properties

Default Printer

Figure 3-17. Properties

»  Click Printer -> Printing Preferences at the menu of
Properties Window.

) fo e =]
Document  View

Connect Status Owner Pages Size Submitted Port

Update Driver
Pause Printing

Cancel All Documents

Sharing...
¥ | Use Printer Offline

Properties

Close

Displays your default preferences for this printer.

Figure 3-18. Properties
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3-8-3-3 Installation Procedure(continued)

» Select Paper Size. Press Apply. Press OK.

= =]

o< N concd N ooy ]

Figure 3-19. Printing Preferences

* Press Save, then Exit.
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3-8-3-4 Sony UP-D898DC Printer Installation

3-8-3-4-1 Tools
Common Phillips screwdrivers

3-8-3-4-2 Manpower
One person 20 minutes + travel.

3-8-3-4-3 Preparations
1. Unpack B/W Printer.
2. Ensure no physical damage.
3. Shut down the system and disconnect the power cord.

3-8-3-5 Installation Procedure

NOTE:  The printer driver is customized for the Versana Premier at the
factory, you do not need to change the settings.

1. Put the DC printer shelf on the bottom of the printer, and
then screw 4 screws to fix the printer shelf.

[ \ﬂ.
=
-

Figure 3-20. Install printer to printer shelf
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3-8-3-2 Installation Procedure(continued)

2. Remove the body left and right cover.

Figure 3-21. Remove body left and right cover

3. Remove both the printer cover and ECG cover.

0 - -NLLA.@]_.--

Figure 3-22. Remove printer and ECG cover
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3-8-3-2 Installation Procedure(continued)

4. Unscrew the 1 screw on each side, then remove the body
4PP/3PP cover assy.

e, v

| K y
| € y

Figure 3-23. Remove body 4PP/3PP cover assy
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3-8-3-2 Installation Procedure(continued)

5. Cut the cable clip and connect the connector of DC printer
power extension cable.

Figure 3-24. Connect DC printer power extension cable

6. Connect the DC power extension cable and USB cable to
the printer, and then lock the ring.

Lock ring

DC Power extension cable

USB cable connector

Figure 3-25. Connect printer power cable and USB cable
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3-8-3-2 Installation Procedure(continued)

7. Put the DC printer into the printer box.

Figure 3-26. Insert DC printer

8. Screw the 2 screws to fix the printer.

Figure 3-27. Push the printer assembly

9. Mount the body covers and the ECG cover in the reverse
order of step 2 - 4.

10. Refer to the Connectivity configure steps of 3-8-3-1 ‘Sony
UP-D898MD Printer Installation’ on page 3-31.
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3-8-3-6 Sony UP-D25MD Printer Installation

3-8-3-6-1 Tools
No special tools needed.

3-8-3-6-2 Manpower
One person 5 min.

3-8-3-6-3 Preparations
1. Unpack the Sony UP-D25MD Printer.
2. Ensure no physical damage.

Versana Premier — Basic Service Manual
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3-8-3-6-4 Installation Procedure
1. Place the device in a suitable place.
2. Connect the USB Cable on the Printer.

3. Connect the power cord with the AC output in the wall outlet,
and then turn on the printer.

4. Connect USB cable to Versana Premier isolated USB port.

Figure 3-28. Color Printer connection

5. Refer to the Connectivity configure steps of 3-8-3-1 ‘Sony
UP-D898MD Printer Installation’ on page 3-31.
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3-8-3-7 Footswitch Installation

3-8-3-7-1 Tools
No special tools needed.

3-8-3-7-2 Manpower
One person 2 min.

3-8-3-7-3 Preparations
1. Unpack the Footswitch.
2. Ensure no physical damage.

3-8-3-7-4 Installation Procedure

1. Connect the Footswitch to the USB port on the Versana
Premier system.

Figure 3-29. Connect Footswitch to the system (1)
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3-8-3-7 Footswitch Installation(continued)

Figure 3-30. Connect Footswitch to the system (2)
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3-8-3-7-5 Configuring Footswitch

Footswitch supports these configurations: No Function, Freeze,
Store, Print, Update, Next Step (Scan Coach), Previous Step
(Scan Coach), Scan Coach Pause/Resume.

Enter Utility -> Application-> Settings to configure the
Footswitch functions.

Settings Print Controls Imaging Controls = Comments Body Patterns Measurements

Preset

ol & Display

Patient In
Tit

Comments

 function at freeze

Figure 3-31. Configuring Footswitch Functions
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3-8-3-8 USB HDD Installation

3-8-3-8-1 Tools
No special tools needed.

3-8-3-8-2 Manpower
One person 1 min.

3-8-3-8-3 Preparations
1. Unpack the USB HDD.
2. Ensure no physical damage.

3-8-3-8-4 Installation Procedure

1. Connect the USB HDD to the USB port on the Versana
Premier system.

Figure 3-32. Connect HDD to the system
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3-8-3-9 External ECG Installation

3-8-3-9-1 Tools
NA

3-8-3-9-2 Manpower
One person 8 minutes + travel.

3-8-3-9-3 Preparations
1. Unpack the ECG Assy.
2. Ensure no physical damage.

3-8-3-9-4 Installation Procedure
1. Insert the ECG USB connector into the USB port.

Figure 3-33. Connect the USB port
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3-8-3-10 DVDRW Installation

3-8-3-10-1 Tools
No special tools needed.

3-8-3-10-2 Manpower
One person 1 min.

3-8-3-10-3 Preparations
1. Unpack the DVDRW.
2. Ensure no physical damage.

3-8-3-10-4 Installation Procedure
1. Take out the DVDRW assy.

Figure 3-34. DVDRW assy
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3-8-3-10 DVDRW Installation(continued)

2. Remove the body left and right cover.

Figure 3-35. Remove body left and right cover

3. Remove both the printer cover and ECG cover.

r

| ,
%

[

|
|

Figure 3-36. Remove printer and ECG cover

Versana Premier — Basic Service Manual 5 System view 3-53

5789130-100 English Rev.5 =
=



System Setup

3-8-3-10 DVDRW Installation(continued)

4. Unscrew the 1 screw on each side, then remove the body
4PP/3PP cover assy.

| L .

Figure 3-37. Remove body 4PP/3PP cover assy
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3-8-3-10 DVDRW Installation(continued)

5. Putin the DVD Assy and screw the 2 screws.

-

Figure 3-38. Putin the ECG Assy
6. Unscrew the screw and then remove the metal sheet.

T
Bl

Figure 3-39. Remove the metal sheet
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3-8-3-10 DVDRW Installation(continued)

7. Connect both of the DVD USB cables to the docking.

Figure 3-40. Connect both of the DVD USB cables

8. Mount the body covers and the ECG cover in the reverse
order of step 2 - 4.
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3-8-3-11 Wireless Adapter

3-8-3-11-1 Tools
No special tools needed.

3-8-3-11-2 Manpower
One person 1 min.

3-8-3-11-3 Preparations
1. Unpack the wireless adapter
2. Ensure no physical damage.

3-8-3-11-4 Installation Procedure

1. Connect the wireless adapter to the USB port on the
Versana Premier system.

Figure 3-41. Connect Wireless Adapter
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3-8-3-12 Bluetooth Adapter

3-8-3-12-1 Tools
No special tools needed.

3-8-3-12-2 Manpower
One person 5 min.

3-8-3-12-3 Preparations
1. Unpack the bluetooth adaptor
2. Ensure no physical damage.

3-8-3-12-4 Installation Procedure

1. Connect the Bluetooth Adapter to the USB port on the
Versana Premier system.

e

Figure 3-42. Connect Bluetooth Adapter
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3-8-3-12-4 Installation Procedure(continued)

2. Reboot the system.

3. After the power-up sequence is complete, press Utility on
the Control Panel. Select Connectivity-> Bluetooth, click
Add New Device.

NOTE: For Bluetooth Adapter connection, the operator must login
as Administrator.

TCP/IP Device Service Dataflow Button Removable Media Miscellaneous | Bluetooth Tricefy

This Device
Name:

Authorized Bluetooth Devices

None

Properties

Figure 3-43. Add New Device

4. Follow the Bluetooth pairing wizard to turn on Bluetooth on
your mobile device. Scan for surrounding devices. Then
select the device name of the Versana Premier in your
surrounding device list to pair.
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3-8-3-12-4 Installation Procedure(continued)

Bluetooth Pairing Wizard

Step 1. Turn on Bluetooth on your Android device.

Step 2. Scan for surrounding devices.

Step 3. Select "VERSANAE" in your surrounding devices list to pair.

Figure 3-44. Bluetooth Pairing Wizard (1)

NOTE: Versana Premier system does not support to pair with Apple
device.

5. The Pincode is shown in the dialogue, click Accept to
continue.

Bluetooth Pairing Wizard

Pincode: XXXXXX
Please COMPARE it with the Pincode shown on your mobile device.

NOTE: This will take about one minute.

Figure 3-45. Bluetooth Pairing Wizard (2)

6. On your mobile device a dialogue box should appear asking
for permission to connect to the Versana Premier system.
Click OK and wait for the process to complete.
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3-8-3-12-4 Installation Procedure(continued)

Bluetooth pairing request

Confirm passkey is xxxxxx to pair with VERSANAE.

CANCEL

Figure 3-46. Bluetooth Pairing Request

7. After pairing is done, the mobile device name appears in the
Authorized Bluetooth Devices field.

This Device

Authorized Bluetooth Devices

Properties

Figure 3-47. Connected Successfully
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3-8-3-13 Printer USB Isolator

3-8-3-13-1 Tools
No special tools needed.

3-8-3-13-2 Manpower
One person 5 min.

3-8-3-13-3 Preparations
1. Unpack the AC isolation transformer.
2. Ensure no physical damage.

3-8-3-13-4 Installation Procedure

1. Insert the Mini USB side of the cable into the Printer USB
Isolator.

i -
SB

Mini USB

Figure 3-48. Insert the USB connector into Printer USB
Isolator
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3-8-3-13 Printer USB Isolator(continued)

2. Insert the USB cable connector in one of the USB ports on
the Ultrasound system.

Printer USB Isolator
Connector Cable
Ehm:@::m:wfvg

Printer Commercmannter

Printer USB Cable
USB Isolator

Printer Power Cable

Wall AC
System Power Cord Power Outlet

Figure 3-49. Insert the USB cable into the Ultrasound system

NOTE: The Ultrasound system in above graphic is only for
illustrational purposes. You can use the Printer USB Isolator
on the desired Ultrasound system.
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3-8-3-14 EMI Filter

EMI filter can improve power grid environment.

3-8-3-14-1 Tools
No special tools needed.

3-8-3-14-2 Manpower
One person 5 min.

3-8-3-14-3 Preparations
1. Unpack the EMI Filter.
2. Ensure no physical damage.

3-8-3-14-4 Installation Procedure

1. Take out the EMI filter from the package. The EMI filter
option includes the EMI filter and the cable.

Figure 3-50. EMI Filter
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3-8-3-14 EMI Filter(continued)

2. Insert one side of the cable into the EMI Filter OUTPUT
side.

Figure 3-51. Insert the cable into the EMI filter output side

3. Insertthe Ultrasound system’s main power cord into the EMI
filter INPUT side.

Figure 3-52. Insert the system power cord into the EMI filter input side
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3-8-3-14 EMI Filter(continued)

4. Connect the EMI filter cable to the Ultrasound system, and
plug the system power cord into wall AC power outlet.

Wall AC Power
St Power Cord

“foutPuT EMI filter cable Sl

Figure 3-53. Connect successfully
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3-9 Connectivity setup

3-9-1 EZ configuration Wizard

EZ configuration wizard is a function to enable the operator to
configure some common system settings when turning on the
system for the first time after the software installation.

NOTE: Password setting is required when turning on the system for the
first time after the software installation.

For Versana Premier, you can also enter EZ Configuration
Wizard by clicking the Insite icon at the top right of the screen.

Service Menu

ContactGE
ConfigureAgent

EZ Configuration Wizard

Temperature And Power

EZ Diagnostic
Versana Club
Disruptive and VCO

Cancel

Figure 3-54. Enter EZ Configuration Wizard
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3-9-1 EZ configuration Wizard(continued)

1. Set password for Drive D (includes Archive of patient
information, temp files, user defines, logs).

Go to Install wizard -> Disk Encryption Password to set
password for Drive D.

NOTE: Drive D password setting is required when turning on the
system for the first time or after the software installation.

System will remember the password automatically.

Disk Encryption Password

Figure 3-55. Set password for Drive D

NOTE: When the HDD is removed from the unit, it will need
password to decode.
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3-9-1 EZ configuration Wizard(continued)

2. Set system password by Install wizard -> System
Password OR Utility -> Admin -> System Admin ->
Change System Password.

NOTE: System password setting is required when turning on the
system for the first time or after the software installation.

System Password

Previous

Figure 3-56. System password setting
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3-9-1 EZ configuration Wizard(continued)

3. Select the appropriate language for system language and
keyboard language from the drop-down list.

Language Setting

Previous

Figure 3-57. System Language settings (1)

NOTE: If you select Exit, you will exit the installation wizard.
» If you do not change the language, press Next to
continue.
* If you change the language setting, press OK to restart
the system.

Information

You have changed the language setting. Must restart the system!

Ok

Figure 3-58. System Language settings (2)

NOTE: If you press Previous, you will go to the previous page.
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3-9-1 EZ configuration Wizard(continued)

4. This screen shows the hospital and time information, and
you can set the system date and time here.

General Information

K Inft

May 2019

Mon Tue Wed Thu

Figure 3-59. General Information

5. Press Next to continue.
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3-9-1 EZ configuration Wizard(continued)

6. The Network Information screen shows the configuration
of wireless and local network:

Network Information

R

Figure 3-60. Wireless Network Information
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3-9-1 EZ configuration Wizard(continued)

Figure 3-61. Local Network Information

Table 3-24: Network settings

Preset Parameter Description

Enable DHCP Select to set TCP/IP.

7. Press Next to continue.
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3-9-1 EZ configuration Wizard(continued)

RSVP - Remote Assistant

8. The RSVP - Remote Assistant screen shows the
configuration of Agent and Proxy.

Submit

Figure 3-62. RSVP - Remote Assistant

Table 3-25:  Agent and Proxy Configuration

Element DESCRIPTION

CRM No Customer Relationship Management (CRM) number. System identifier assigned to the
customer unit by the service region. CRM is pre-populated by adding Versana Premier to
the CRM number. The CRM number of the Versana Premier is editable.

Serial No Serial number of the agent (read-only). If the agent is not registered with a serial number,

this field is populated with the serial number of the Versana Premier. The serial number of
the agent is tied to the serial number of the Versana Premier.

Proxy Server

When Enable Proxy is selected, name of the proxy server IP.

Proxy Port When Enable Proxy is selected, number of the proxy server port.
Username When Proxy is selected, name of the user.
Password When Proxy is selected, password for the user.

5789130-100 English Rev.5
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3-9-1 EZ configuration Wizard(continued)

After RSVP - Remote Assistant has been successfully
configured, these elements will have the corresponding
values:

* Agent Registered will be Yes

* Agent Quarantine will be No

* Agent CRM Verified will be Yes

The information on System Information is available to all
service class licenses.

To access System Information, navigate to Utility >
Service > Home.

Service Browser

A Home © DiagsVv & utilites v £ Options & Agent Configuration

@ system Information

CRM Number VERP_123456TWx1 ~
Agent Registered Yes
Agent Quarantine No
Agent CRM Verified Yes

Madel Number
Serial Number 1234567WXA

System Type VersanaPremier

Figure 3-63. System Information

9. After having set the RSVP - Remote Assistant, press Next
to continue.
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3-9-1 EZ configuration Wizard(continued)

10. This screen shows the report of the previous settings. You
can export it to the database.

Summary Information

Figure 3-64. Summary Information

Press Export and select the location where you want to
store the report.

Internal Storage(D:/log)

(9]¢ Cancel

Figure 3-65. Export Summary

11. Press Exit to exit Installation Wizard.
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3-9-2 TCP/IP Screen

1. Press Utility on the control panel and login as admin, refer

to ‘Logging on to Versana Premier as “ADM™ on page 4-11 .
2. Select Connectivity on the screen.

3. Select TCP/IP tab, the screen gives an overview of the
network settings for Versana Premier.

TCP/IP Device Service Dataflow Button Removable Media Miscellaneous  Bluetooth Tricefy

er Name |DESKTOP-OALSTAS x BElEsSINETWOT

Configuration

P-/

IP settings

Figure 3-66. TCP/IP Screen
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3-9-2-1 Changing the AE title and/or Port Number

1.

NOTE:

2.

3-9-3 Network setup

To change AE Title and/or Port No, edit the respective
fields.

TCP/IP Device Service Dataflow Button Rem|

MyComputer

Ping €D

Properties

haPremier-00000

Figure 3-67. AE Title/Port No

MAC Address will also be displayed on this page.

Select Save to store your changes. This will bring up a new
warning screen.

Question

To activate all of your changes, please restart the system. Ready to restart?

Cancel

Figure 3-68. Warning Message

Select OK to save your changes or Cancel to return without
saving any changes.

Reboot the system to activate the settings or continue with
other TCPIP setup tasks.

For network connection setup, See 7-6-1 ‘Network
Configuration’ on page 7-37 for more information.
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3-9-4 Setup connection to a DICOM server

Versana Premier is configured to work with DICOM servers in a
network environment. Images are first saved on the local image
butter on the system. At the end of the examination the images
are sent to the DICOM server via a DICOM spooler and to the
local database, depending on dataflows.

To connect to the DICOM server, the following information has to
be entered in the system.

* The DICOM server IP address
*  The DICOM server port number
» The DICOM server AE title (the server application's name)

Table 3-26: Utility ->Connectivity ->TCP/IP screen

Device Service Dataflow Button Removable Media Miscellaneous Bluetooth Tricefy

Name [DESKTOP ¢ 1 Wireless Network

1 Enter the Versana Premier computer name. This may be the same as the station name.

2 Enter the Versana Premier ip address, subnet mask, default gateway and network speed.
For automatic assignment of IP address, subnet mask and default gateway, select DHCP.

Note: If possible, set the Versana Premier network Speed to match that of the Network
switch. if in doubt, set it to AutoDetect. Otherwise, transfer times can be two or five times
longer, during which the Versana Premier will appear to be locked up. (If the Hard Drive
activity light on the front of the console is lit steady or blinks quickly, the Versana Premier is
most likely not hung.)
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3-9-4 Setup connection to a DICOM server(continued)

Table 3-27: Utility ->Connectivity ->Device screen

TCPAP Device vic Dataflow

MyComputer 1

Properties

VersanaPremier-00000 2

104 3

1 Select MyComputer.

2 Assign an AE title to the Versana Premier. (AE stands for Application Entity. DICOM
services use this to identify the Versana Premier.) AE title is case-sensitive. This
titte may contain the Computer Name from the TCP/IP page, if desired.

Note: It is NOT recommended to use the factory default. This is not prohibited, but
more than one system with the same AE title can cause confusion.

3 Edit Port Number if needed. 104 is typical. Save your changes and reboot the system.
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3-9-5 How to get the Versana Premier to recognize another Device on
the Network

Table 3-28: Utility ->Connectivity ->Device screen

Device vic Dataflow Device VicH Dataflow

Properties

1
1

1 Select Add. The system creates a device called “NewDevice”.
2 Change the name to one of your choosing.
3 Enter the IP address of the device.

| ole

Save your changes and then press Ping. A “Smiley Face” indicates successful

communication between your Versana Premier and the device. A “Frown” indicates
failed communication. Check the following:

* Is the device running?

« Is it connected to the network?

« Did you enter the right IP address?
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3-9-6 How to Setup and Use a DICOM Image Storage Service

An Image Storage Service provides a place to store patient and
exam data from Versana Premier and corresponding images.
The Image Storage Service, or the device that hosts it, is often
called a Patient Archiving and Communication System (PACS).

Table 3-29: Setup an Image Storage Service

Button Re| dia Miscellaneous  Bluetooth

Service

Dicom Image Storage

Properties

1 In Utility -> Connectivity -> Service, from the Destination Device drop-down menu, select the
device on which the service resides. (This assumes you have already setup the device in the
Device tab in ‘How to Setup and Use a DICOM Image Storage Service’ on page 3-82 .

2 From the Select Service Type to add drop-down menu, select DICOM Image Storage and press
Add.

3 Change the name of the service to one of your choosing.

4 Enter the AE Title and port Number of the service. AE Title is case-sensitive.

4 Save your changes and then press Verify. A “Smiley Face” indicates successful communication

with the service.

Note: If you get a successful Ping (Smiley Face) at the device level but not at the
service level, it is possible that the AE Title or Port Number of the service settings are
incorrect. Ensure that these are correct then re-verify. Be sure that the service type
(Store, Print, etc) is correct and supported by the device.
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3-9-7 Dataflow

f CAUTION DO NOT rename the factory default dataflow.

A dataflow is a set of pre-configured services. When you select
a dataflow, the ultrasound system automatically works according
to the services associated with the dataflow. The Dataflow tab
allows you to select and review information about dataflows. You
can also create, change, and remove dataflows.

Set up dataflows for the services.

NOTE: You must be logged on as Administrator to use the Dataflow tab.

Table 3-30: Setup an Image Storage Service

TCP/IP Device Vi Dataflow Button Removable Media Miscellaneous  Bluetooth Tricefy

=

- MyComputer

+-52 Local Archive - Int. HD
B- TricefyDevice

-5 Trice Archive

Properties *-¢ Trice Patient

1 Select the dataflow from the list.

2 Select to store data directly to archive (no buffer storage).

3 Select so that this dataflow does not appear as a Dataflow on the Patient menu.
4 Select to use this dataflow as the default dataflow when you start the system.
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3-9-8 Button

NOTE:

NOTE:

NOTE:

TCP/IP Device

Physical Print Buttons

Format*

Active Images Page

3-84 é System view
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You can assign print buttons via the Utility --> Connectivity -->
Button page.

Assigning print buttons. First select the print button to configure
on the upper, left corner of the page. Then select the device you
want to add in the middle part of the page, under Available Input/
Outputs. Then click on the right arrow in the top right corner of
the page.

You can configure each print key to multiple output devices/
dataflows.

Only attach one DICOM service per print key (e.g., PACS and
DICOM printer). Multiple DICOM devices should be configured
via a dataflow.

When using a print key to send an image directly to a DICOM
device, this causes a single DICOM association per image. Most
devices (all known printers) work fine with this. However, some
storage devices, such as ALI, Kodak Access, and Cemax,
assume that the end of each association is the end of the exam
and can result in a new folder for each image. In the Utility
menu, select a single association or open PR for the desired
DICOM storage device.

Service Dataflow Removable Medie Visce ous 3 o Tricefy

Printflow View
MyComputer

=
T» MyComputer
L2 Copy to Dataflow

‘1_‘,‘1 Copy to Dataflow
=¥ Standard Print
52 USB Quick Save
TricefyDevice
Trice Archive
Trice Patient

Figure 3-69. Botton Preset Menu
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3-9-8 Button(continued)

Table 3-31:  Physical Print Buttons

Preset Parameter

Description

M&A only (no images)

Configures the system to send a DICOM structured report only; no image
isgenerated or sent.

Table 3-32:  Still Images

Preset Parameter

Description

Format

RawDICOM, DICOM, or M&A.

Compression

Always set to None.

Table 3-33: Cllips/Volumes

Preset Parameter

Description

Cllips: Add Multiframe Data

Checkbox

Compression

None, Rle, Jpeg, Jpeg2000

Quality

Lossless, 99, 98, 97, ... 50
Note: The default Compression for Clips is JPEG85. It is strongly
recommended to keep the Compression set to JPEG85.

Table 3-34:  Active Images Page

Preset Parameter

Description

Standard Print

Lets you send to a Windows-based printer.
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3-9-9 Removable Media

The Removable Media tab allows you to:

*  Verify the DICOM directory on removable media.
»  Verify the free space of the media.

»  Verify that the media is finalized or unfinalized.

*  Verify that the media is formatted or unformatted.

*  Format removable media (rewritable CD/DVD or USB
device).

Device e Dataflow Button Removable Media M aneous Bluetooth Tricefy

Figure 3-70. Removable Media Preset Menu

Table 3-35: Tools

Preset Parameter Description
Removable Media Select the removable media to format or verify.
Label Type a label for a new removable media (free text).
Verify * Select to verify DICOM directory on removable DICOM disk.

* Verify the free space of the media.
« Verify that the media is finalized or unfinalized.
« Verify that the media is formatted or unformatted.

Format Select to format removable media.

Quick Format To format the media quickly, check this box. If you uncheck this box, the
media is formatted with a full format. New media should always be formatted
with a full format.

The bottom of the screen lists properties of the selected media.
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3-9-9 Removable Media(continued)

3-9-9-1 Formatting removable media

NOTE:

Select the removable media from the Media list.

Type a name for the removable media in the Label field.
Do not use the following characters for labelling:

\/o; ., <> +=]]

Select Format. Confirm OK or Cancel.

An information window confirms when the format has been
completed. Select OK to exit.

Verifying removable media

1.
2.

Versana Premier — Basic Service Manual
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Select Verify.
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3-9-10 Miscellaneous

The Miscellaneous tab allows you to configure tools related to
patient management and print and store options. You can
specify default system functionality, such as whether patient ID
is required when you archive data, or if you want the system to
automatically search the archive for a patient when you enter
patient data.

dia  Miscellaneous Bluetooth Tricefy

Print and Store Options

Figure 3-71. Miscellaneous Preset Menu

Table 3-36: Patient/Exam Menu Options

Preset Parameter Description

Use birthdate In the Patient information window, enter either the patient age or the
birthdate:When selected, enter birth date, then the age is
calculated.Whencleared, enter age (birth date field not available).

Auto search for patient In the Search/Create Patient window: When selected, the system
automatically searches through the selected patient archive, while the user
enters patient information.When cleared, the automatic search tool is turned
off. If you are trying to keep the past patient data confidential, DO NOT use
this feature.
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Table 3-36:

Patient/Exam Menu Options (Continued)

Preset Parameter

Description

Automatic generation of
patient ID

In the Search/Create Patient window: When selected, the Patient ID is
notrequired when entering a new patient in the archive. The
systemautomatically generates an ID number. When cleared, the Patient ID
isrequired when entering a new patient in the archive.

Auto Archiving patient data

Archives patient data automatically.

After [End Current Patient],
go to

Select go to Worklist screen or Patient screen when ending the current
patient.

Keep Search String

Search string is kept rather than cleared.

Worklist Auto Query

Automatically queries the worklist server.

Show BBT

Show BBT field on the OB patient screen to input the basal body
temperature.

Double click on patient list
to start

Select Review or New Exam to display each time you double click on the
patient name in the patient list on the Patient menu.

Detail Mode

Select to display Detail Mode, rather than Exam View, when you select the
patient name in the patient list on the Patient menu. You can also type
comments while in Detail Mode.

Export to USB HDD:
Create DICOMDIR

Export to Network storage:
Create DICOMDIR

Create DICOMDIR is a DICOM file format which contains how the directory
and DICOM files structured for diagnostic portable media behave. It is
important for portability between the Versana Premier to PACS. If you want to
save exams to the USB Hard drive and look at it on the PACS, the
DICOMDIR is a must.

Automatic Disable Patient
Data

Select to automatically disable patient data.
If selected, locks the patient name, date of birth and gender (like Patient ID).
The Factory Default for this preset is unchecked.

Remember Cursor Position
on the Transfer Screen

To set a default cursor location on the Data Transfer screen:

1. Select the “Remember cursor position in the Transfer screen” preset and
press Save.

2. On the Data Transfer screen, move the cursor to the desired field.

3. Exit out of the Data Transfer screen. When returning to the Data Transfer
screen, the cursor location is in the position your selected.

Quick New Patient Entry

Select to store new patient automatically by pressing the Patient key.

Table 3-37:

Patient/Exam Message Options

Preset Parameter

Description

Patient info exist in logfile

Check box to select.

Request acknowledge of E
nd Exam action

When selected, the user is asked to confirm action when ending an
examination.

Warn Image Store without
Patient

Select to receive a warning when you press the Print key without an active
patient.
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Table 3-37:

Patient/Exam Message Options

Preset Parameter

Description

Warn Register to No
Archive

Select to receive a warning when you register a patient to the “No Archive”
data flow. Select a different data flow for permanent storage of patient data.

Warn image store to Read
Only dataflow

The system posts a warning message if you attempt to store images to a
read-only Dataflow.

Warn video titles exist in
the internal storage

The system posts a warning if the video titles exist on the internal DVR flash
memory.

Table 3-38:  Print and Store Options

Preset Parameter

Description

P[1-3] Key Sound

Select None, Click, Chimes, Ding, Ding-Dong, or Whoosh.

Store Dual as Dicom Only

Select to always store dual images as a DICOM (secondary capture) store,
rather than Raw DICOM.

Dual When Color Support
is Mixed

Dataflow Mixed is not available. While transferring dual images to the PACS,
send black and white images as gray; send color images as color. Set up 2
services (one gray and one color), set up 2 dataflows, and set up 2 buttons. E
ach button needs to be tied to a different service.

Select if you want to keep the user preset for Color Photometric Interpretation
while in Dual mode.

Store Multiframe for Sec
Capture Loops

Select if you want the CINE loop stored as secondary capture.

Enable Whizz Capture
Area

Check box to select.

Store 2D Loop with
Timeline Data

Check box to select.

Patient List Print-Font Size

Select font size.

Image Order Scheme

Select to Direct Store images in Acquisition Order, Scan Coach/Assistant

Order, or Off.

« Off. The clipboard on the Ultrasound system shows the image in the order it
was acquired. Therefore, re-stored images appear where you’d expect.
However, on the PACS system, images appear in arrival order or in image
number order.

* Acquisition Order. From the Ultrasound system perspective, the same as
“Off.” But on the PACS system (if based on image number order), images
are displayed consistently with the way they are stored on the Ultrasound
system.

» Scan Coach/Assistant Order. You can define the storage order (reading
order) via Scan Coach/Assistant Creator. Therefore, based on the order
defined in Scan Coach/Assistant, images are re-ordered and displayed in
this manner both on the Clipboard and on the PACS system.
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Table 3-39:  Other ID Options

Preset Parameter Description

Enable Other ID Not selected is the Default.

If selected, allow entering Other ID, such as Citizen Service Number, Burger
Service Number (BSN), National Health System (NHS) number, along with
patient ID information on the Patient Screen.

Validation Format If the Enable Other ID preset is selected, the system validates the format of
“Other ID” when an ID is entered. Choose: NHS Number *** ** ***** 1| etters
and Numbers, Numbers, or Any (no restriction)
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3-9-11 Bluetooth

This Device
Name

Authorized Bluetooth Devices

Properties

To add a new bluetooth device,

1. Press Add New Device.
2. Type the device name in the Name field.

Button ! e aneous Bluetooth Tricefy

Figure 3-72. Connectivity Bluetooth Preset Menu

Table 3-40: Device

Preset Parameter

Description

Add New Device/Remove

Press Add new device to add a new device; press Remove to delete a
device.

Properties: Name

Type the name of the device.

Properties: MAC Address

Unique network card address. NOTE: Only available for MyComputer.

Properties: Enabled

Select to enable bluetooth device.

Properties: Image Transfer
Support

Select to enable image transfer.

Properties: Date Added

Display the new device added date.
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3-9-12 Tricefy

New GE Versana ultrasound systems have Tricefy pre-installed.
Additional software is not necessary for using Tricefy; simply
activate your account using the following steps.

1. Press Utility -> Connectivity -> Tricefy.

NOTE: The Tricefy tab is only available on machines that have
Tricefy option.

Dataflow Button Removable Media Miscellanecus  Blustooth Tricefy

Figure 3-73. Tricefy Menu

2. Enable Tricefy checkbox, and enter the email address to
authorize the account. Press “ Activate account” to
activate your account, this process may take up to 30
seconds, and a dialog will pop up if succeeded. And you will
receive a notification email, click the link to complete the
whole activating process.

Ultrasound Cloud

Configure the P-Buttons for Send and

Figure 3-74. Activate Tricefy Account
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3-9-12 Tricefy(continued)

3. Add Tricefy to Print workflow.

* Click Button to configure the P- Bottons for sending
and sharing images.

TCP/IP Device Service Dataflow Button Removable Media Miscellaneous  Bluetooth Tricefy

Figure 3-75. Button Menu

»  Select Print1 (or Print2, Print3) which you would like to
use. Then Select Trice Archive and press >> button to
add it to Printflow View, press Save. Now when you
press the P1 button, the image will be sent to your
Tricefy cloud.

TCP/IP Device e Dataflow Button Removable M Mi: aneous  Bluetooth Tricefy

Physical Print Buttons

=] Prin
Print1 MyComputer
Print1 I’mﬁ Copy to Dataflow &- MyComputer
—<¥ Standard Print L Copy to Dataflow
| L:e USB Quick Save
P Save As
T— ImiceTyuevice
=2 Trice Archive
| -2 Trice Patient

E- NewDevice
52 Dicom Image Storage

Figure 3-76. Configure the P-Button for Tricefy
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3-9-12 Tricefy(continued)

4. If you want to share the images to patient, please add Trice
Patient to Printflow View. And also remember input the
patient’s Phone number or email address.

Patient

Data Transfer

New Patient

Register

Details

Figure 3-77. Share Images to Patient

NOTE: If you has any problem with Tricefy settings, please contact
your GE service/sales representative.
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3-10 Option Setup

3-10-1 Software Option Installation Procedure

NOTE:  Not all features described in this section may be available or
cleared for sale in all markets. Please contact with your local GE
Ultrasound representative to get the latest information.

1. Power on the system.
NOTE: Keep the power cord connection during the installation.

2. Atfter the power-up sequence is complete, press Utility on
the control panel, and then select Admin-> System Admin.

WARNING For software Option Installation, the operator must login as
Administrator.

3. Enter the new SW Option key and then select Add.

System Admin Users

Product
uct

Numb

Service

Protecting Health Information(PHI)

Figure 3-78. New Option Key
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Option Setup

3-10-1 Software Option Installation Procedure(continued)

4. To activate the changes, press OK to restart the system.

Question

To activate all of your changes, please restart the system. Ready to restart?

Cancel

Figure 3-79. Dialog Window

NOTE: There is no need to restart the system after each
installation, if several option keys are installed at one time.
Select Cancel for the first several times, and select OK after
the last installation to activate all the changes.

5. After the system is powered on, check the option status.

System Admin Users Logon User policies

Product

Service

Ena

Protecting Health Information(PHI)

Prevent Writing to Removable Media-CD/DVD/USB (restart needed)

Disk Encryption
Disk Encryption
Change System Pa

Chal

Figure 3-80. Check Option Status

The option status explanation:
* Permanent: This option is enabled in the system.
» Disabled: This option is disabled in the system.
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System Setup

3-10-1 Software Option Installation Procedure(continued)

6. Configure the user define key in utility. On the screen, the

user defined key name will be displayed.

Figure 3-81. User define key display on the screen

7. This completes the option installation of Versana Premier.

NOTE:

Installing corresponding hardware is a prerequisite of
loading software option successfully. Please check below

table for correspondence.

Table 3-41:  Software Corresponding Hardware

Software Option

Hardware

4PP 4PP Front Cover Assy
DVDROM DVD Writer Kit
3D_4D 4D Box Assy

3-98 § System view
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Paperwork after setup

3-11 Paperwork after setup

NOTE:  During and after setup, the documentation (i.e. CDs with
documentation, User Manuals, Installation Manuals, etc.) for the
Versana Premier and the peripherals must be kept as part of the
original Ultrasound system documentation. This ensures that all
relevant safety and user information is available during the
operation and service of the complete Ultrasound system.

3-11-1 Contents in this Section

*  3-11-2 ‘User’s Manual(s) on page 3-99
*  3-11-3 ‘Product Locator Installation Card’ on page 3-100

3-11-2 User’s Manual(s)

User Check that the correct User Manual(s) for the system and
software revision, is included with the installation. Specific
language versions of the User Manual may also be available.
Check with your GE Sales Representative for availability.

Versana Premier — Basic Service Manual System view 3-99
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System Setup

3-11-3 Product Locator Installation Card

NOTE: The Product Locator Installation Card shown may not be the

same as the provided Product Locator card.

GE Medical Systems General Electric CGR Yokogawa Medical Systems Ltd.
matrg  Froduct Locator File Product Locator Adm. - DSE/SM  GEMBA Service Administration
Addess PO, Box 414 283 Route de la Miniere 4-7-127 Asahigaoka
Milwaukee, W1 53201-0414 78530 Buc, FRANCE Hino-shi Tokyo 191, JAPAN
CESCAPTION F& | WODEL REY SERIAL
FYSTEM UTL ocrP BS ORD EMLOYEE M)
EasTRCT ROOM CATE (MO - D4 - YR)
CUSTOMER M3,

INSTALLATION ==

46-303268 Rev 5

3-100 s System view
& 5

i

ZIP CO0E

Figure 3-82. Product Locator Installation Card (Example)
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Chapter 4

General Procedures and
Functional Checks

This chapter provides procedures for quickly checking
major functions of the Versana Premier and diagnostics
instructions using the built-in service software.
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General Procedures and Functional Checks

4-1 Qverview

4-1-1 Purpose of this chapter

This chapter provides procedures for quickly checking major
functions of the scanner and diagnostics instructions using the
built-in service software.

4-1-2 Contents in this chapter

*  4-1‘Overview’ on page 4-2

*  4-2 ‘General procedures’ on page 4-3

* 4-4 ‘Functional checks’ on page 4-41

*  4-5 ‘Power supply test & adjustments’ on page 4-65

4-1-3 Special Equipment required

To perform these tests, you'll need any of the sector, linear, or
convex probes. (Normally you should check all the probes used
on the system).

4-2 ; System view Versana Premier — Basic Service Manual
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General procedures

4-2 General procedures

f CAUTION Ultrasound system requires all covers.

Operate this Ultrasound system only when all board covers and
frame panels are securely in place. The covers are required for
safe operation, good Ultrasound system performance and
cooling purposes.

When servicing parts of the Ultrasound system where there is
exposure to voltage greater than 30 volts:

1. Follow LOCK OUT/TAG OUT procedures.

Turn off the breaker.

Unplug the Ultrasound system.

Maintain control of the Ultrasound system power plug.

Wait for at least 30 seconds for capacitors to discharge as
there are no test points to verify isolation.

f WARNING Energy Control and Power Lockout for Versana Premier.

o oD

Ultrasound System components may be energized.
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General Procedures and Functional Checks

4-2-1 Overview

Some procedures are used more often than other. The intention
with this section is to keep the most used procedures in one
place.

4-2-1-1 Contents in this section

4-4

=

i

System view

4-2-2 ‘Power ON/Boot Up’ on page 4-5

4-2-3 ‘Power off’ on page 4-8

4-2-5 ‘Logging on to Versana Premier as “ADM” on
page 4-11

4-2-6 ‘Service Key (SSA)’ on page 4-12

4-2-7 ‘Exit to Windows Desktop from the Versana Premier
application software’ on page 4-13

4-2-8 ‘Removable media’ on page 4-13

4-2-9 ‘Backup and Restore Database, Preset Configurations
and Images’ on page 4-13

4-2-10 ‘Data Management’ on page 4-22

4-2-11 ‘Backup’ on page 4-22

4-2-16 ‘Cleaning the Trackball’ on page 4-24

4-2-17 ‘Cleaning the air filters’ on page 4-26

Versana Premier — Basic Service Manual
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General procedures

4-2-2 Power ON/Boot Up
4-2-2-1 Warnings
DANGER ALWAYS CONNECT THE ULTRASOUND SYSTEM TO A

FIXED POWER SOCKET WHICH HAS THE PROTECTIVE
GROUNDING CONNECTOR.

DANGER NEVER USE A THREE-TO-TWO PRONG ADAPTER; THIS
DEFEATS THE SAFETY GROUND.

DANGER ENSURE THAT THE POWER CORD AND PLUG ARE
INTACT AND THAT THE POWER PLUG IS THE PROPER

HOSPITAL-GRADE TYPE (WHERE REQUIRED).

CAUTION Ultrasound system requires all covers.

Operate this Ultrasound system only when all board covers and
frame panels are securely in place. The covers are required for
safe operation, good Ultrasound system performance and
cooling purposes.

CAUTION Use only power supply cords, cables and plugs provided by or
designated by GE.

NOTE: Do not cycle the Circuit Breaker ON-OFF-ON in less than five
(5) seconds. When turning OFF the Circuit Breaker, the
Ultrasound system should de-energize completely before
turning the circuit breaker ON.

Versana Premier — Basic Service Manual
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General Procedures and Functional Checks

4-2-2-2 Connect AC (mains) Power to Versana Premier

4-6 é System view

Connecting AC Power to the Versana Premier ultrasound unit,
involves preliminary checks of the power cord, voltage level and
compliance with electrical safety requirements.

1.

Ensure that the wall outlet is of appropriate type, and that
the Circuit Breaker is turned off.

Uncoil the power cable, allowing sufficient slack so that the
unit can be moved slightly.

Verify that the power cable is without any visible scratches
or any sign of damage.

Verify that the on-site mains voltage is within the limits
indicated on the rating label near the Circuit Breaker on the
rear of the unit.

Connect the Power Cable’s female plug to the Power Inlet at
the rear of the unit.

Lock the plug in position with the Retaining Clamp (ACC
Clamp).

Verify that the Mains Power Circuit Breaker is in OFF
position, if not, switch it OFF.

Connect the Power Cable’s other end (male plug) to a
hospital grade mains power outlet with the proper rated
voltage, and the unit is ready for Power ON/Boot Up.

Versana Premier — Basic Service Manual
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General procedures

4-2-2-3 Switch ON the AC Power to Versana Premier

NOTE:

NOTE:

Versana Premier — Basic Service Manual

5789130-100 English Rev.5

Switch ON the Mains Power Circuit Breaker at the rear of
the unit.

You should hear a “click” from the relays in the AC Power
and the unit is ready to boot.

Press once on the On/Off key on the Operator Panel to boot
the unit.

During a normal boot, you may observe that:

a.

The unit’s ventilation fan starts on full speed, but slows
down after a few seconds (listen to the fan sound).

Power is distributed to the peripherals, Operator Panel
(Console), Monitor, Front End Processor and Back End
Processor.

Back End Processor and rest of scanner starts with the
sequence listed in the next steps:

Back End Processor is turned ON and starts to load the
software.

The Start Screen is displayed on the monitor.

A start-up bar indicating the time used for software
loading, is displayed on the monitor.

The software initiates and sets up the Front End
electronics and the rest of the instrument.

The backlight in the keyboard is lit.

As soon as the software has been loaded, either a 2D
screen is displayed on the screen, indicating that a
probe has been connected, or a No Mode screen is
displayed, indicating that no probe has been connected.

Total time used for start-up is typical one and a half
minutes or less. If starting after a power loss or a
lock-up, the start-up time may be up to four minutes.

Diagnostic LEDs on the rear panel indicate the boot up
status, refer to “Normal Status®in Table 7-10 on
page 7-51.

System view 4-7
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General Procedures and Functional Checks

4-2-3 Power off

4-8 45 System view

=~

When you switch off the unit, the system performs an automatic
shutdown sequence.

The SYSTEM - EXIT menu, used when switching off the unit,
gives you these choices:

System Exit

System Administrator is logged on as ADM

Logon Time 2018/07/02 - 02:27

No software upgrade is being performed.

Figure 4-1. System Exit Window

Logoff
Use this button to log off the current user.
The system remains ON and ready for a new user to log on.

If the Logoff button is dimmed, it indicates that no user is
logged on to the unit at the moment.

Shutdown

Use this button to shut down the system. The entire system
will shut down. It is recommended to perform a full shutdown
at least once a week.

If the Shutdown button is dimmed, use the key-combination
<Ctrl+Alt+Delete> to shut down the unit.

Versana Premier — Basic Service Manual
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General procedures

4-2-3 Power off(continued)

NOTE: To enable the key-combination <Ctrl+Alt+Delete>, the
dongle should be connected to the system.

« Cancel

Use this button to exit from the System-Exit menu and
return to the previous operation.

4-2-3-1 System shutdown

Disconnect the Mains Power Cable is necessary. For example:
Relocating the scanner.

off sequence has been completed. Failure to do so may result

f CAUTION DO NOT unplug and/or transport the unit until after the power
in corrupted patient files.
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General Procedures and Functional Checks

4-2-4 Check System Date and Time

A warning message "Please check the system date and time are
correct" appears on the screen when the system is powered on.
This warning message appears for the possible reasons:

* The system is not boot up for over 14 days.

* The system time has been changed by 24 hours earlier than
the current system time of last boot-up.

* The BIOS time is changed by 24 hours earlier than the

current system by resetting BIOS time,replacing BIOS
module or changing BIOS time.

This warning message is to remind the user to check the system
date in case the system date and time is incorrect.

Warning

Please check that system date and time are correct.

Figure 4-2. Check system date and time message
Move the cursor to OK and press Cursor key on the control
panel to select OK. The system enters.

Check the system date and time. If it is incorrect, follow below
steps to reset the system date and time.

Enter Utility -> System -> General -> Date/Time.
Reset the system date and time.

Select Apply and then select OK.

Select Save.

4-10 ; System view Versana Premier — Basic Service Manual
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General procedures

4-2-5 Logging on to Versana Premier as “ADM”

Select Utility on the control panel, then select Admin.

It will bring up the Operator Login dialog where you must log
on.

NOTE: When User Operator Login Window pop up for the first time, it’s
required to set the ADM password forcefully.

Operator 1

Password:

Figure 4-3. Operator Login Window

1. Operator: Select the operator.
2. Password: Enter Operator’s password (optional).
3. Select the type of Login or Cancel.

* OK: Standard login.
* Cancel: Cancel login.

As default, ADM is defined.
- ADM

If you log on as ADM, you will have access to do general set-up,
service adjustments, adjust network and connectivity settings.

Select the name ADM, the password as default and select
Login.

It is possible for the administrator (ADM) to establish new users
(USR) and set unique passwords for each user, including a new
password for ADM. If the login as ADM fails, contact the
responsible person in the hospital to get access.

+ USR

If you log on as USR, you will have access to do set-up tasks
that a user may need to do during daily use.

Versana Premier — Basic Service Manual ; System view 4-11
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General Procedures and Functional Checks

4-2-6 Service Key (SSA)

A Service Key and a proprietary GE Service password are
necessary for use by GE Service when performing proprietary
level diagnostics like accessing the desktop on the BEP. The
password used with the GE service key changes at specific
intervals.

The SSA key provides secure access for GE service personnel
to advanced tools to service the system.

SSA is a class M key with the following characteristics:

* Access to all service features

* Access to Windows Desktop

* Key must be renewed every 30 days
* Tied to SSO

* Password locked via key pad

Please complete the course on GE Learning before using SSA:
Course name: Secure Service Access Training
Course ID: GEHC-SVCS-63061025

NOTE: Press | Agree to enter the Maintenance Access Screen when
below Information dialogue window appears. Press OK before
the status bar completes, otherwise the system may enter
scanning screen.

Checking Secure Key
Owner : 212455016

The Service Key is owned by the individual identified above. Use of the key and the
activities performed with this key are monitored and reported to GE Healthcare.,

I Agree

Figure 4-4. Service Key Information

5789130-100 English Rev.5
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General procedures

4-2-7 Exit to Windows Desktop from the Versana Premier application

software

If you want to exit to the Windows Desktop when the application
software is running, please refer to Proprietary Service Manual.

4-2-8 Removable media

Refer to the latest revision of the User Manual to perform the
following tasks:

* Using Removable Media

* Labeling Removable Media

* Formatting Removable Media

*  Verifying Removable Media

4-2-9 Backup and Restore Database, Preset Configurations and

Images

NOTE:  Always save presets before any software reload. This ensures
the presets loaded after the software reload are as up—to—date
as possible.

All user presets except changes to Summary, Anatomy, and
Biometry pages, can be saved on an DVD-R disk (or USB
memory device) for reloading on the system.

NOTE:  Presets should NOT be saved on the same USB memory device
(or DVD-R disk) as images. The Archive Menu lists the images
but does NOT list the presets stored on a USB memory device
(or DVD-R disk).

Versana Premier — Basic Service Manual
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General Procedures and Functional Checks

4-2-9-1 Formatting Media

1. Select Utility -> Connectivity -> Removable Media.
2. Select the media type from the drop down menu.

3. Enter the label for the media. It is best to use all capital
letters with no spaces or punctuation marks. Select Format.

Button Removable Media M

Repair

Quick Format

Figure 4-5. Format and Verify Media

4. The system displays a pop-up menu, as shown in
Figure 4-6, select OK to continue.

Warning

Are you sure you want to format H: and remove all data from the media

Figure 4-6. Format Warning Pop-up Window

5. If desired, verify that the format was successful by returning
to Utility-> Connectivity->Removable Media and selecting
Verify.
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General procedures

4-2-9-2 Backup System Presets and Configurations

NOTE:  Always backup any preset configurations before a software
reload. This ensures that if the presets need to be reloaded,
after the software update, they will be the same ones the
customer was using prior service.

1. Insert a formatted media into the drive.
2. Enter Utility-> System-> Backup/Restore.

NOTE: If you are not logged in as GE Service or with administrator
privileges, the Operator Login window is displayed. Log on
with administrator privileges.

3. Inthe Backup list, select Patient Archive, User Defined
Configuration and Service.

4. In the Media field, select CD/DVD (or USB memory device).

5. Select Backup.

The system performs the backup. As it proceeds, status
information is displayed on the Backup/Restore screen.

General System Imaging System Measure |Backup/Restore Peripherals User Configurable Key About

Backup
Media
Media

EZMove

USB Control

Enable US

Figure 4-7. Backup/Restore Menu
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General Procedures and Functional Checks

4-2-9-3 Restore System Presets and Configurations

local hard drive. Make sure to insert the correct CD (or USB

f CAUTION The restore procedure overwrites the existing database on the
memory device).

1. Insert the Backup/Restore CD/DVD (or USB memory
device) into the drive.

2. Enter Utility-> System-> Backup/Restore.

NOTE: If you are not logged in with administrator privileges, the
Operator Login window is displayed.Log on with
administrator privileges.

3. In the Restore list, select Patient Archive, User Defined
Configuration and Service.

4. In the Media field, select the Backup/Restore CD/DVD (or
USB memory device).

5. Select Restore.

The system performs the restore. As it proceeds, status
information is displayed on the Backup/Restore screen.

General System Imaging System Measure |Backup/Restore Peripherals User Configurable Key

Restore

Media
Media CD/DVD
EZMove

der Than in Days

USB Control

Enable USB (

Figure 4-8. Restore message
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General procedures

4-2-9-4 Archiving Images

1. Insert the archive media.

2. To format the archive media, enter Utility-> Connectivity->
Removable Media.

3. Format the CD. Verify the format if desired.

4. Images will be moved from the hard drive by date.
Therefore, the best way is to label media by date.

NOTE: Images will be moved from the hard drive by date.
Therefore, the best way to label media is by date. When
images are moved to the archive media, they will be deleted
from the system hard drive. However, the patient database
(backed up earlier) maintains pointers to the location of the
images on the archive media.

TCP/IP Device Service Dataflow Button Removable Media Mis«

Repair

Figure 4-9. Format Media Screen

5. Enter Utility-> System-> Backup/Restore.
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General Procedures and Functional Checks

4-2-9-4 Archiving Images(continued)

6. Select “Move File Older Than in Days”.

System Measure |Backup/Restore Peripherals = User Configurable Key

Restore

Backup

Media Detailed Restore of User Defined

Media CD

Restore

USB Control

Enable USE

Figure 4-10. EZBackup/Move

7. Press EZBackup/EZMove.

e Exam View

Date v Category Exam Description Img. size
2018106107 Abdomen None

Figure 4-11. EZBackup Wizard 1
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General procedures

4-2-9-4 Archiving Images(continued)

8. \Verify the information on the first page of EZBack/EZMove
wizard, then select Next.If you want to backup all of the
exams in the range (even if the exam was previously
backed up), check this option. If you uncheck this option, the
system only backs up exams which have not yet been
backed up.

Next Cancel

Figure 4-12. EZBackup Wizard 1

9. lItindicates the size of the data and the storage. Select Next
to continue.

NOTE: The calculation for the number of backup CD is only an
estimate. Allow for one additional CD when performing an
EZBack/EZMove.

Size of Data :

Patient Archive : 0 MB
Images to back up : 102.4 MB

Reports to back up : Disable for backup

Number of images larger than 565 MB : 0

Discs :

Total size : 102.6 MB

New discs needed (approximated) : 1 (each disc capacity is 650 MB)

Back| Next |Cancel

Figure 4-13. EZBackup Wizard 2
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General Procedures and Functional Checks

4-2-9-4 Archiving Images(continued)

420 W
=

i

NOTE: This message “Please insert a blank media...” appears if
you press Next without inserting the backup media. Insert
the media and continue.

Information

Please insert a blank media (it will be labeled as 20180607_01) in CDRW drive.

ALL DATAIN THE MEDIAWILL BE ERASED.

Click OK to continue and CANCEL to quit backup.

Ok Cancel

Figure 4-14. Insert Media Message

10. The status menu appears. When the backup/move has
been complete, press Next.

Figure 4-15. EZBackup Wizard 3

NOTE: If you need to insert the next media, a message appears
providing you with the media label.

System view Versana Premier — Basic Service Manual
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4-2-9-4 Archiving Images(continued)

11. When the backup is complete, the completion wizard page
appears. Press Finish.

Figure 4-16. EZBackup Completion Window

All databases, presets and images should now be saved to
removable media.

Versana Premier — Basic Service Manual
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4-2-10 Data Management

Refer to the latest revision of the Versana Premier Basic User
Manual to perform the following tasks:

»  Configuring the Disk Management Function

«  Setting the Disk Management Schedule

»  Configuring Data Management Settings

»  Configuringestination Device Setting

*  Running the Disk Management Function

« Starting Disk Management Manually

4-2-11 Backup

For more information, refer to the latest revision of the Versana
Premier Basic User Manual.

4-2-12 Restore the factory defaults

For instructions, please see “Data Backup and Restore” in the
Basic User Manual/User Guide.

connecivity.res and IPSave in
D:\ldunn\target\resources\idunn\userdefs could not be deleted.
If they are deleted, please rewrite the serial number.

f WARNING To avoid not being able to connect to Local Archive,

4-2-13 Installation and Setup Procedure for Peripherals

Please refer to 3-8-3 ‘Peripherals Installation Instructions’ on
page 3-31.
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General procedures

4-2-14 Where are the User Manuals and the Service Manual?

Online versions of the User Manuals are available via the help
function.

Both the User Manuals and the Service Manual are delivered as
PDF files on a CD-ROM. Paper copies may be ordered from
GE.

4-2-15 How to display or print the PDF files from the Manual CD?

1. Insert the CD-R disk (CD-ROM) into the CD-drive on a PC
or Laptop with Adobe Acrobat Reader.

CAUTION Do not try to use the Versana Premier to read these files, it will
not work!

2. Follow the instructions on the screen to display the manual
of choice.

3. Before printing the complete manual, or pages from the
manual, select File > Print.

4. Select the paper size and choose Portrait.
5. Select Print to start printing. In the pop up window, you may

choose which pages to print and the number of copies you
want to print (usually 1 copy).
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General Procedures and Functional Checks

4-2-16 Cleaning the Trackball

WARNING DQ NOT touch any boards with int_egrated circuits prior to
taking the necessary ESD precautions.

Always connect yourself, via an arm-wrist strap, to the advised
ESD connection point located on the rear of the Ultrasound
system (near the power connector).

Follow general guidelines for handling of electrostatic sensitive
equipment.

AN

4-2-16-1 Manpower

One person, 10 minutes,

4-2-16-2 Tools

« Antistatic brush and/or antistatic vacuum cleaner

4-2-16-3 Preparations

To get access to the trackball for cleaning, you must perform the
following steps:

1. Power down the system.
2. Disconnect the mains power cable from the wall outlet.

Follow these links if you need more information: See
4-2-3 ‘Power off’ on page 4-8 for more information.
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4-2-16-4 Clean the Trackball

Dust is often building up behind the ball, so it interferes with the
ball rotation and for optical trackballs the light used for sensing.
To get access for cleaning, you need to remove the ball.

The ball is held in position by the Dust Gasket.

1. Power off the system.

2. Rotate the dust gasket counterclockwise until it can be
removed from the keyboard.

Figure 4-17. Remove the retainer

3. Separate the trackball and the gasket. Wipe off any oil or
dust from the trackball, gasket and the trackball housing
using a cleaner or cotton swab.

4. Assemble the trackball and gasket, then put it into the
housing and rotate it clockwise until its notches are set in

the position.
CAUTION When cleaning, make sure not to spill or spray any liquid into
the trackball housing (keyboard or system).

4-2-16-5 Test the Trackball

Power up the system and test that the trackball now works as
intended.
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4-2-17 Cleaning the air filters

Clean the system's air filters to ensure that a clogged filter does
not cause the system to overheat and reduce system
performance and reliability. It is recommended the filters be
cleaned every two weeks, but the requirements will vary due to
your system use.

CAUTION Be sure to lock the wheels before cleaning the air filters to
avoid injury by any unexpected movement of the system.

DO NOT operate the unit without the air filters in place.

Allow the air filters to dry thoroughly before re-installing them
on the unit.

4-2-17-1 Cleaning

1. Power off the system.
2. Remove the body left and right cover on both sides.

o 3
Figure 4-18. Remove the body left cover
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4-2-17 Cleaning the air filters(continued)

3. Remove the air filters on both side panels.

N S B \
Figure 4-19. Remove the Filters

4. Dust the filters with a vacuum cleaner and/or wash it with a
mild soapy solution.

If washed, rinse and dry the filters before re-installation.
5. Re-install the clean filter in the reverse order of removal.
Please align the 3 Pins with the 3 holes on the body left cover

\I' @
Figure 4-20. Install the Air Filter
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4-2-18 Monitor

To clean the monitor face:
Use a soft, folded cloth. Gently wipe the monitor face.

DO NOT use a glass cleaner that has a hydrocarbon base (such
as Benzene, Methyl Alcohol or Methyl Ethyl Kentone) on
monitors with the filter (anti-glare shield). Hard rubbing will also
damage the filer.

NOTE: When cleaning the screen, make sure not to scratch the
monitor.

4-2-19 Operator Control Panel

To clean the operator control panel:

1. Moisten a soft, non-abrasive folded cloth with a mild,
general purpose, non-abrasive soap and water solution.

2. Wipe down operator control panel.

3. Use a cotton swab to clean around keys or controls. Use a
toothpick to remove solids from between keys and controls.

NOTE: When cleaning the operator control panel, make sure not to spill
or spray any liquid on the controls, into the system cabinet, or in
the probe connection receptacle.

NOTE: In case of SARS, use bleach, alcohol, or Cidex in a normal
diluted form for cleaning/disinfecting the operator panel.

NOTE: DO NOT use T-spray or Sani Wipes on the control panel.

CAUTION Before cleaning the control panel, make sure the key cap is
firmly in place.
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Disk Encryption/Decryption

4-3 Disk Encryption/Decryption

4-3-1 Overview

Disk Encryption is a function to protect the patient information on
the device and prevent unauthorized access to PI/PHI,
especially when the device is stolen. The encryption AES is 256
bit.

NOTE: Disk Encryption can also protect the user data stored on
removable device.

NOTE: The steps for Removable Media Encryption and Local Patient
Data Drive Encryption are the same.

keys. It is the customer’s responsibility for storing the keys. GE
will have no back door or any responsibility or possibility of
recovering the data.

f CAUTION The user must make backups and take care of the encryption
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4-3-2 Disk Encryption

1. Login as administrator. Press Utility -> Admin -> System
Admin -> Disk Encryption.

Disk encryption

LSt‘lecl encrypt medium:

!Security level for patient data stored on the system:

Conversion Status: Fully Decrypted
Lock Status: Unlocked

Protection Status: Unprotected

Figure 4-21. Disk Encryption 1

2. Select Encryption ON. A confirmation message pops up,
press Continue to continue the encryption process.

Disk encryption

Select encrypt medium:

The process of enabling encryption of the patient data on the system will take a
considerable amount of time (in the range of one to serveral hours). The system
should not be used when this process is ongoing. Other functions will be
blocked and current exam will be closed.

Press Continue to proceed with enabling encryption, or press Cancel to abort.

Protection Status: Unprotected

Figure 4-22. Disk Encryption
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Disk Encryption/Decryption

4-3-2 Disk Encryption(continued)

3. Enter a password or a passphrase and re-enter to confirm.
Press Continue.

NOTE: A valid password must be at least 8 characters long and has
a maximum length of 256 characters.

Disk encryption - select password or passphrase

The password [ passphrase will protect the patient data on the device.
Passwords and passphrases should be selected with a propriate length and
complexity, and be according the company policies and general security

recommandations.

Enter password | passphrase:

Re-enter password | passphrase:

Figure 4-23. Disk Encryption 3

4. Insert a USB and select it to record the recovery key. You
can also press Print recovery key to print the recovery key,
or you can press Hide recovery key to hide the recovery
key.

Press Continue.

Disk encryption

Disk encryption - Store key / recovery key

P T P R S e e

Information

Figure 4-24. Disk Encryption 4
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4-3-2 Disk Encryption(continued)

5. When the recording process is completed, a confirmation
dialog pops up, press OK.

Information

Figure 4-25. Disk Encryption 5

6. Encryption process begins.
You can press Pause to pause the encryption process.

Disk encryption

Select encrypt medium:

Disk encryption - Encrypting...

Encryption of patient data is ongoing. Please don't use the system until the process is completed,

91.7%

Lock Status: Unlocked

Protection Status: Protected

Figure 4-26. Disk Encryption 6

7. When the encryption process completes, press Finish.

NOTE: The encryption process for patient data drive may take thirty
minutes or more.

CAUTION Make sure to keep the password/passphrase, recovery key
and any back up of these in secure place, not accessible

for unintented audience.
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4-3-3 Pause Encryption

1. During encryption process, you can press Pause to stop the
encryption process.

Disk encryption - Encrypting...

Encryption of patient data is ongoing. Please don't use the system until the process is completed]
91.7%

Figure 4-27. Encryption Pause 1

2. A confirmation dialog pops up, press Yes to continue or No
to cancel.

Question - Pause Conversion

want to PAU SE Encryption/Decryption now?

Figure 4-28. Encryption Pause 2

Versana Premier — Basic Service Manual 5, System view 4-33

5789130-100 English Rev.5 |
=~



General Procedures and Functional Checks

4-3-4 Resume Encryption

1. Press Utility -> Admin -> System Admin -> Disk Encryption.
Press Resume.

Disk encryption

Select encrypt medium:

Encryption has been interrupted, please resume the conversion.

Conversion Status: Encryption Paused

Lock Status: Unlocked

Protection Status: Unprotected

Figure 4-29. Encryption Resume 1

2. A confirmation dialog pops up, press Yes to rusume
conversion or press No to cancel.

Disk encryption

Select encrypt medium:

Question - Resume Encryption

Do you want to Resume the Encryption now?

Protection Status: Unprotected

Figure 4-30. Encryption Resume 2
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Disk Encryption/Decryption

4-3-4 Resume Encryption(continued)

3. Encryption of patient data is ongoing. Please do not use the
system until the process is completed.

Disk encryption - Encrypting...

Encryption of patient data is ongoing. Please don't use the system until the process is completed.

O oo

Figure 4-31. Encryption Resume 3

4-3-5 Change Password

After the encryption process is completed, you can change the
password as you wish.

1. Press Utility -> Admin -> System Admin -> Disk
Encryption. Press Change Password.

Disk encryption

Select encrypt medium:

Security level for patient data stored on the system:

Conversion Status: Fully Encrypted

Lock Status: Unlocked

Protection Status: Protected

Figure 4-32. Change Password 1
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4-3-5 Change Password(continued)

2. Enter new password/passphrase, and re-enter it to confirm.

Disk encrvption

Disk encryption - select password or passphrase

The password | passphrase will protect the patient data on the device.
Passwords and passphrases should be selected with a propriate length and
complexity, and be according the company policies and general security
recommandations.

Enter password [ passphrase:

Re-enter password / passphrase:

Figure 4-33. Change Password 2

3. Press OK.

Information

Password has been changed successfully.

Figure 4-34. Change Password 3
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Disk Encryption/Decryption

4-3-6 Change Recovery Key
Atfter the encryption process is completed, you can change the
recovery key as you wish.

1. Press Utility -> Admin -> System Admin -> Disk
Encryption. Press Save/Change Recovery Key.

Disk encryption

Select encrypt medium:

Security level for patient data stored on the system:

Conversion Status: Fully Encrypted

Lock Status: Unlocked

Protection Status: Protected

Figure 4-35. Change Recovery Key 1

2. Insert a USB to store the new recovery key.

Disk encryption

Disk encryption - Store key / recovery key

Select drive to store key | recovery key:

Print recovery key i very key Continue Cancel

Protection Status: Unprotected

Figure 4-36. Change Recovery Key 2
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4-3-6 Change Recovery Key(continued)

3. Press OK.

Information

Recovery Key has been succeffuly saved to H:\ENG001-05E4659E-

D24A-4B62-9667-A15522FBACD3

Figure 4-37. Change Recovery Key 3

Information

ery Key has been Changed successiully,

Ok

Figure 4-38. Change Recovery Key 4

4-3-7 Unlock with user entered key & recovery key

When the patient data is in locked status, you can unlock it with
user entered key and recovery key.

You can insert the USB with recovery key, or you can input the
password or recovery key manually to unlock the system.

NOTE:  If you press Cancel, the system will stay in locked status and
some of the functions will be not available.

The patient data stored on the device is encrypted. The encryption
key is not stored on the device and there is no USE storage device
containing the key connected.

Connect USE device with Recovery key, enter Password or enter
Recovery key, or press Cancel to continue for Emergency scanning:

@ WUSB with Recovery key is now connected, try reading from USB

() Password:
) Recovery key:

Key ID: CCOCDFDF-CBCC-4400-98C0-719717C5CE0F

o« | Cancel |

Figure 4-39. Unlock Dialog
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4-3-8 Emergency Scanning

1. Boot scanner.
2. Press Cancel on unlock dialog.

The patient data stored on the device is encrypted. The encryption
key iz not stored on the device and there is no USE storage device
containing the key connected.

Connect USE device with Recovery key, enter Password or enter
Recovery key, or press Cancel to continue for Emergency scanning:

@ USB with Recovery key is now connected, try reading from USE

Password:
Recovery key:

Key ID: CCOCDFDF-CBCC-4400-98C0-719717C5Ca0F

- N ]

Figure 4-40. Cancel Unlock Process

3. Continue as before (Press Emergency in login dialog).

Versana Premier — Basic Service Manual é System view 4-39
5789130-100 English Rev.5



General Procedures and Functional Checks

4-3-9 Disk Decryption

1. If you want to decrypt the patient data, you can press Utility
-> Admin -> System Admin -> Disk Encryption. Select
Encryption Off.

Disk encryption

Select encrypt medium:

Security level for patient data stored on the system:

P

Conversion Status: Fully Encrypted

Lock Status: Unlocked

Protection Status: Protected

Change |

Figure 4-41. Decryption 1

2. A confirmation dialog pops up, press Yes to continue.

3. Decryption of patient data is ongoing. Please don’t use the
system until the process is completed.

Disk encryption - Decrypting...

Decryption of patient data is ongoing. Please don't use the system until the process is completed.

Figure 4-42. Decryption 2

4. When the decryption process is completed, press Finish.
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4-4 Functional checks

4-4-1 Overview

In this section, the functional checks for Versana Premier are
described. Functional checks are used to verify that the product
works as intended. Functional checks may also be used during

troubleshooting.

4-4-2 Contents in this Section

4-4-3 Preparation

Turn on power to Versana Premier. For detailed description, See
4-2-2 ‘Power ON/Boot Up’ on page 4-5 for more information.
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4-4-4 Basic Controls

4-4-5 Control Panel

“shift

N7 20 O21
e =)

Figure 4-43. Control Panel Map

e e, S
1. Power On/Off 11.
2. Patient key 12.
3. Probe key 13.
4. Report key 14.
5. End Exam key 15.
6. Whizz key 16.
7. Cursor key 17.
8. M Mode/Z 18.
9. CW 19.
10. Clear key 20.

4-42 ﬁ System view
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Measure key

PW Mode/Y

PDI

CF Mode/X

Body Pattern key
Comment key

B Mode key

Freeze key

Dual key&Quad key
Depth key

21.
22.

23.
24.
25.
26.
27.
28.
29.

& Elipse

Ellipse/Zoom key

Utility -> Connectivity ->
Button

Scan Coach key
Alphanumeric Keyboard
Utility

Comment key

CHI key

Trackball

User Configurable Keys

Versana Premier — Basic Service Manual
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4-4-6 Versana Premier SoftMenu Key Tour

1. Rotary key: Rotate to adjust the menu.
2. Page Up/Down key: To turn the menu page up and down.

Figure 4-44. SoftMenu Key Tour
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4-4-7 Control Panel

N

aod

® N o

9

Figure 4-45. Monitor Display Tour

Institution/Hospital Name, Date, Time, Operator
Identification.

Patient Name, Patient Identification.

Power Output Readout.

Probe Identifier. Exam Preset.

Current date and time, Caps Lock: (lit when on),
network connection indicator, system messages
display, InSite status, InSite controls.

Imaging Parameters by Mode.

Cine Gauge.

Active Images screen.

Delete Image.

10. Save As Menu.
11. Three types of Images Clipboard.
12. Image Preview.

4-44 -.\ System view
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m

13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23.
24.
25.
26.
27.

Trackball Functionality Status.
Measurement Results Window.
Gray/Color Bar.

Image Clipboa

rd.

Probe Orientation Marker.

Image.

Measurement Calipers.
Region of interest.

Depth Scale.

Focal Zone Indicator.

Body Pattern.

Measurement Summary Window.
User Configurable Key.

P1, P2, P3.
Follow-up tool.
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4-4-8 Performance Tests

4-4-8-1 Image Quality Check (IQC) preset for service

Image Quality Check (IQC) is intended to facilitate Image
Quality checks during Quality Assurance Evaluation. Quality
Assurance tests are used to determine whether a scanner is
providing the same level of performance year after year.

By using the same setting year after year, this ensures that the
data collection consistent, independently of who performs the
test.

This preset only includes fundamental settings for 2D mode.
Processing modes like SRI, Harmonics, etc., are turned off.

To do IQC, follow the steps below:

NOTE: The IQCforService is only visible when service dongle is
connected to the system.

1. Activate IQC via Utility--> Admin--> System Admin.
Check the “Enable IQC for Service” box. Select Save, then
select Exit.

System Admin Users

Product . .
nformation

N Num

SW Option Key

Installed Option Keys

Remove

Service

Protecting Health Information(PHI)

Prevent Writ to Removable Media-CD/DVD/USB

Disk Encryption

Disk Encryption

Figure 4-46. Check “Enable IQC for Service”

2. Press Utility -> Imaging Preset Manager. Select IQC from
the left column, and selece to move it to the
Imaging Preset Selections. Then Select Exit.
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General Procedures and Functional Checks

4-4-8-1 Image Quality Check (IQC) preset for service(continued)

Imaging Preset Manager

Figure 4-47. Image Quality Check

3. Press Probe/Preset on the control panel. Then select

Exit after Probe

Cancel

Figure 4-48. Image Quality Check
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4-4-8-2 Test Phantoms

The use of test phantoms is only recommended if required by
your facility's (customer’s) QA program.

Versana Premier — Basic Service Manual
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4-4-9 B Mode Checks

4-4-9-1 Introduction

The B Mode is the system’s default mode.

4-4-10 B Mode Screen Example

4-4-11 Preparations

» Connect one of the probes.
*  Turn ON the scanner.

The B Mode is displayed (default mode).

4-4-12 Adjust the B mode controls

Press B Mode on the Operator Panel to access B mode.

These Image Controls are used to optimize the B Mode picture.
Verify that all the listed controls are working as intended:

* Use Gain and TGC controls to optimize the overall image
together with the Power control.
* Use Depth to adjust the range to be imaged.

* Use Focus to center the focal point(s) around the region of
interest.

» Use Frequency (move to higher frequencies) or Line
Density (move to higher line density) to increase resolution
in image.

* Use Frequency (move to lower frequency) to increase
penetration.

* Use the Rejection control to reduce noise in the image.
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4-4-13 M Mode Checks

4-4-14 M-Mode Screen Example

4-4-15 Preparations

Connect one of the probes to the scanner’s left-most probe
connector.

Turn ON the scanner.

The 2D Mode window is displayed (default mode).
Press M Mode on the Operator panel to bring up an
M-Mode picture on the screen.

Use the trackball to position the cursor over the required
area of the image.

4-4-16 Adjust the M Mode controls

These Image Controls are used to optimize the M mode picture.
Verify that all the listed controls are working as intended:

Versana Premier — Basic Service Manual

5789130-100 English Rev.5

Adjust Horizontal sweep to optimize the display resolution.
Adjust Gain and TGC controls to adjust the range to be
imaged.

Adjust Compression and Edge Enhance to further
optimize the display.

Adjust Rejection to reduce noise while taking care not to
eliminate significant low-level diagnostic information.

System view 4-49

1-iem



General Procedures and Functional Checks

4-4-17 Color Mode Checks

4-4-17-1 Introduction

Color Flow screens are 2D or M Mode screens with colors
representing blood or tissue movement.

Color Flow may be selected both from 2D mode or from M mode
or a combination of these.

4-4-17-2 Preparations

*  Connect one of the probes to the scanner’s left-most probe
connector.

¢ Turn ON the scanner.

The 2D Mode window is displayed (default mode).

4-4-18 Select Color 2D Mode

1. From an optimized 2D image, press CF.

2. Use the trackball to position the ROI frame over the area to
be examined.

3. Press Set. The instruction Size should be highlighted in the
trackball status bar. Use the trackball to adjust the
dimension of the ROI.
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4-4-19 Adjust the Color Mode controls

NOTE:

NOTE:

NOTE:

Versana Premier — Basic Service Manual
5789130-100 English Rev.5

Adjust the Active mode gain to set the gain in the color flow
area.

Adjust Scale to the highest setting that provides adequate
flow detection.

The scale value may affect FPS, Low Velocity Reject, and
Sample Volume.

Adjust Wall Filter to remove low velocity blood flow and
tissue movement that reduces image quality.

Adjust Sample volume (SV) to a low setting for better flow
resolution, or a higher setting to more easily locate disturbed
flows.

Adjust Frequency to optimize the color flow display. Higher
settings improve resolution. Lower settings improve depth
penetration and sensitivity. This does not affect the
frequency used for 2D and M-Mode.

Frequency setting may affect FPS, SV and Low Velocity
Reject.

Adjust PowerOutput to obtain an acceptable image using
the lowest setting possible.

The Power setting affects all other operating modes.

Adjust the following settings to further optimize display of the
image:

Use Invert to reverse the color assignments in the color flow
area of the display.

Use Threshold to emphasize either the color flow overlay,
or the underlying grey scale tissue detail.

Use Baseline to emphasize flow either toward or away from
the probe.

Use Spatial Filter to reduce noise in the color flow area.
Spatial Filter smooths the image by averaging collected data
along the same horizontal line. An increase of the spatial
filter will reduce noise, but this will also reduce the lateral
resolution.
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4-4-20 Select Color M Mode

1. Select M Mode.

2. Use the trackball to position the ROI frame over the area to
be examined.

3. Press Set. The instruction Size should be highlighted in the
trackball status bar. Use the trackball to adjust the
dimension of the ROI.
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4-4-20-1 Adjust the Color M Mode controls

NOTE:

NOTE:

NOTE:

Adjust the Active mode gain to set the gain in the color flow
area.

Adjust Scale to the highest setting that provides adequate
flow detection.

The scale value may affect FPS, Low Velocity Reject, and
Sample Volume.

Adjust Wall Filter to remove low velocity blood flow and
tissue movement that reduces image quality.

Adjust Sample volume (SV) to a low setting for better flow
resolution, or a higher setting to more easily locate disturbed
flows

Adjust Frequency to optimize the color flow display. Higher
settings improve resolution. Lower settings improve depth
penetration and sensitivity. This does not affect the
frequency used for 2D and M-Mode.

NOTE: Frequency setting may affect FPS, SV and Low
Velocity Reject.

Adjust PowerOutput to obtain an acceptable image using
the lowest setting possible.

The Power setting affects all other operating modes.

Adjust the following settings to further optimize display of the
image:

Versana Premier — Basic Service Manual
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Use Invert to reverse the color assignments in the color flow
area of the display.

Use Threshold to emphasize either the color flow overlay,
or the underlying grey scale tissue detail.

Use Baseline to emphasize flow either toward or away from
the probe.
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4-4-21 PW Doppler Mode Checks
4-4-21-1 Introduction

PW Doppler are used to measure velocity (most often in blood).

Doppler mode can be done with a special pencil probe or with
an ordinary probe. By using an ordinary probe, you can first
bring up a 2D picture for navigation purpose and then add PW
Doppler.

4-4-21-2 Preparations

» Connect one of the probes to the scanner.

*  See 4-4-26 ‘Probe/Connectors Check’ on page 4-59 for info
about connecting the probes.

For available probes, see 9-3-2 ‘Probe’ on page 9-6:.
*  Turn ON the scanner
The 2D Mode window is displayed (default mode).
* If needed, adjust the Display’s Brightness and Contrast
setting.
Press PW to start Pulsed Wave Doppler (PW).

Use the trackball to select the Area of Interest (Sample
Volume) in PW.
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4-4-22 Adjust the PW Doppler Mode controls

Adjust the Active mode gain to set the gain in the spectral
Doppler area.

NOTE:

NOTE:

Versana Premier — Basic Service Manual
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Adjust Wall Filter to reduce unwanted low velocity blood
flow and tissue movement.

In PW mode, adjust Sample volume to low setting for better
resolution, or higher setting to more easily locate the
disturbed flows.

Adjust the Compression setting to balance the effect of
stronger and weaker echoes and obtain the desired intensity
display.

Adjust Frequency to optimize flow display. Higher setting
will improve resolution and the lower setting will increase the
depth penetration.

Adjust Frame rate to a higher setting to improve motion
detection, or to a lower setting to improve resolution.
Frequency and Frame rate settings may affect the Low
Velocity Reject.

Adjust Power Output to obtain an acceptable image using
the lowest setting possible. This is particularly important in
CW mode, as the energy duty cycle is 100% (constant).

The Doppler Power setting affects only Doppler operating
modes.

Adjust the following settings to further optimize the display
of the image.

Use the Sweep Speed to optimize the sweep speed.

To view signal detail, adjust Scale to enlarge the vertical
spectral Doppler trace.

Use Invert to reverse the vertical component of the spectral
Doppler area of the display.

Use Angle Correct to steer the ultrasound beam to the
blood flow to be measured.
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4-4-23 Tissue Velocity Imaging (TVI) Checks

4-4-23-1 Introduction

TVI calculates and color codes the velocities in tissue. The
tissue velocity information is acquired by sampling of tissue
Doppler velocity values at discrete points. The information is
stored in a combined format with grey scale imaging during one
or several cardiac cycles with high temporal resolution.

4-4-23-2 Preparations

NOTE:

4-56 é System view

Connect one of the probes, to the scanner’s left-most probe
connector.

See 4-4-26 ‘Probe/Connectors Check’ on page 4-59 for info
about connecting the probes.

For available probes, see 9-3-2 ‘Probe’ on page 9-6:
Turn ON the scanner.

The 2D Mode window is displayed (default mode).

If needed, adjust the Display’s Brightness and Contrast
setting.

Press TVI.

Use the trackball (assigned function: Pos) to position the
ROI frame over the area to be examined.

Press Set. The instruction Size should be highlighted in the
trackball status bar.

If the trackball control pointer is selected, press trackball to
be able to select between Position and Size controls.

Use the trackball to adjust the dimension of the ROI.

Versana Premier — Basic Service Manual
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4-4-24 Adjust the TVI Controls

NOTE:

NOTE:

Versana Premier — Basic Service Manual
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To reduce quantification noise (variance), the Nyquist limit
should be as low as possible, without creating aliasing. To
reduce the Nyquist limit: Reduce the Scale value.

The Scale value also affects the frame rate. There is a trade
off between the frame rate and quantification noise.

TVI provides velocity information only in the beam direction.
The apical view typically provides the best window since the
beams are then approximately aligned to the longitudinal
direction of the myocardium (except near the apex). To
obtain radial or circumferential tissue velocities, a
parasternal view must be used. However, from this window
the beam cannot be aligned to the muscle for all the parts of
the ventricle.

PW will be optimized for Tissue Velocities when activated
from inside TVI.
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4-4-25 Basic Measurements

NOTE: The following instructions assume that you first scan the patient
and then press Freeze.

4-4-25-1 Check Distance and Tissue Depth Measurement

Press Measure once to display an active caliper.

Move the trackball to position the active caliper at the start
point (distance) or the most anterior point (tissue depth).
Press Set to fix the start point.

The system fixed the first caliper and displays a second
active caliper.

Move the trackball to position the second active caliper at
the end point (distance) or the most posterior point (tissue
depth).

Press Set to complete the measurement. The system
displays the distance or tissue depth value in the
measurement results window.

Before you complete a measurement:

To toggle between active calipers, rotate Cursor Select button.

To erase the second caliper and the current data measured and
start the measurement again, press Clear.

NOTE: To rotate through and activate previously fixed calipers, rotate
Cursor Select button.

NOTE:  After you complete the measurement, to erase all data that has
been measured to this point, but not data entered onto
worksheets, press Clear.
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4-4-26 Probe/Connectors Check

NOTE: Probes can be connected at any time, whether the unit is ON or
OFF.

4-4-26-1 To connect a Probe

1. Place the probe’s carrying case on a stable surface and
open the case.

2. Carefully remove the probe and unwrap the probe cable.
3. Put the probe in the probe holder.

probe head could result in irreparable damage.

f CAUTION DO NOT allow the probe head to hang free. Impact to the

4. Hold the probe connector vertically with the cable pointing
upward.

5. Slide the connector lock to the left (unlocked position).

6. Align the connector with the probe port and carefully push
into place.

7. Slide the connector lock to the right position to secure the
probe connector.

8. Carefully position the probe cable in the probe cord holder
spot so it is free to move, but not resting on the floor.

CAUTION TAKE THE FOLLOWING PRECAUTIONS WITH THE PROBE
A CABELS:
-KEEP AWAY FROM THE WHEELS
-DO NOT BEND

-DO NOT CROSS CABLES BETWEEN PROBES

Table 4-1:  Probe and Connectors Checks

Step Task Expected Results
1 Select the appropriate connected probe from the The probe activates in the currently-selected
probe indicators. operating mode. The probe’s default settings
for the mode and selected exam are used
automatically.
2 Launch the application. To change application, The selected application starts.
press Probe key on the Control Panel.
3 Verify there’s no EMI/RFI or artifacts specific to the | No EMI/RFI or artifacts.
probe.
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General Procedures and Functional Checks

Table 4-1:  Probe and Connectors Checks

Step Task Expected Results
4 Test the probe in each active connector slot. It will display pictorial data each time.
5 Do a leakage test on the probe, See It passes the test.
10-7 ‘Electrical safety tests’ on page 10-23 for
more information.
6 Repeat this procedure for all available probes.

4-4-26-2 Activating the probe

The probe activates in the currently-selected operating mode.
The probe’s default settings for the mode and selected exam are
used automatically.

4-4-26-3 Deactivating the probe

3.

Press the Freeze key.

Gently wipe the excess gel from the face of the probe.
(Refer to the User Guide for complete probe cleaning
instructions.)

Carefully slide the probe around the right side of the
keyboard, toward the probe holder. Ensure that the probe is
placed gently in the probe holder.

4-4-26-4 Disconnecting the probe

Probes can be disconnected at any time. However, the probe
should not be selected as the active

1.
2.
3.

Unlock the probe.
Pull the probe and connector straight out of the probe port.

Carefully slide the probe and connector away from the
probe port and around the right side of the keyboard.

Ensure the cable is free.

Be sure that the probe head is clean before placing the
probe in its storage box.

bend, be sure to keep probe cables free from the wheels.

f WARNING Take the following precautions with the probe cables: Do not
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Functional checks

4-4-27 ECG Check

4-4-27-1 Introduction

The ECG capability on this unit, is intended as use as a trigger
for measurements, but can also be viewed on the screen.

4-4-27-2 Parts needed

« ECG Module

4-4-27-3 Preparations

None
4-4-27-4 ECG Check
Table 4-2: ECG Checks
Step Task Expected Result(s)
1 Connect the ECG harness to the connector The unit displays a straight curve along the
under the control panel. bottom edge of the image sector on the screen.
2 Connect the three leads to an ECG simulator, | When connecting, the signal on the screen will

or

Fasten the three ECG Pads to your body and
connect the three leads to respective ECG
Pad.

be noisy.
When the connection is completed, a typical
clean ECG signal is displayed.
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General Procedures and Functional Checks

4-4-28 Cineloop Check

4-4-28-1 Introduction

A cineloop is a sequence of images recorded over a certain time
frame. When using ECG the time frame can be adjusted to
cover one or more heart cycles. When frozen, the System
automatically displays the cineloop boundary markers on either
side of the last detected heart cycle.

4-4-29 Preparation

Connect one of the probes to the scanner.

See 4-4-26 ‘Probe/Connectors Check’ on page 4-59 for info
about connecting the probes

For available probes, see 9-3-2 ‘Probe’ on page 9-6:

Turn ON the scanner. The 2D Mode is displayed (default
mode).

4-4-30 Adjust the Cineloop controls

Press Freeze.

The left and right markers are displayed on either side of the
last detected heart cycle on the ECG trace.

Press Freeze.
The selected heart beat is played back.
Press Freeze to freeze the cineloop.

Use the trackball to scroll through the acquisition and find
the sequence of interest.

Adjust Cycle select to move from heart beat to heart beat
and select the heart cycle of interest.

Adjust Num cycles to increase or decrease the number of
heart beats to be played back.

Adjust Left marker and Right marker to trim or expand the
cineloop boundaries.

4-4-31 Back End Processor checks

4-62 § System view

If all the previous tests have been passed successfully, the
Back End Processor is most likely OK.

If the system seems to be operating erratically, please refer
to ‘Diagnostics/Troubleshooting’ on page 7-1.
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4-4-32 Operator Panel Test

*  The Operator Panel is tested when the Versana Premier is
powered up as part of the start-up scripts, run at every
start-up.

For more info, please refer to ‘Diagnostics/Troubleshooting’
on page 7-1.

4-4-33 Peripheral checks

Check that peripherals work as described below:

Table 4-3:

Peripheral Checks

Step

Task to do

Expected Result(s)

Press FREEZE

Stop image acquisition.

Press PRINT on the
Control Panel

The image displayed on the screen is

printed on B&W printer.

Connect with Foot
Switch on USB port
and press once.

To start image acquisition (the same
function as FREEZE key).

4-4-33-1 Printer checks

The internal printer is controlled from the Print and Store keys
on the Versana Premier’s Operator Panel.

The factory default is:

*  Print for the standard printer

Store for the screen capture to clipboard

4-4-34 Turn OFF Power to Versana Premier

See 4-2-3 ‘Power off’ on page 4-8 for more information.

4-4-35 Mechanical Functions Checks

4-4-35-1 Operator Panel Movement

Please refer to:

*  6-3 ‘Monitor Adjustments’ on page 6-6
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General Procedures and Functional Checks

4-4-35-2 Casters (Wheels) and Brakes Checks

Examine the wheels frequently for defects to avoid breaking or

jamming.

Table 4-4: Wheel Characteristics

Wheel

Characteristics

Front and Rear

Swivel and Brake
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4-5 Power supply test & adjustments

4-5-1 Power Supply Test Procedure

There is no need to do any special tests on the Power Supplies
if there don’t seems to be a problem that may be related to the
Power Supply.

Refer to 7-7-1-1 ‘System Doesn’t Boot (Hang-up)’ on page 7-51,
if you appear to have a problem that may be related to the
Power Supplies.

4-5-2 Power Supply Adjustment

There are no adjustments on the power supply. The DC Power
is self-regulated. If a voltage is outside the specified range, it
means that something is wrong, either with the power supply
itself or with a unit connected to that specific power outlet. When
an error occur, the power will be turned off immediately.

Refer to 7-7-1-1 ‘System Doesn’t Boot (Hang-up)’ on page 7-51,
if you appear to have a problem that may be related to the
Power Supplies.
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4-6 Application Turnover Check List

Complete these checks before returning the scanner to
customer for use:

4-6-1 Software Configuration Checks

Table 4-5: Software Configuration Checks

Step Task to do Notes
1 Verify Date and Time is correct.
2 Verify that Location (Hospital Name) is correct.
3 Verify Language settings are correct.
4 Verify assignment of Print Keys.
5 Verify all of the customer’s options are set up Demo Option strings turn on
correctly.
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Site Log

4-7 Site Log

Table 4-6:  Site Log

DATE SRVICE PERSON PROBLEM COMMENTS
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4-8 My Trainer

4-8-1 Overview

My Trainer provides a quick guide to operate the system.
To access My Trainer,

1. Press Alt + H to enter My Trainer.
Or,
1. Press Utility -> System -> User Configurable Key. Check

Enable Numeric Hot Key, then set My Trainer in the
Keyboard Key or User Defined Key.

Vieasure Backup/Restore  Peripherals | User Configurable Key About

User Defined Key

Figure 4-49. Set My Trainer

2. Press defined key to access My Trainer.

There are five sections in My Trainer. The five sections are
displayed on the left side of the My Trainer interface.
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My Trainer

4-8-1 Overview(continued)

Getting started

e,
System setbing

Penpheral connection

— e
Maintenance

g oW NN =

e —————————————
Quick Card

Figure 4-50. Sections display

Getting Started: Circuit breaker, Probe Connection, Touch
Panel

System Setting: Facility name set up, Date time set up,
Enable options check, Language setting, User conf, User
preset

Peripheral Connection: Back panel ports, Network
Connectivity, Connect to a printer, DICOM setting, Back-up/
restore the patient information, software version.

Maintenance: Trackball, Contact GE service, Insite, Log
export, Air Filter Replacement.

Quick Card: Control Panel Overview, Entering Patient Data,
Selecting a Probe/Application, Measurements, Annotating
an Image, Adjust Color ROI, Pulsed Wave Doppler, Split
Screen, End Exam, About GE Healthcare.
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4-8-1 Overview(continued)

Welcome to

For Versana Premier Series @

BookMark Software version (2/2)

©)

e 0o o o
N
Description

Select the Admin tab in Utility to display the serial number of the device.

Gpe

Figure 4-51. Interface lllustration

The interface of the My Trainer includes below information:

1. The product name of the system.

2. Sections. Select the button to expand the section to show
the list of subsections.

3. Subsections.

4. The highlighted subsection shows this subsection is
currently opened and displayed on the right side.

5. Exit. Press this button to exit this interface.

6. The left number shows the current page of the subsection.
The right number shows the total pages of the subsection.

7. lllustration with graphic.
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My Trainer

4-8-1 Overview(continued)
8. Text instruction about how to operate.

Table 4-7:  Page turning

Select the arrow to go to the previ-
ous page

Select the arrow to move to the next
page.

Select the arrow to go to the home
page

Select the arrow to go to the end
page.

Versana Premier — Basic Service Manual ; System view 4-71

5789130-100 English Rev.5 o
i~



General Procedures and Functional Checks

4-72 é System view Versana Premier — Basic Service Manual

— 5789130-100 English Rev.5
=~



Chapter 5

Components and Functions
(Theory)

This chapter explains Versana Premier’s system
concepts, component arrangement, and subsystem
functions.

It also describes the power distribution and the
Common Service Desktop interface.
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Components and Functions (Theory)

5-1 Overview

5-1-1 Contents in this chapter

*  5-1‘Overview’ on page 5-2
* 5-2 ‘Block Diagram and Theory’ on page 5-3
* 5-3 ‘Common Service Desktop’ on page 5-6
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Block Diagram and Theory

5-2 Block Diagram and Theory

5-2-1 General Information

Versana Premier is an ultrasound imaging scanner.
The system can be used for:

» 2D Gray Scale

« 2D Color Flow imaging

* M-Mode Gray Scale imaging

* Color M-Mode

*  Doppler

« Different combinations of the above

Signal flow from the Probe Connector Panel to the Front End, to

the Mid Processors and Back End Processor and finally to the
monitor and peripherals.

System configuration is stored on a hard disk drive and all
necessary software is loaded from the hard disk drive on power
up.

5-2-2 Top Console

The Top Console includes a Standby/On switch, a keyboard,
different controls for manipulating the picture quality, controls for
use in Measure & Analyze (M&A), and loudspeakers for stereo
sound output (used during Doppler scanning).
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Components and Functions (Theory)

5-2-2-1 Block Diagram

5-2-2-2 System Diagram

Touch
Panel

ACIn| Power

100-240vAc Box

Monitor W |
|

System FAN

Figure 5

-1.

Versana Premier System Block Diagram

NOTE: The dotted square illustration shows the option parts.

5-4 i System view
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Block Diagram and Theory

5-2-2-2-1 System Diagram Introduction

The system is composed of top modules, one box and power
box which is located at the bottom side of the machine.

The top module include Keyboard Assy, Speaker, Monitor (21.5
inch), Touch panel and optional peripherals like AC/DC printer,
ECG module, DVD and Gel warmer.

The one box has 4 PWAs:CWI (CPU_WDC_10 Board), MST,
PIB (Probe Interface Board) and CWD board. System FANs are
also included in the Box to dissipate the system thermal. 4D
module is mounted on this one box.

There is IODKG (I/O Docking) board which is fixed in the
mechanical frame, this board connects with one box through the
docking connector, and provides all I/O signals for system use.

The power box includes power switch, AC noise filters and an
ACDC module which provides DC19V power to system. It also
has AC outlet for on-board AC printer.

NOTE: When AC power in, the power is DC19V generated by ACDC of
Power Box; When no AC power, and if the machine has battery,
the power is discharged from battery.
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Components and Functions (Theory)

5-3

5-3-1 Introduction

5-6 é System view

Common Service Desktop

The Service Desktop is an interface that provides access to
system information, status and diagnostics.

The Service Desktop has different content or views depending
on the access level. The access level is determined by the user
profile as well as the service options enabled on the Versana
Premier.

* Basic view is the standard view, restricted only by the user
through the user profile settings. Administrator default user
has access to the Service Desktop. Any user with "local
Service access" in their user profile can have access to this
view.

* Class C view is the view enabled by the service options
purchased.
« Service Advanced
» Service Expert (requires Service Advanced)
» Service Pro (requires Service Advanced)

Versana Premier — Basic Service Manual
5789130-100 English Rev.5



Chapter 6

Service Adjustments

This chapter describes how to test and make
adjustments to the Versana Premier. You can use these
to test the system for errors.
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Service Adjustments

6-1 Overview

6-1-1 Contents in this chapter

*  6-1‘Overview’ on page 6-2
* 6-2-1 ‘Region presetting procedure’ on page 6-4
*  6-3 ‘Monitor Adjustments’ on page 6-6
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Preset Region

6-2 Preset Region

Only factory default presets are supported. User is allowed to
selection region presets according to where the system is used

with service support.

Table 6-1:  Preset Region

Region

Preset Region

USA, Canada and Latin America

USA_LA Preset

Europe EU Preset
China China Preset
APAC Asia Preset
South Asia India Preset

Middle East, Africa and other countries

EAGM Preset
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Service Adjustments

6-2-1 Region presetting procedure

6-4

=

A

=~

The Region Presetting procedure:

In Utility--> System--> General, select the correct region
from Preset Region (restart needed), refer to Figure 6-1 on
page 6-4.

General System Imaging System Measure Backup/Restd

Location

Regional Options
Date/Time
Time Format

3(restart needed)

Figure 6-1. Region Preset

The window below will display after the region being
selected. Select "Ok", refer to Figure 6-2 on page 6-4.

Question

This will result in loss of Imaging Presets

Reload region preset : None

Ok Cancel

System view

Figure 6-2. Quesiton
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Preset Region

6-2-1 Region presetting procedure(continued)

»  After "Ok" is selected, the window below will display.Select
"Ok" and then restart the system.

Question

Figure 6-3. Restart the system
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Service Adjustments

6-3 Monitor Adjustments

6-3-1 Purpose of this section

This section describes how to test and adjust the scanner.
These tests are optional. You may use them to check the
system for errors.

6-3-2 Monitor Adjustments
Please refer to User Manual for how to adjust the Monitor
Position, Brightness and Contrast.
To adjust the brightness and volume:

1. On the alphanumeric keyboard,
* adjust brightness with Ctrl +Up/Down keys;
» adjust volume with Ctrl +Left/Right keys.

Figure 6-4. Monitor Adjustment
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Monitor Adjustments

6-3-3 Brightness and Contrast

1. Press Cursor key on the control panel. Move the trackball to
position the cursor over the adjustment icon, then press Set
to display the setting menu.

Figure 6-5. Setting Menu Icon

2. Follow the procedure below to adjust the Color
Temperature, Contrast, Brightness and LED Light:

» To adjust the color temperature: press Standard,
Brown, or Blue to choose the color temperature. The
chosen color temperature displays in the Color Temp
area.

STANDARD

Brown

Figure 6-6. Color Temperature

» To adjust the Contrast: Press Set to choose the
adjustment button, hold down the Set key and move the
trackball to move the adjustment button. Move the
adjustment button to the left to decrease the contrast or
move the adjustment button to the right to increase the
contrast.

STANDARD

Brown

oy
¥4 Contrast

Reset

Figure 6-7. Contrast

Versana Premier — Basic Service Manual ; System view 6-7
5789130-100 English Rev.5



Service Adjustments

6-3-3 Brightness and Contrast(continued)

6-8

=

i

To adjust the Brightness: Press Set to choose the
adjustment button, hold down the Set key and move the
trackball to move the adjustment button. Move the
adjustment button to the left to decrease the brightness
or move the adjustment button to the right to increase
the brightness.

STANDARD

Brown

Brightness §

Figure 6-8. Brightness

To adjust the LED Light (at the bottom of the Monitor):
Press Set to choose the adjustment button, hold down
the Set key and move the trackball to move the
adjustment button. Move the adjustment button to the
left to decrease the LED brightness or move the
adjustment button to the right to increase the LED
brightness.

Color Temp: STANDARD

Brown

Figure 6-9. LED Brightness

3. Press Reset to return to the default setting; Press Exit to
exit the setting menu.

NOTE: Press Reset button and the three color temperature settings
will return to the default settings.

System view
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Chapter 7

Diagnostics/Troubleshooting

This chapter describes how to setup Versana Premier
and run the tools and software that help maintain image
quality and system operation. Very basic host, system
and board levels are run whenever power is applied.
Some Service Tools may be run at the application level.
However most software tests are required.
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Diagnostics/Troubleshooting

7-1 Overview

7-1-1 Contents in this chapter

* 7-1‘Overview’ on page 7-2

* 7-2 ‘Gathering Trouble Data’ on page 7-3

* 7-3 ‘Screen Capture’ on page 7-5

e 7-4 ‘System Warning/Error and Logs’ on page 7-11

* 7-5‘Common Service Desktop’ on page 7-14

* 7-6 ‘Network and Common Diagnostics’ on page 7-37
* 7-7 ‘Troubleshooting’ on page 7-51
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Gathering Trouble Data

7-2-1 Overview

/-2 Gathering Trouble Data

There may be a time when it would be advantageous to capture
trouble images and system data (logs) for acquisition to be sent

back to the manufacturer for analysis. There are different
options to acquire this data that would give different results.

7-2-2 Collect Vital System Information

Versana Premier — Basic Service Manual
5789130-100 English Rev.5

The following information is necessary in order to properly

analyze data or images being reported as a malfunction or being

returned to the manufacturer:

Product Name = Versana Premier

From the Utility>System>About screen:
Applications Software

e Software Version
¢ Software Part Number

System Image Software

* Image Date
* Image Part Number

Additional Information

System view
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Diagnostics/Troubleshooting

7-2-3 Collect a Trouble Image with Logs

If the system should malfunction, press the Alt+D keys
simultaneously. This will collect a screen capture of the image
monitor, system presets and several log files in a date and time
stamped “.zip” file.

NOTE: This function may also be used to make a Print Screen.
This Alt+D function is available at all times.
When Alt+D is pressed, a menu box appears that allows for:

* aplace to enter a description of the issue
* acheckbox to indicate a System lockup

* achoice to Export a pre-formated CD-R/DVD-R or save to
the Export directory D: drive (for remote viewing through
InSite)

System Problem Reperting X

CD / DVD Recordable (G:)

o li

Figure 7-1. Alt+D Dialog Box
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Screen Capture

/-3 Screen Capture

There may be times when the customer or field engineer will
want to capture a presentation on the screen. This is
accomplished by first saving the image(s) to the clipboard using
a Store Key.
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Diagnostics/Troubleshooting

7-3-1 Capturing a Screen

The following is a generic process to capture any screen from
the scanner:

1. Navigate to and display the image/screen to be captured.

2. Press Store. This will place a snapshot of the screen on the
“clipboard” displayed at the left side of the scan image
display.

Figure 7-2. Select Image to Capture

3. Select and highlight the snapshot to be stored.
4. Select Save As Icon on the lower left of the image screen.

Figure 7-3. Menu > Save As

7-6 ; System view Versana Premier — Basic Service Manual
- 5789130-100 English Rev.5
e~



Screen Capture

7-3-1 Capturing a Screen(continued)

5. A Save dialog box will be opened. Choose the archive
location to save image on the USB Drive or CD/DVD.

Save in archive

Folder name File name

Compression

Quality

Save as type

Transfer Size : 0.00 MByte

Figure 7-4. Save Dialog Box

NOTE: Click Save -> Transfer To CD/DVD, if the archive location is
DVD/CD; Click Save, if the archive location is USB.

NOTE: It is better to save the image in Jpeg format. Image of this
format can be easily reviewed in the computer.
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Diagnostics/Troubleshooting

7-3-2 Capturing a Screen with Service Dongle

The following is a generic process to capture the whole screen
from the scanner:

1. Insert the Service dongle in the system’s USB port.

2. Press Prtsc key on the control panel, the whole screen is
captured.

3. Press Ctri+Shift+Esc, the Start Task Manager dialog is
displayed.
NOTE: It is also available to Exit to Windows and save the image on
the system or removal media. For how to Exit to Windows,
please refer to Proprietary Service Manual.

4. In Windows Task Manager, select File-> New Task
(Run...).

= = Ho )
Options  View Help

Mew Task (Run...) Performance | Networking | Users

Exit Task Manager
T ———rmmeCPL  Memory (... Descripton
BackgroundSe... LLC 00 23,740k LOGIGES ... | |
btwdins.exe SYSTEM oo 2,204K  Bluetooth... =
CISVC.EXE SYSTEM a0 204K ContentI...
conhost.exe uLc Qg 1,300 K Console ...
CSrSS.eXe SYSTEM an 1,740K Client Ser...
CSMSS.EXE SYSTEM an 12,076 K Client Ser...
dwm.exe uLC a0 1,684K Desktop...
EcholLoader.exe LLC an 659,334 K EcholLoader
igfxCUIServic... SYSTEM a0 2,252K  ighCUISe...
ighEM. exe uLe 00 5,068 K ighEMM...
ighHK. exe uLe 00 3,788 K ightHK Mo...
igfxTray.exe uLc Qg 7,780K  igfxTray ...
inetinfo.exe SYSTEM ili] 7,996 K Intermetl...
IPROSetMonit... SYSTEM a0 1,880 K Intel®PR...
|sass.exe SYSTEM a0 3,832K Local Sec... -
[/]Show processes from all users T e

Figure 7-5. Windows Task Manager
5. Type in the program name: mspaint.

= —

K . Type the name of a program, folder, document, or Internet
== resource, and Windows will open it for you.

Open: -

‘\ﬁ:g' This task will be created with administrative privileges,

| ok || cence || Browse. |

Figure 7-6. Create New Task
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Screen Capture

7-3-2 Capturing a Screen with Service Dongle(continued)

6. The paint screen is displayed, press Ctrl+V to paste the
captured screen. And then save the image in the
appropriate destination.

| AT ..
5 o | I:E
3 DI:D:ID__D:IDD colers

ll

@(J- % b Computer +
Organize =
i Pictures

4 # Hard Disk Drives (1)
Videers

User () Title Bar
2P Computar S 555 GB free 1559 GF
o Vser (0] 2/ Daficess ble St (
evices with Removable Storage (1)
# o KINGSTON (M) . KINGSTON (H) J kbl
| 125%60.0 6 F — =
12UKTE &L -G
E201611071446
ENN611071500
EMNIEIL0TISH

Hide Patient Data  Never

Key Usage

. EXEILOTISET < as £ 3x(500ms)

Unkitled.pag
PHG (".pog)

General User Interface

Color Level (restart needed)  Bright

Figure 7-7. Save Image
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Diagnostics/Troubleshooting

7-3-3 Capturing a Screen by physical print buttons

The following is a generic process to capture the whole screen
(not including the Touch Panel screen) from the scanner:

1. Press Utility -> Connectivity -> Button to configure
Physical Print Buttons for the button to capture screens.

2. Select any key from Print1, Print2, Print3 or Print4 from
Physical Print Buttons.

3. Select Secondary Capture Screen from Format.

4. Select USB Quick Save, press >> to move to right column.
Press Save and Exit.

GE Healthcare

Bluetooth Tricefy

=

MyComputer &- MyComputer
I-=2 Copy to Dataflow L2 Copy to Dataflow
¥ Standard Print
| = 2 USB Quick Save
8- TricelyDevice
I-52 Trice Archive
&2 Trice Patient

Figure 7-8. Windows Task Manager

5. After Print key configuration complete, press the configured
Print key, the captured screen will be saved to the USB
directly.
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System Warning/Error and Logs

/-4 System Warning/Error and Logs

7-4-1 Temperature warning

A Warning

The system has detected the lower air filter requires cleaning.

Please clean the lower air filter.

Ok

Figure 7-9. Temperature Warning

» Cause: CPU temperature exceeds threshold (95 degrees)
*  What to do: shut down the system and clean the filter.

7-4-2 Temperature exceeds threshold

Warning

System temperature is too high.
System will shut down.

Cancel

Figure 7-10. Temperature exceeds threshold

* Cause: CPU temperature exceeds threshold (100 degrees)
and therefore, system must be shutdown immediately.

*  What to do: shut down the system and clean the filter.
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Diagnostics/Troubleshooting

7-4-3 System voltage failure

Warning

System voltage fault.
System will shut down.

Figure 7-11. System voltage failure

Cause: Hardware and/or voltage error detected.
What to do

Press OK and reboot the system.

if the problem persists, shut down the system, turn OFF the
circuit breaker and then reboot the system.

7-4-4 Hardware configuration error

Invalid Hardware Configuration.

System will NOT Scan.

Ok

7-12 d; System view

=5

Figure 7-12. Hardware configuration error

Cause: Hardware(s) is not detected as valid system.
System is able to boot up but not able to scanning.

What to do

Press OK and reboot the system.

If the problem persists, shut down the system, turn OFF the
circuit breaker and then reboot the system.

if the problem persists, shut down the system and analyze
the log files in Technical Support Mode.

Versana Premier — Basic Service Manual
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System Warning/Error and Logs

7-4-5 System error

System Error.

Please Restart the system.

Ok

Figure 7-13. System error

» Cause: Hardware(s) is not detected as valid system.
System is able to boot up but not able to scanning.

¢ What to do

Press OK, turn off the system and then reboot it.

2. If the problem persists, shut down the system and analyze
the log files.

Versana Premier — Basic Service Manual ; System view 7-13
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Diagnostics/Troubleshooting

/-5 Common Service Desktop

7-5-1 Purpose of this section

This section describes the features of the Service desktop.
These are the different levels of access to the Service desktop:

7-14 é System view

Service Basic access (Class A) - a user locally logged into
the machine with Local Service Access privilege. This level
provides limited access to Service desktop widgets and
utilities.

Service Expert, Pro, and Advanced access (Class C) Local -
Depending on the purchase level,includes an option string
to control access.

GE Service access (Class M) and an SSA key. For users
with local Service Access privileges, this level provides
unrestricted access to all Service desktop widgets and
utilities.

Remote access - a user remotely accessing the Versana
Premier. This level provides unrestricted access to all
Service desktop widgets and utilities. Disruptive mode is
limited to the user access privileges to Remote Service
Access.

Versana Premier — Basic Service Manual
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Common Service Desktop

7-5-2 Disruptive mode

NOTE:

Versana Premier — Basic Service Manual
5789130-100 English Rev.5

Disruptive mode is a way to control interruptions to operation of
the Versana Premier. Disruptive mode is required whenever
service performs a function that may disrupt a normal scan.
Activating Disruptive mode results in a red message displayed
on the task bar. This message indicates that the Versana
Premier needs to be restarted once the service activity is
complete. The message remains until the Versana Premier is
restarted. This prevents patient scanning while the Versana
Premier is not operating at an optimal status. For example,
running a diagnostic may leave the Versana Premierin a state
that is not good for imaging.

Specifically, Disruptive mode is required to run diagnostics,
clean presets, and reset the patient database, and turn on
Virtual Console Observation (VCO).

*  When Disruptive mode is On, all service functionality on the
Service desktop is allowed but user operation of the
Versana Premier may be limited.

*  When Disruptive mode is Off, some service functionality on
the Service desktop is not available and user operation of
the Versana Premier is normal.

Additionally, the ability to enable Disruptive mode depends on
the logged in user.

* Local user - a user locally logged into the machine will be
able to set the Versana Premier to Disruptive mode or allow
a Disruptive mode request from a remote user through the
Service desktop. The local user must have Authorize
Remote Service Access to allow Disruptive mode. If the
local user does not have this right, the remote user’s
request will be automatically denied

* Remote user - a user remotely accessing the Versana
Premier will not be able to automatically switch Disruptive
mode to On. The logged in user (user actually logged on to
the Versana Premier) needs to have the ability to grant
remote access. The logged in user will be notified through a
dialog box and asked to allow Disruptive mode.

Change Password and Disk Defragment are not available
for the remote user whether Disruptive mode is On or Off.

For more information, see:7-5-2 ‘Disruptive mode’ on page 7-15
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Diagnostics/Troubleshooting

7-5-3 Color statuses

7-5-4 Licenses

NOTE:

7-16 § System view

Throughout the Service desktop, colors indicate the following:

¢ Green - Status is normal
* Orange - Status is a warning
* Red - Status is an error

With Service Basic Access (Class A), these are the available

options:
+ HOME
«  Utilities

» Change Password

» Data Transfer

* Delete Files

* Gather Logs

*  Network Capture

* SSA License

* Thirty Party Licenses
+ Options
* Agent Configuration

With Service Advanced (Class C), these are the available

options:

With a Class C license, options display according to these

purchased level of access.
« HOME

* Diags

* Run Diags

* Diag History
«  Utilities

* Change Password
*  Checkpoints

* Delete Files

» Disk Defragment
» Data Transfer

* Gather Logs

*  Network Capture
* SSA License

Versana Premier — Basic Service Manual
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Common Service Desktop

7-5-4 Licenses(continued)

»  System Shutdown
*  Thirty Party Licenses

*  Options
» Agent Configuration

With Service Advanced plus Service Expert (Class C), the Clean
Userdefs, Reset Patient Database,and Software Reload utilities
are added to the Service Advanced options listed.

With Service Advanced and Service Expert plus Service PRO
(Class C), the probe assessment tool (ePAT) diagnostic is
added to the Service Advanced and Service Expert options
listed.

With GE Service access (Class M) and an SSA key, these are
the available options:

+ HOME
« Diags
* Run Diags
» Diag History
«  Utilities
» Change Password (not available through a remote
connection)

*  Checkpoints

* Clean Userdefs
» Data Transfer

* Delete Files

« Disk Defragment (not available through a remote
connection)

* Disruptive Mode Utility
* Gather Logs
*  Network Capture
* Reset Patient Database
* Software Reload
* SSA License
+ SSH
*  Thirty Party Licenses
» Virtual Console Observation
+ Options
* Agent Configuration

Versana Premier — Basic Service Manual
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Diagnostics/Troubleshooting

7-5-5 Home

Home configurations vary depending upon the purchased
service level.

Figure 7-14.

.
O B o B

Home with Class C and Class M Access

For more information, see:

* 7-5-5-1 ‘System Information’ on page 7-19

* 7-5-5-2 ‘Software Status’ on page 7-21

» 7-5-5-3 ‘System Status’ on page 7-22

* 7-5-5-11 ‘Disk Drive Space’ on page 7-32

»  7-5-5-12 ‘Network Configuration’ on page 7-34
* 7-5-5-13 ‘Connected Probes’ on page 7-36

7-18 ) System view
&
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Common Service Desktop

7-5-5-1 System Information

System Information displays general information about the
Versana Premier. When the Versana Premier has been
successfully configured with the back office, these elements will
have the corresponding values:

* Agent Registered will be Yes

* Agent Quarantine will be No

» Agent CRM Verified will be Yes

The information on System Information is available to all
service class licenses.

To access System Information, navigate to Utility > Service >
Home.

iervice Browser

) Service Desktop

A Home © DiagsVv & utilites v £ Options & Agent Configuration

@ system Information

CRM Number VERP_123456TWx1 ~
Agent Registered Yes
Agent Quarantine No
Agent CRM Verified Yes

Madel Number
Serial Number 1234567WXA

System Type VersanaPremier

Figure 7-15. System Information

This table shows all the elements available on System
Information with descriptions.

Table 7-1:  System Information

Element DESCRIPTION

CRM Number

Customer Relationship Management (CRM) number.
System identifier assigned to the customer unit by
the region service team.

Versana Premier — Basic Service Manual
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Diagnostics/Troubleshooting

Table 7-1:

System Information

Agent Registered

Registered status of the agent. Valid values are:

* Yes - The agent is registered in the back office.

* No - The agent is not registered in the back office.

* Not Available - The agent is not running or has not
been configured.

Agent Quarantine

Quarantine status of the agent. Valid values are:

* Yes - The agent has more than one device regis-
tered with the same CRM Number in the back
office.

* No - The agent has one device registered with the
listed CRM Number in the back office.

* Not Available - The agent is not running or has not
been configured.

Agent CRM Verified

CRM verified status of the agent. Valid values are:

* Yes - The agent is verified in the back office.

* No - The agent is not verified in the back office.

* Not Available - The agent is not running or has not
been configured.

Model Number

GE part number for the Versana Premier. The same
number as listed on the rating plate.

Serial Number

Serial number of the Versana Premier. The same
number as listed on the rating plate.

System Type

Product name of the Versana Premier.

Facility

Name of the hospital or facility where the Versana
Premier is installed

For more information, see:7-5-5 ‘Home’ on page 7-18

7-20 ) System view
£
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Common Service Desktop

7-5-5-2 Software Status
Use Software Status to view general information about the
software installed on the Versana Premier.

The information on Software Status is available to all service
class licenses.

To access Software Status, navigate to Utility > Service >
Home.

[L) Software Status

System Date Mon, Jul 16, 2018
System Time 15:18:08
Application Installation Date 14:21:00 07/13/2018
Base Image Installation Date Mot Available

Base Image Version OO0

Application Software Version R10.1

Application Status Running

Figure 7-16. Software Status

This table shows all the elements available on Software Status
with descriptions.

Table 7-2:  Software Status

Element DESCRIPTION
System Date Current date in the format <day>, <month> <date> <year>.
System Time Local time based on the last time the system desktop was

refreshed in the format <hh:mm:ss>.

Application Installation Date Date the application software was installed. The application
software includes the Versana Premierproduct-specific software.

Base Image Installation Date Date the base image software was installed. The base image
software includes the Windows operating system and other
supporting software.

Base Image Version Version number of the base image software
Application Software Version Version number of the application software
Application Status Status of the application. Valid values are

* Running

* Stopped

For more information, see:
* 7-5-5'Home’ on page 7-18

Versana Premier — Basic Service Manual
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Diagnostics/Troubleshooting

7-5-5-3 System Status

7-22

Use System Status to view status information on the Versana
Premier. Specifically, do the following:

View the hardware configuration file

View temperatures for FRUs, fans, and a graphical
representation of the monitored temperatures

View voltages for FRUs and AC

View the amount of time the Versana Premier has been
running

View the amount of time since the Versana Premier has last
been rebooted

The information on System Status is available to Class C and
Class M licenses.

To access System Status, navigate to Utility > Service > Home.

System Status

Hardware Configuration

" Temperature

" Voltage

o

System On Time

Time since Last Reboot 0 hours3 minutes

Figure 7-17. System Status
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Common Service Desktop

7-5-5-3 System Status(continued)

This table shows all the elements available on System Status

with descriptions.

Table 7-3:

System Status

Element

DESCRIPTION

Hardware Configuration

Displays the contents of the hardware configuration
file.

Temperature

Displays the temperature monitoring of the Versana
Premier as normal, warning, or error using the
standard colors and icons. Includes temperature
out-of-spec events including an overall count of
event warnings and errors for the last 30 days or the
last status checkpoint whichever is sooner.
Temperature displays temperature a graph for the
configured monitoring points.

Voltage

Displays the voltage monitoring of the Versana
Premier as normal, warning or error using the
standard colors and icons. Includes voltage
out-of-spec events including an overall count of the
event warnings and errors for the last 30 days or last
status checkpoint whichever is sooner.

System On Time

Displays the time the Versana Premier was turned
on.

Time Since Last Reboot

Displays the time the Versana Premier was last
rebooted.

Versana Premier — Basic Service Manual
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Diagnostics/Troubleshooting

7-5-5-4 Hardware Configuration

Hardware Configuration displays the contents of the hardware
configuration file which includes all the vital product data (VPD).

To access Hardware Configuration, navigate to Utility >
Service > Home, and then under System Status, select
Hardware Configuration.

Hardware Configuration

BEpR COMPUTERNAME DESKTOP-LHIDARA ~

BF VPO revision field 3

8F Pole that owns the design dragon

g Functional revision 2H

BF System Platform Wukong

8F Part number (GE format] 5758521

8F Revision Number 3

8F FPGA version w2023

COMEXP VPO revision field 3

COMEXP Pole that owns the design dragon

COMEXP Functional revision 1A

COMEXP System Platform Wukong

COMEXP Part number (GE format] 5758521 v
3 >

Figure 7-18. Hardware Configuration

This table shows all the elements available on Hardware
Configuration with descriptions.

Table 7-4:  Hardware Configuration

Element DESCRIPTION
Component Hardware component.
ltem Parameter with the vital product data (VPD).
Value Actual value of the Item.

For more information, see:
e 7-5-5-3 ‘System Status’ on page 7-22
e 7-5-5'Home’ on page 7-18
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Common Service Desktop

7-5-5-5 Temperature

Use Temperature to troubleshoot problems with monitored
FRUs and the fans. Specifically, use these pages:

* FRU Status
* Graphs

To access Temperature, navigate to Utility > Service > Home,
and then under System Status, select Temperature.

For more information, see:

e 7-5-5-6 ‘FRU Status’ on page 7-26

* 7-5-5-7 ‘Graphs’ on page 7-28

» 7-5-5-3 ‘System Status’ on page 7-22
* 7-5-5'Home’ on page 7-18

Versana Premier — Basic Service Manual
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Diagnostics/Troubleshooting

7-5-5-6 FRU Status
FRU Status displays a summary of the FRUs being monitored
and the details for each FRU.

To access this page, under System Status, select Temperature
and then select FRU Status.

B FRU Status Details

Name +* Status Lower Limit Warnings Upper Limit Warnings Lower Limit Errors Upg
BEP_CHIPSET_TEMPERATURE Normal o 0 0 o
BEP_CPU_TEMPERATURE Normal o o 0 o
BEP_SYS_TEMPERATURE Normal o o 0 o
MST_AFE_TEMPERATURE Normal o 0 0 o
MST_BFO_TEMPERATURE Normal o o 0 o
MST_BF1_TEMPERATURE Normal o o 0 o
MST_MVP_TEMPERATURE Normal o 0 0 o

Figure 7-19. FRU Status

This table shows all the elements available on FRU Status with
descriptions.

7-26 é System view Versana Premier — Basic Service Manual
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Common Service Desktop

7-5-5-6 FRU Status(continued)

Table 7-5: FRU Status

Element DESCRIPTION

FRU Status Summary Number of the FRUs being monitored.

FRU Status Details

Name * Name of the FRU.

Status Status of the FRU. Valid values are:

« Normal - Indicates that the FRU is operating within the allowable range.

» Warning - Indicates that the FRU is operating close to the limit of the allow-
able range.

« Error - Indicates that the FRU is operating outside the allowable range.

Low Level Warning Number of low temperature warnings.
High Level Warning Number of high temperature warnings.
Low Level Errors Number of low temperature errors.
High Level Errors Number of high temperature errors.

For more information, see:
e 7-5-5-5 ‘Temperature’ on page 7-25
* 7-5-5'Home’ on page 7-18

Versana Premier — Basic Service Manual
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Diagnostics/Troubleshooting

7-5-5-7 Graphs

Graphs displays trend graphs for selected elements which have
been selected as key indicators of overall temperature status
inside the card rack.

To access this page, under System Status, select Temperature
and then select Graphs.

! Temperature Monitoring s ([T
B BEP_CPU_TEMPERATURE Temperature Trend BB MST_MVP_TEMPERATURE Temperature Trend

— Series 1 —Saids 1
Data froem : 2018-7-28 01:03:04 Data from : 2018-7-28 01:03:04

Uppar Limit Error .
Uppac OIS WaRTIAG
Upper Limit Error

75
Upgar Limit Wasming
e a————
-
Lowar G Wairing o Lowas Ciret Warsing

5 25
20 Jul 0600 1200 16:00 31 Jul 30, Jul 06:00 12:00 1800 31 Jul
Time Tirne
I MST_BFO_TEMPERATURE Temperature Trend BB MST_BF1_TEMPERATURE Temperature Trend
— Series 1 — Sadias 1
Data from - 2018-7-28 01:03:04 Data from : 2018-7-28 D1:03:04
100
Ugger Limit Error Upper Limiz Errer
Uppar DAt Waiihg Uppéd OmaWaiiing
[T e, —r—— R At L At -
25
Lowar G Wadring o Lowes Gmet Wamning

Figure 7-20. Graphs

For more information, see:

*  7-5-5-5 ‘Temperature’ on page 7-25
e 7-5-5'Home’ on page 7-18
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Common Service Desktop

7-5-5-8 Voltage

Use Voltage to troubleshoot problems with monitored FRUs and
the AC voltage of the Versana Premier.

Specifically, use these pages:
* FRU Status
* AC Voltage

To access Voltage, navigate to Utility > Service > Home, and
then under System Status, select Voltage.

For more information, see:

* 7-5-5-6 ‘FRU Status’ on page 7-26

* 7-5-5-10 ‘AC Voltage’ on page 7-31

» 7-5-5-3 ‘System Status’ on page 7-22
* 7-5-5'Home’ on page 7-18

Versana Premier — Basic Service Manual
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Diagnostics/Troubleshooting

7-5-5-9 FRU Status

FRU Status displays a summary of the voltages for the FRUs
being monitored and the details for each FRU.

To access this page, under System Status, select Voltage and
then select FRU Status.

B FRU Stotus Details

MST_2VSV_CLK Normal 0
MST_AFE_1V8 Normal 0
MST_AFE_3V3_0 Normal ]
MST_AFE_3V3.1 Normal 0
MST_D1V10 Nermal 0
MST_D1V1_1 Normal 0
MST_D1V1_ 2 Normal 0
MST_D1v2_DSP Normal 0
MST_DIVS_XIO Normal ]

0 0 0 A
(4] o ']
0 0 0
Q o 1]
0 0 0
o 0 o
o o 0
1] o 1]
0 0 0 it

Figure 7-21. FRU Status

This table shows all the elements available on FRU Status with

descriptions.

Table 7-6: FRU Status

Element

DESCRIPTION

Name

Name of the FRU.

Status

Status of the voltage for the FRU. Valid values are:

» Normal - Indicates that the fan is within the allowable range.

» Warning - Indicates that the voltage is close to the limit of the
allowable range.

« Error - Indicates that the voltage is outside the allowable range.

Lower Limit Warnings

Number of low limit voltage warnings.

Upper Limit Warnings

Number of high limit voltage warnings

Lower Limit Errors

Number of low limit voltage errors

Upper Limit Errors

Number of high limit voltage errors

For more information, see:
* 7-5-5-8 ‘Voltage’ on page 7-29
e 7-5-5'Home’ on page 7-18
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Common Service Desktop

7-5-5-10 AC Voltage

AC Voltage graphically displays the voltage input over a period
of time to help identify instabilities,or fault conditions, over time.

To access this page, under System Status, select Voltage and
then select AC Voltage.

4% \oltage Monitoring TR o |
B MST_D3V3 Power Trend MST_AFE_3V3_0 Power Trend
- — o
from : 201 28 01:04:!
Vppse it frroe pparims waming Uppar Uit Ervox povimiWorming
s 3 Lives i B Eowe Gk Waring s 3
& & Lowver Ui Erva
: :
o o
i Time

B MST_AFE_3V3_1 Power Trend MST_AFE_1V8 Power Trend

age — Voitags

Date from : 2018-7-28 01:0%58 Data from: 2013-7-28 010458

Uppar imit Error

Ugper Limt Error

Liiver Ui B

Figure 7-22. AC Voltage

For more information, see:
» 7-5-5-8 ‘Voltage’ on page 7-29
* 7-5-5‘'Home’ on page 7-18
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7-5-5-11 Disk Drive Space

Use Disk Drive Space to view the hard drive partitions including
total size and available free space in GB. Includes the overall
health of the drive in one of these colors:

* Red - Available free space is less than 10% of the total size.

* Orange - Available free space is more than 10% and less
than 20% of the total size.

* Green - Available free space is more than 20% of the total

size.

The information on Disk Drive Space is available to Class C
and Class M licenses.

To access Disk Drive Space, navigate to Utility > Service >

Home.

B Disk Drive Space

D: Drive

F: Drive

7-32 é System view

A
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14.2 GB free of 49.9 GB

19.6 GB free 0of 19.9 GB

349.3 GB free of 349.9 GB
0.0 GB free of 0.0 GB

31.3 GB free of 45.0 GB

Figure 7-23. Disk Drive Space
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7-5-5-11 Disk Drive Space(continued)

This table shows all the elements available on Disk Drive
Space with descriptions.

Table 7-7:  Disk Drive Space

Element DESCRIPTION

C: Drive C: partition shows the graphical representation of the
following:

» Used space in GB

* Available free space in GB

D: Drive D: partition shows the graphical representation of the
following:

* Service

* Logs.

* Temp

* Export

* Service configuration

» Misc

* Available free space in GB

E: Drive E: partition shows the graphical representation of the
following:

« Patient images

* Archive

* Printer spooler

« Clipboard

» Dicom spooler

» Misc

* Available free space in GB

F: Drive F: partition shows the graphical representation of the
following:

+ Serial Number

* Available free space in MB

Z: Drive Z: partition shows the graphical representation of the
following:

» Package repository

» Misc

* Available free space in GB

For more information, see:

* 7-5-5'Home’ on page 7-18

Versana Premier — Basic Service Manual ; System view 7-33
5789130-100 English Rev.5



Diagnostics/Troubleshooting

7-5-5-12 Network Configuration

Use Network Configuration to view network (wired and
wireless) information (the full ipconfig details)for the network
configured with the Versana Premier.

The information on Network Configuration is available to Class
C and Class M licenses.

To access Network Configuration, navigate to Utility >
Service > Home.

all Network Configuration More Details
Host Name DESKTOP-LHIDARA ~

Wired Connection

IpV4 Address 3.35.156.157
IpV6 Address fe80uc4e4:35bbic33b:fdob%%4
Subnet Mask 255.255.255.0
Default Gateway 3.35.156.254
v
MAC Address C4-00-AD-0F-37-13

Figure 7-24. Network Configuration

Network Details

Figure 7-25. Network Configuration with More Details

7-34 é System view Versana Premier — Basic Service Manual
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7-5-5-12 Network Configuration(continued)

This table shows all the elements available on Network
Configuration with descriptions.

Table 7-8: Network Configuration
Element DESCRIPTION
Host Name Name of the local host for the Versana Premier.
More Details Displays the ipconfig details

Wired Connection

IpV4 Address

Local IP address for the wired network connection.

IpV6 Address

Local IP address for the wired network connection.

Subnet Mask

Local subnet mask for the wired network.

Default Gateway

Default gateway for the wired network.

MAC Address

Address for the MAC for the wired network.

Speed (Mbps)

Speed of the wireless connection.

Wireless Connection

IP Address

IP address for the wireless network connection.

Subnet Mask

Subnet mask for the wireless connection.

Default Gateway

Default gateway for the wireless connection.

MAC Address

Address for the MAC for the wireless connection.

Speed (Mbps)

Speed of the wireless connection

Status

Current status of the wireless connection.

For more information, see:

e 7-5-5'Home’ on page 7-18

Versana Premier — Basic Service Manual
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7-5-5-13 Connected Probes

Connected Probes shows probes connected to the Versana
Premier. The order on the user interface is top down matching
the left-to-right order on the Versana Premier.

The information on Connected Probes is available to all service
class licenses.

To access Connected Probes, navigate to Utility > Service >
Home.

&h Connected Probes

Active Probe Temperature (Celsius) Mot Available
Probe Name Probe 1d Status
N/A Non Active ~
N/A Non Active
ac cla_8C Active
v
< >

Figure 7-26. Connected Probes

This table shows all the elements available on Connected
Probes with descriptions.

Table 7-9:  Connected Probes

Element DESCRIPTION

Active Probe Temperature (Celsius) When available, temperature of the active probe.
Not all probes report temperature. The most common probe
to report temperature is the TEE probe.

Probe Name Name of the probe connected to the Versana Premier.
Probe ID Identifier of the probe connected to the Versana Premier.
Serial Number Serial number of the probe connected to the Versana

Premier. If the serial number of the probe is not available,
then N/A displays.

Status Statuses of the probe connected to the Versana Premier.
Valid values are:

» Active

» Non Active

For more information, see:7-5-5 ‘Home’ on page 7-18
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7-6 Network and Common

Diagnostics

7-6-1 Network Configuration
7-6-1-1 Wire-LAN Network

1. Connect system with network.

2. Enter Utility-> Connectivity-> TCP/IP, in IP settings
window, check Enable DHCP, and select the proper
network speed in Network Speed.

TCP/IP Device Service Dataflow Button Removable Media llaneocus

Computer Name |DE \8 X Wireless Network

IP settings Configuration

DHGCP

Figure 7-27. Enable DHCP

Versana Premier — Basic Service Manual ; System view 7-37
5789130-100 English Rev.5



Diagnostics/Troubleshooting

7-6-1 Network Configuration(continued)

NOTE: If user wants to setup static IP address, uncheck Enable
DHCP option, input static address in IP-Address box,
Subnet Mask and Default Gateway box. In Network
Speed, choose the proper speed available.

TCP/IP Device Servi Dataflow Removable Media Miscellaneot

Figure 7-28. Network Settings

3. Select Save, and a popup window displays. Select OK to
restart the system and activate the changes.

Question

To activate all of your changes, please restart the system. Ready to restart?

Ok Cance

Figure 7-29. System Restart inquiry dialog

4. After the system restarts, the network icon on the right top of
the screen shows that the network is available.

I:I < unavailable

available

Figure 7-30. Network icon
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Network and Common Diagnostics

7-6-1-2 Wireless-LAN Network

NOTE: To configure the Wireless-LAN network, the operator must login
as administrator.
1. Connect the wireless adapter in the USB port.

2. Enter Utility-> Connectivity-> TCP/IP, press
Configuration.

3. Double click Wireless network. you chosen, or click the
Connect at the left bottom of screen.

i ﬁ,) CS 1RB206
Security enabled wireless network

Figure 7-31. Wireless Network Conection
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7-6-1-2 Wireless-LAN Network(continued)

4. Input Network Key and Confirm Network Key, then click
Connect.

Wireless Network Connection

——
"
l

Figure 7-32. Connection Status

5. The network icon at the left bottom of screen shows that the
wireless network is available.

Figure 7-33. Wireless-LAN Connection

unavailable

available
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7-6-2 Remote Access

Remote Access is a feature designed to enable OLE’s access to
customer’s desktop remotely, service engineers don't have to be

on site to connect the physical dongle to exit to desktop, it's

doable remotely by using this feature.

1. In the server side, type the CRM No. of the system which
the OLE would remotely connect to, and select Get Started.

NOTE: Remote FFA link:https://stg-ffa.am.health.ge.com/#/di/
home.

Versana Premier — Basic Service Manual
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Start Remote Troubleshooting

Workflow Type
® Standard (Includes Insitel, Insite2, and RSuP)

Enter System or Service ID

® System ID

Devices using RSvP may utilize Advanced Search for filtering.

CRMNo X

Service Request ID (Optional)

O Service Request ID

Country of System

Get Started

I p

Figure 7-34. Input System ID

s System view
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7-6-2 Remote Access(continued)

2. Select Connect. Then the Connect page is displayed.

@ Field Force Automation Monitoring v | [ Service Tools v ® Vuleiceo v

Modality Service Event System ID Ass o1 Site Name Service Contract Ph. No.

USYSTEMS = 111116WX1 U SYSTEM INVENIA GE MEDICAL SYSTEMS v (&

GLOBAL
HEADQUARTERS

Customer Info System Info

Installed 24-May-2018 Contract
SERVICE REQUEST INFO

IDENTIFICATION
Customer Symptom
) System ID 111116WX1 Details ~ Entitlements
Contact Name Serial Number - U

Asset Description U SYSTEM INVENIA
Remote Hours

Contact Phone + Show More
CONFIGURATION FE Hours
Emall Software - Apps Hours -
Hardware -
SITE INFO RESPONSE TIMES
ABOUT

Room Phone . Account Time 06:56:33 GMT
Connectivity UNKNOWN  Insite2-RSVP 1SeTRE018

CSO Status v Good
o bile N Callback Time 02:56:33 CST+08:00
obile 15-June-2018
Equi| t Status -
Alternate Phone quipment Status

Call Back Response Time-
Comments
prr— ‘E:;‘j) Onsite Response Time -
Figure 7-35. Connect Page
3. Select HTTPS to Connect. Then the OLE is remotely
connected to the system.
Connect Status RequestFastPoll | | &

Remote Console

HTTPS RDP SSH Desktop

In Session Ready Ready Ready

Commands Command Status

‘Search by Keyword(s)

Updated: 14 May 2018 03:48:49 Date Range : 9May 13, 2018 - May 14, 2018 ~

All Commands

Figure 7-36. Select HTTPS to Connect

NOTE: RDRP is not available in Versana Premier.
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7-6-2 Remote Access(continued)

4. Enter Otpions to add service option key.

NOTE: Please delete the added service option key when your
service work is done.

ousz98370

zzzzzzzzzzz

Autoscore

sssss

Bvodesicer Valid unti: 20180630 ]

Figure 7-37. Add Service Option Key

5. Enter Utility-> Disruptive Mode Utility, select Enable.

B Disruptive Mode Utility

Disruptive Mode Status Disabled

Date of Last Modification Fri, Jun 8, 2018 15:37:03

Figure 7-38. Enable Disruptive Mode
6. If we want to see the Scan screen or have control of the unit,

we have to go to Virtual Console Observation and start it.
Enter Utility-> Virtual Console Observation, select Start.

Virtual Console Cbservation
Status VCO is Running

i Stop

Figure 7-39. Start VCO
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7-6-2 Remote Access(continued)

7. Select Desktop to Connect. Then the OLE is remotely
connected to the system.

COMTeTT STty RequestFastPol | T
STATUS UNKNOWN  Insite2-RSVP Last Connected - Next Connection -

~ Connectity Configuration A

Polling Interval (hh;

Last Registration
opTIONS

iting 4 Uno
e

Remote Console

HTTPS RDP SSH Desktop
Ready Ready Ready In Session
‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘

Figure 7-40. Select Desktop to Connect

NOTE: You need to reboot the system before clinical scanning is
resumed.
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7-6-3 Service Diagnostics

7-6-3-1 MST board

NOTE:

7-6-3-2 CWI board

Versana Premier — Basic Service Manual
5789130-100 English Rev.5

MST Swept Demodulator Test performs a signal path test of
the swept demodulator FPGA on the MST.

MST Front End Interface Test tests that the MST can access
Front-End boards.

MST Analog Test.

MST Memory Access Test tests that MST can access to the
internal, external, external cache memory spaces.

Front End Interface FPGA Test reads the version of the GFE
FPGA.

MST Fixed Demodulator Test: MST Fixed Demodulator
signal path test.

DSP Master Clock Check checks DSP Master Clock.
MST Swept Demodulator Long Test.

MST Temperature Test.

MST Voltage.

FPGA Internal Memory Test.

The FPGA Internal Memory test may fail if it is performed
with other tests at the same time.

FPGA Version.

HV STOP Test tests HV-STOP mechanism and checks each
board is able to assert HV_STOP using its HV_STOP
source.

CWI Voltage.

Other Voltage test point.

Memory tests the memory on the mother board.
Network Interface.

Network Interface Reliability Test.

CPU Temperature Test.

System view 7-45
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7-6-3-3 Front End Path

* AFE IF Test checks digital path between AFE chips and
FPGA.

* Complex Mixer Test checks the Mixer process chain of
FPGA.

» CE Decoder Test checks the Code Excitation Decoder
process chain of FPGA.

* Analog CW checks I-Q symmetry of pedof CW beamformer
receiving signal.

7-6-3-4 PC Test

* Hard Drive Test Long tests functionality of the hard drive.
» Hard Drive Test Short tests functionality of the hard drive.
* RTC clock:

*  AVI playback tests playing back an AVI file.

«  Click “Play” to run the test. If the test is successful, you
will see a brief video clipo with audio. For more
information about the test, click “More Information”.

» Click “Pass” if the test successfully reproduces the
video clip.

»  Click “Fail” if the test is unable to successfully reproduce
the video clip.

*  Click “Cancel” button to quit the test without recording a
test result.

* Keyboard

* Press each key on the keyboard and it will be added to
the History. Hold down a key to test the repeat of that
key. To cancel, click Cancel or press Alt-X.

»  Special purpose keys like volume control or Internet
access keys may not be detected. To test the Fn key of
a notebook computer, hold down the Fn key while
pressing another key.

* Note: This diagnostic is intended to verify keyboard
keys are in good working order. It is not intended to
veriy that keyboards produce desired characters.
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7-6-3-4 PC Test(continued)

¢ Monitor Test Patterns

Versana Premier — Basic Service Manual

5789130-100 English Rev.5

This test is composed of various elements that verify a
monitor functions correctly. To test a monitor feature,
click the appropriate button. You can return to this dalog
by clicking the mouse button or pressing any key.

The Combination Test helps you verify your monitor is
properly aligned, and set at the correct color depth and
resolution. Use the crosshair pattern in each corner of
the screen to visually determine if the monitor aligns
correctly. If the crosshairs appear distored or out of
focus, a problem may exist with the monitor alignment.
Use the color spectrum array for visually verifying the
monitor color depth capacity. If the colors in the color
spectrum do no blend smoothly together, a problem
may exist with the monitor color depth. Use the
graduated horizontal and vertical alignment bars to
determine the monitor resolution capabilities. The better
you can discern individual lines as they move closer
together, the higher the resolution capabilities of the
monitor.

The Solid Color Test helps point out malfunctioning or
dysfunctional pixels using five basic colors: red, green,
blue, black, and white. Fill the screen with an
appropriate color by clicking the associated button. If a
pixed! is malfunctioning, the pixel color will contrast with
the color of all other pixels.

The VESA Test Patterns allow you to test the monitor for
proper luminance, geometry and focus. Click the
appropriate button to fill the screen with the associated
test pattern. You can return to this dalog by clicking the
mouse button or pressing any key.

System view 7-47
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7-6-3-4 PC Test(continued)

¢ Trackball

* The Mouse Status Test verifies the cursor position and
mouse button state. When a mouse button is pressed,
the corresponding button on the picture will change
color. If the mouse is a wheel or scroll mouse, an arrow
will indcate the direction the wheel is being rotated.
Clicking the wheel will flash the picture of the mouse in
the Mouse Status Test area.

» The Drag and Drop Test verifies a mouse can
successfully perform drag and drop operations. Left
click the picture of the CD and drag is onto the picture of
the drive. If successful, the picture will change.

» The Double Click Test verifies a mouse can successfully
perform double-click operations. Double-click on the
picture of the monitor. If successful, the picture will
change.

* Sound Test generates sounds for testing the speakers.
* USB Ports Test lists USB Devices.

7-6-3-5 Assessment Utility

Probe Assessment

NOTE: The probe assessment is only available for the probe connected
in the first probe port.

Figure 7-41. The first probe port

NOTE: P2D probe is not supported in Probe Assessment.
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7-6-3-5 Assessment Utility(continued)

1. Place the probe’s carrying case on a stable surface and
open the case.

2. Carefully remove the probe and unwrap the probe cord.
3. Put the probe in the probe holder.

CAUTION DO NOT allow the probe head to hang free. Impact to the
probe head could result in irreparable damage.

4. Prior to inserting the probe, ensure that the connector
locking handle is positioned to the left.

5. Align the connector with the probe port and carefully push
into the left-most probe port.

6. Turn the connector locking handle to the right to secure the
probe connector.

7. Carefully position the probe cord so it is free to move and is
not resting on the floor.

8. Press Probe button on the control panel and select the first
probe from the probe indicators.

9. Enter global service user interface as GE service.

10. In the Diags-> Run Diags-> ProbeAssessment to check
the probe.

If there is no broken element and the probe is acceptable for
diagnostic, the following result window displays.

Figure 7-42. Probe Assessment Pass
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7-6-3-5 Assessment Utility(continued)

11. In the Diags-> Run Diags->Diags History to check the
probe diagnostic results.

Figure 7-43. Probe Assessment Result

f CAUTION Reboot the system after the probe assessment.

7-6-3-5-1 Probe Pass/Fail Criteria
Pass

* No dead element

* Dead elements on the edge (#0, #1 or #end-1, #end)

Fail

* Max 2 weak elemets on the scan line: -3dB<elements<-2dB
* Any one of the elements in one scan line: element<-3dB
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/-7 Troubleshooting

7-7-1 Console Troubleshooting

7-7-1-1 System Doesn’t Boot (Hang-up)

Table 7-10:  Hang-up black screen diagnostic table

ON/OFF LED1

button (HDD) LED2 LED3 Failure module
White On Blink slowly | Blink Slowly | Normal status
1. ACDC failure or its related
cable.

Power No light OFF OFF 2. :;T;g;:;;,?:?; failure or its
connected. * 1atl.
Power on 3. CWI PWA failure.
button not 1. KBD Cable Connection failure.

pressed No light Blink slowly | Blink Slowly | 2. IODKG PWA failure.
3. KBD PWA failure.

White On Not Blink Not Blink CWI PWA failure

Green ON Blink slowly ON Normal status

Power on failed, no response to
power on button:

1. KBD Cable Connection failure
2. IODKG PWA failure.

3. KBD PWA failure.

4. CWI PWA failure.

White Blink slowly Blink slowly

CWI PWA failure - CWI power
Power on NA Blink quickly OFF have failure which leads to CPU
button NA boot fail.

pressed
1. IODKG PWA failure - IODKG

power have failure.

2. Peripheral failure - which may
cause D12V of IODKG
abnormal.

3. CWI PWA failure - PWR MCU
fail to send PWR_OK to
IODKG board.

NA OFF Blink quickly

Green ON Blink quickly | Blink quickly | CWI PWA failure - CPU boot fail.
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Chapter 8

Replacement Procedures

This chapter describes how to remove and install, or
replace, modules and subsystems in the Versana
Premier. It also includes instructions for installing and
re-installing the software.

Versana Premier — Basic Service Manual System view 8-1
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Replacement Procedures

8-1 Overview

8-1-1 Contents in this chapter

¢ 8-1‘Overview’ on page 8-2

*  8-2 ‘Warnings and important information’ on page 8-3
» 8-3 ‘Disassembly/Re-assembly’ on page 8-5

*  8-4 ‘Loading the software’ on page 8-9
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Warnings and important information

8-2-1 Warnings

ﬁ WARNING

ﬁ WARNING
ﬁ WARNING

AN

Versana Premier — Basic Service Manual
5789130-100 English Rev.5

8-2 Warnings and important

information

Energy Control and Power Lockout for Versana Premier.

When servicing parts of the Ultrasound system where there is
exposure to voltage greater than 30 volts:

1. Follow LOCK OUT/TAG OUT procedures.

2. Turn off the breaker.

3. Unplug the Ultrasound system.

4. Maintain control of the Ultrasound system power plug.

5

Wait for at least 30 seconds for capacitors to discharge as
there are no test points to verify isolation.

6. Remove/disconnect the battery, if present.

Ultrasound System components may be energized.

Because of the limited access to cabinets and equipment in the
field, placing people in awkward positions, GE has limited the
lifting weight for one person in the field to 16 KG (35 LBS).
Anything over 16 KG (35 LBS) requires 2 people.

DO NOT touch any boards with integrated circuits prior to
taking the necessary ESD precautions.

Always connect yourself, via an arm-wrist strap, to the advised
ESD connection point located on the rear of the Ultrasound
system (near the power connector).

Follow general guidelines for handling of electrostatic sensitive
equipment.

System view 8-3
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8-2-1 Warnings(continued)

NOTE: Use an ESD compatible work space or the ESD-kit during parts
replacement.

disposed as unsorted municipal waste and must be collected

f WARNING The waste of electrical and electronic equipment must not be
separately.

Please contact the manufacturer or other authorized disposal
company to decommission your equipment.

8-2-2 Returning/shipping probes and repair parts

Equipment being returned must be clean and free of blood and
other infectious substances.

GE policy states that body fluids must be properly removed from
any part or equipment prior to shipment. GE employees, as well
as customers, are responsible for ensuring that parts/equipment
have been properly decontaminated prior to shipment. Under no
circumstance should a part or equipment with visible body fluids
be taken or shipped from a clinic or site (for example, body coils
or an ultrasound probe). The purpose of the regulation is to
protect employees in the transportation industry, as well as the
people who will receive or open this package.

NOTE: The US Department of Transportation (DOT) has ruled that
‘items that were saturated and/or dripping with human blood
that are now caked with dried blood; or which were used or
intended for use in patient care” are “regulated medical waste”
for transportation purposes and must be transported as a
hazardous material.
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8-3 Disassembly/Re-assembly

8-3-1 Warning and Caution

REMOVE ANY COVERS OR PANELS. ELECTRICAL
HAZARDS EXISTS AT SEVERAL POINTS INSIDE.
BECOME THOROUGHLY FAMILIAR WITH ALL
HAZARDOUS VOLTAGES AND HIGH CURRENT
LEVELS TO AVOID ACCIDENTAL CONTACT

f WARNING  ONLY QUALIFIED SERVICE PERSONNEL SHOULD

CAUTION Do wear the ESD wrist strap when you work on live circuits and
more than 30V peak is present.

Versana Premier — Basic Service Manual System view 8-5
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8-3-2 Tools needed for servicing Versana Premier

Table 8-1:  Standard tools list for Versana Premier
Part
No Name Part No. QTY Screw Description Screwdriver Description
1 screw 2159632 2 Screw BH M4x6 Common Phillips Screwdriver
2 screw 2159634 4 Screw BH M4x10 WHT Common Phillips Screwdriver
3 screw 2327793 135 D2 Screw SJ2836-87 Common Phillips Screwdriver
M3x8
4 screw 2373562 3 Screw M4x10 Common Phillips Screwdriver
5 screw 5138465 10 Screw FH M2.5x5(NL) Common Phillips Screwdriver
6 screw 5176890 6 Screw DIN965A M4x8 Small Phillips Screwdriver
7 screw 5244775 2 Screw GB T820-2000 Common Phillips Screwdriver
M3x8
8 screw 5342274 4 Inch Screw #6-32UNC Common Phillips Screwdriver
9 screw 5439265 246 Screw-M4x10 Common Phillips Screwdriver
10 screw 5445720 12 GB 818-2000 M4x30 Common Phillips Screwdriver
11 screw 2337572 2 Screw FH M3x6 Common Phillips Screwdriver
12 screw 5476381 20 Bolt M8x18 with Washer 6# Inner Hexangular Set
13 screw 5476387 34 Bolt M6x15 with Washer 5# Inner Hexangular Set
14 screw 5476394 5 Bolt M8x30 6# Inner Hexangular Set
15 screw 5476438 14 Bolt M8x36 With Washer 6# Inner Hexangular Set
16 screw 5476440 17 Bolt M6x24 With Washer 5# Inner Hexangular Set
17 screw 5477579 2 Screw_DIN912 M6_20 5# Inner Hexangular Set
18 screw 5490719 4 Screw PM SW4x8 Common Phillips Screwdriver
19 screw 5491747 1 Screw Pan Head M4x4 Common Phillips Screwdriver
20 screw 5491847 2 Hand Screw M2p5x5 by hand
NOTE:  Please use the correct Screwdrivers listed in Table 8-1.
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Disassembly/Re-assembly

8-3-3 Overview of Versana Premier

Figure 8-1. System Overview 1

1. Monitor Assy 5. KBD Speaker Cover for Versana Premier
2. Keyboard Assy 6. Probe holder for Versana Premier
3. Body 4PP Front Cover for Versana 7. Frame Handle for Versana Premier
Premier(Option) 8. Gel holder for Versana Premier
4. Base Assy 9. Body Top Cover Assy for Versana Premier
Versana Premier — Basic Service Manual ; System view 8-7
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8-3-3 Overview of Versana Premier(continued)

Figure 8-2. System Overview 2

1. Monitor Assy
2. Keyboard Assy
3. Body Assy
4. Base Assy
8-8 ;, System view Versana Premier — Basic Service Manual
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8-4 Loading the software

8-4-1 Purpose of this section

This section describes how to reinstall software on Versana
Premier.

8-4-2 Customer provided prerequisite

* Formatted and labelled media for Images storage.

* Formatted and labelled media for Patient Archive and
Presets (User Defined Settings).

e Password for the user ADM.

8-4-3 Data Management - moving all images

f CAUTION An error, or a power loss may occur.

Always backup the Patient Archive and the Presets (System
Configurations) before loading the software!

In order to complete a successful restore of the Patient
Database, as needed after a hard disk replacement, or if all the
content on the hard disk has been erased, the images must be
moved away from Versana Premier before doing backup of the
Patient Database.

Depending on the location set-up, either move the images to a
remote server or to removable media like DVD or CD discs.

* Move the images to a remote server or to removable media.

For instructions, please see “Disk management” in the Basic
User Manual/User Guide.

Versana Premier — Basic Service Manual
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8-4-4 Backing up the Patient Archive and System Configurations

f CAUTION An error, or a power loss may occur.

Always backup the Patient Archive and the Presets (System
Configurations) before loading the software!

In order to complete a successful restore of the Patient
Database, as needed after a hard disk replacement, or if all the
content on the hard disk has been erased, the images must be
moved away from Versana Premier before doing backup of the
Patient Database.

Depending on the location set-up, either move the images to a
remote server or to removable media like DVD or CD discs.

« Backup the Patient Archive and System Configurations.

For instructions, please see “Data Backup and Restore” in
the Basic User Manual/User Guide.

8-4-5 Restoring up the Patient Archive and System Configurations

NOTE: It is not suggested to manually delete the files in
D:\ldunn\target\resources\idunn\userdefs.

WARNING To avoid Iackjng of connecting to Local Ar_chive, connecivity.res
and IPSave in D:\Ildunn\target\resources\idunn\userdefs could

not be deleted. If they are deleted, please rewirte the serial
number.
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8-4-6 Recording important settings and parameters

8-4-6-1 Overview

It is considered to be best practice to always keep a record on
paper of the settings for the Versana Premier. Verify if it is
current before you start to load software!

f CAUTION An error, or a power loss may occur.

Always keep a record of the settings for the Versana Premier on
paper. Verify if it is current before starting a software loading! If
needed, record the settings.

This subsection includes descriptions for recording data from
the following screens:
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8-4-7 Loading the System Software

preserved data, you should save any patient data,
images, system setups and customer presets to CD,
DVD, USB Flash Drive, or USB Hard Disk before doing a
software upgrade.

f WARNING While the software install procedure is designed to

NOTE:  Before loading the system software, please ensure that the
power can be continuously supplied and there is no risk of
power cut off during loading procedure.

NOTE:  Before loading/reload the system software, please change
system language to English, refer to Figure 3-57 on page 3-70.
Otherwise, there will be garbage on the system after software
reload/loading.

There is one method to load the system software:
NOTE:  Load the system software with USB memory stick.

NOTE:  Find the system software USB memory stick by removing the
body left cover, detailed position refer to the Figure.

Figure 8-3. Software USB memory stick position
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8-4-7-1 Loading the System Software with USB memory stick

This section describes how to upgrade the software.

1. Insert the Upgrade USB memory stick labeled “System &
Application Software” to the USB port of the system.

2. Properly turn off the system by momentarily pressing the
Power On/Off Switch. Then select Shutdown in the System
Exit Window.
NOTE: If the system does not shutdown normally, hold down the
Power On/Off Switch until the light turns off.

3. Power on the system and it will detect the USB memory
stick automatically.

4. Select the option Load the complete disk or Load the
bootable C: partition only for software upgrade. Or select
Exit to exit the upgrade process.

Load the complete disk Load the bootable C: partition anly

Only Reload/Upgrade Application

Software
Figure 8-4. Upgrade instruction
Versana Premier — Basic Service Manual . System view 8-13
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8-4-7-1 Loading the System Software with USB memory stick(continued)

Load the complete disk: the complete disk will be
loaded. This option is recommended for application
software upgrade.

Only Reload/Upgrade Application Software: the
application software will be loaded/upgraded only. This
option is recommended for application software
upgrade or reload.

data will be erased. If backup has not been performed, all data

f WARNING If selecting Load the complete disk, all existing software and

like Patient Data, System Configuration and User
Configurations (Customer Presets) will be lost. Please ensure
that any patient data on the disk has been backed up before
upgrading the system.

NOTE:

NOTE:

5.

NOTE:

8-14 ; System view

This option is used by service engineer only.

Load the bootable C: partition only: this option is
intended for recovery of a system that will not boot up.
All patient data is preserved.

While the software installation procedure is designed to
preserve data, select choice Load the bootable C:
partition only to format disk C.

If Load the complete disk is selected, a confirmation

window will pop out, then select Execute to continue.

Before loading the complete disk, please ensure that any

patient data on the disk has been backed up.
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8-4-7-1 Loading the System Software with USB memory stick(continued)

Confirmation

Are you sure to load the complete disk?

NOTE:

ALL PATIENT DATA (IF ANY) WILL BE DESTROYED! PLEASE BACKUP PATIENT DATA BEFORE
UPGRADING.

Figure 8-5. Confirmation Window
6. System USB memory stick will be loading. Wait for the

software installation to complete. Status bar on the screen
indicates the progress (about 30 minutes).

f WARNING Do not interrupt the software loading at any time.

Versana Premier — Basic Service Manual ;. System view 8-15
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Replacement Procedures

8-4-7-1 Loading the System Software with USB memory stick(continued)

&,3 GE Healthcare imagination at wark

Load the complete disk

+ Format the whole disk

@

[ | T

Figure 8-6. Loading Process
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Loading the software

8-4-7-1 Loading the System Software with USB memory stick(continued)

7. The system will display upgrading result and shutdown
automatically within 30 seconds. Or click the Shutdown in
the screen to shut down the system immediately.

} GE Healthcare imagination at work

Congratulations! The upgrade has completed
successfully and system will shutdown after 30

seconds automatically.

Or please click to shutdown your device.

Figure 8-7. System upgrade complete

If the upgrade fails, select Exit to exit the upgrade process,
then remove the USB memory stick. Insert the USB memory
stick again and repeat the upgrade process from step 2 on

page 8-13.

@ GE Healthcare i

Installation failed, please try again.

Please contact GE Service if this problem still exists.
@

U Upaie =

dithe drive specicd.

Figure 8-8. System upgrade fail
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Replacement Procedures

8-4-7-1 Loading the System Software with USB memory stick(continued)

8. Remove USB memory stick. Then press Power On/Off
switch to power on the system.

NOTE: Remove the USB memory stick before the system restarts.
If you do not remove the USB memory stick, the software
system upgrading process repeats when the system boots

up.

NOTE: Ensure the USB memory stick is properly and securely
connected. Once the USB memory stick is accidentally
disconnected from the system during the upgrading
process, the error message will pop up: “The volume for a
file has been externally altered so that the opened file is no
longer vaild.” Insert the USB memory stick again and restart
the system to run the upgrading process from step 3 on
page 8-13.

8-4-7-2 Rewrite the Serial Number
If selected to load the complete disk during the software loading

process, when powering the system, the system will indicate to
rewrite the serial number.
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o 5789130-100 English Rev.5
=~



Loading the software

8-4-7-3 Secure Wipe

NOTE:
NOTE:

NOTE:

NOTE:

NOTE:

Versana Premier — Basic Service Manual
5789130-100 English Rev.5

Secure wipe is intended to erase all the patient data with the
software on the system before the system will be shipped for
service.

This tool is not BAM approved.

Before starting this procedure, remove all probes and
peripherals and remove them from the system.

While it is believed to be unnecessary, it would not hurt to
disconnect the system from the network and remove all
transducer.

Please ensure AC adapter is connected during system upgrade!
1. Insert the USB memory stick labeled “System & Application
Software” to the system.

2. Properly turn off the scanner by momentarily pressing the
Power On/Off Switch. In System-Exit window, select
Shutdown to shutdown the system.

If the system will not shutdown normally, hold down the
Power On/Off Switch until the light turns off.

3. Power on the system. The system will detect the USB
memory stick automatically.

System view 8-19
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Replacement Procedures

8-4-7-3 Secure Wipe(continued)

4. Select Secure Wipe. Or select Exit to exit the process.

Load the complete disk Load the bootable C: partition only

Only Reload/Upgrade Application
Software

Figure 8-9. Upgrade message

5. The system indicates all data will be erased, select Execute
to continue.

Confirmation

Are you sure to erase the complete disk?

NOTE:
ALL PATIENT DATA (IF ANY) WILL BE DESTROYED !
PLEASE BACKUP PATIENT DATA BEFORE EXECUTING ERASING.

Figure 8-10. Confirm Dialog

NOTE: All the patient data cannot be recovered after wipe process.
8-20 System view Versana Premier — Basic Service Manual
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Loading the software

8-4-7-3 Secure Wipe(continued)

6. The process may take twenty minutes or more.

@ GE Healthcare imagination at work

Secure Wipe

+ Format the whole disk
+ Format disk1

0%

Estimated time: 31 minutes.

Figure 8-11. Wiping Process

7. The system will shutdown automatically when the wiping
progress completes.

NOTE: As the SSD is empty after secure wipe, the system cannot
boot up. The software should be loaded first after the wipe
process.
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Replacement Procedures

8-4-7-4 Software Version check out

8-4-7-4-1 Functional Check-out

1. Power on Versana Premier system and wait until system
booting to scanning screen.

NOTE: If selected to load C Disk only when loading the system
software, the system will display a screen to restore
Computer name before entering the scanning screen.

2. Press Utility on the control panel.

3. Select the System -> About and check whether the
software version is right.

General n sure Bac Peripherals

Software

Base Image

Patents

Figure 8-12. Software version
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Loading the software

8-4-7-5 Reload the Correct Preset Region

NOTE:  After the system software loading completion, please reload the
correct preset region.
1. Reboot the system.

2. Press Utility on the Control Pane, then select System ->
General.

3. Inthe Location portion, select the right region in the field of
Preset Region.

General System Imaging System Measure Backup/Res

Location

Regional Options
Date/Time
Time Forma

Date/Time(restart needed)

Figure 8-13. Preset Region

4. Reboot the system.
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Replacement Procedures

8-4-7-6 Option Strings Check

NOTE:  After the system software loading completion, please check the
option strings to ensure that the options are activated and
working.

1. Reboot the system.

2. Press Utility on the control panel.

3. Select Admin -> System Admin.

4. Ensure that all the installed option keys are displayed and
the status of Options are valid.

* The status “Permanent” means the option keys are
activated and working.

System Admin

Product

Remove

Protecting Health Information(PHI)
=

Disk Encryption
Disk Encryption
Change System Password

Chang d

Figure 8-14. Software Option
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Loading the software

8-4-7-7 Probe Recognition Check

NOTE:  After the system software loading completion, please check to
ensure that the system can recognize the probes.

Plug in the probe. In scanning mode, the probe information is
displayed on the right top location of the screen. About the
probe specification for intended use on Versana Premier.

Plug in at least one of each type of the probes and check if each
of the probes is recognized and the probe information is
displayed correctly.

, GE Healthcare Mi 0.8

28/06/2017 15:04:13 ADM Tis 0.2

Frq
- Gn
SIA
© Map
D
DR

Whiz

Figure 8-15. Probe identification
8-4-7-8 Peripheral Device Check

Check to ensure that all the peripheral devices work properly.

For instruction of peripheral device check, See
4-4-33 ‘Peripheral checks’ on page 4-63 for more information.

Versana Premier — Basic Service Manual
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Replacement Procedures

8-4-7-9 Reinstall DICOM Devices

Reinstall any DICOM devices used by the customers and check
to ensure these DICOM devices work properly.

The instruction about installing DICOM devices is not
incorporated in this manual. To access the instruction about
installing DICOM devices please refer to another manual Basic
User Manual. Please use the latest revision of this document.
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Chapter 9

Renewal Parts

This chapter lists the renewal parts available for the
Versana Premier.

Versana Premier — Basic Service Manual ; System view 9-1

5789130-100 English Rev.5 =
i~



Renewal Parts

9-1 Overview

9-1-1 Contents in this chapter

e List of Abbreviations
¢« Renewal Parts Lists
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List of Abbreviations

O-2 List of Abbreviations

Table 9-1:  List of Abbreviations

ABBREVIATION DESCRIPTION
3D THREE DIMENSIONAL
Assy ASSEMBLY
FRU Field Replacement Unit
CRU Customer Replacement Unit
KBD Keyboard Assy
BnV Brightness and Volume
MST Master Board
Cwi CPU /WDC /10 Board. WDC is DC Power Board for
Wukong Platform.
PIB Probe Interface Board, also name as Relay PIB
4PP 4 Probe Port
SSA Secure Service Access
Versana Premier — Basic Service Manual ; System view 9-3
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Renewal Parts

O9-3 Renewal Parts Lists

9-3-1 Operator Console Assy

The following figure illustrates what is the body front cover (1),
body left cover (2), body back cover (3), body right cover (4) of
the system.

Figure 9-1. Operator Console Assy
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Renewal Parts Lists

9-3-1 Operator Console Assy(continued)

Monitor Assy

Body ASSY e

Base AsSy .

{

;\1 Ix“ '\: V C
e T

Figure 9-2. Console Assy
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Renewal Parts

9-3-2 Probe
Table 9-2:  Probes for Versana Premier
Commercial | Center Image
Part Part Frequency Replaced
Item Part Name Number Number (MHz) By Qty
1100 4C-RS 5488477 H4000SR 3.10 £ 10% 1
1101 8C-RS 5499508 H40402LS 6.5+ 20% 1
1102 E8C-RS 5499516 H40402LN 6.5+ 20% 1
1103 E8Cs-RS 5670375 H48062AF 2.75 + 20% 1
1104 BE9CS-RS 5589323 H40482LN 7.5+ 20% 1
1105 3Sc-RS 47237516 H45041DL 2.75 +20% 5433833 1
1106 6S-RS 5499316 H45021RP 4.5+ 20% 1
1107 128-RS 5499321 H44901AB 7.75+20% 1
1108 12L-RS 5499501 H40402LY 7.5+ 20% 1
1109 LK760-RS 5548914 H44901AF 7.15+20% 1
1110 L8-18i-RS 5499609 H40462LF 9.5+ 20% 1
1111 RAB2-6-RS KTZ303982 H48681WR 3.3+10% 1
1112 RIC5-9A-RS KTZ304063 H48701EJ 6.5+ 10% KTZ304128 1
1113 L6-12-RS 5454332 H48062AC 7.75 1 20% 1

9-3-3 Peripheral

Table 9-3:  Peripherals for Versana Premier

Commercial
Part
Item | Part Number Number Description Qty
Footswitch
1201 5151236 H41642LS Footswitch MKF 2-MED USB GP26 1
1202 5338419 H41882LD 1-Peadl type Footswitch “Whanam FSU-1000" 1
USB Stick
1203 5446638 H48962LC USB Stick 1
Printer
1204 5133107-2 H485421L.Z SONY UPD25 Color Printer USA Kit 1

9-6 ; System view Versana Premier — Basic Service Manual
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Renewal Parts Lists

Table 9-3:  Peripherals for Versana Premier

Commercial
Part
Item | Part Number Number Description Qty
1205 | 5133108-2 H48552LA SONY UPD25 Color Printer EUP Kit 1
1206 | 5133106-2 H48542LY SONY UPD25 Color Printer CHN Kit 1
1207 | 5133109-2 H48552LB SONY UPD25 Color Printer JPN Kit 1
1208 | 5491253 H48312AN SONY UPD25 Color Printer BRAZIL kit
1209 | 5151259-2 H48492AZ BW Printer (UP-D898MD) 1
1210 | 5778615 H48052BG UP-D898MD DC Printer Kits 1
1211 5130409 H41402LS 898 printer paper 1
Others

1224 NA H48832AC Wireless Adaptor 1
1225 NA H48122BT Bluetooth Adaptor 1
1226 | 5449275-4 H48192BL Transcend TS8XDVDS-K DVDRW kit with SW 1
1227 | 5129487 H41852LK USB ECG Module (AHA) 1
1228 | 5800116 H41852LL USB ECG Module (IEC) 1
1229 | 5149641 H41852LM ECG ASSY w/ Chinese Label 1
1230 | 5434317-4 H48492AB 1TB mobile USB HDD 1
1231 5802026-3S NA Service for Versana Premier System and Application 1

Upgrade USB R1.0.2
1232 5802026-4S NA Service for Versana Premier System and Application 1

Upgrade USB R1.0.3
1233 5802026-6S H48172BY Service for Versana Premier System and Application 1

Upgrade USB R1.0.5

Versana Premier — Basic Service Manual
5789130-100 English Rev.5
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Renewal Parts

9-3-4 Power Cord

Table 9-4: Power Cords for Versana Premier

Commercial
Item Part Number Part Number Description Qty
1300 5177123-2 H48482AF AC Power Cord Europe 1
1301 5176304-2 H48482AK AC Power Cord China 1
1302 5176773-2 H48482AH AC Power Cord India 1
1303 5177195-2 H48482AC AC Power Cord Argentina 1
1304 5176907-2 H48482AG AC Power Cord UK 1
1305 5177153-2 H48482AM AC Power Cord Denmark 1
1306 5177154-2 H48482AD AC Power Cord Switzerland 1
1307 5177187-3 H48482AE AC Power Cord Australia 1
1308 5177146-2 H48482AL AC Power Cord USA 1
1309 5400868-2 H48482AN AC Power Cord Brazil 1
1310 5176753-2 H48482AJ AC Power Cord Israel 1
1311 5177126-2 H48482AB AC Power Cord Japan 1
9-8 é System view Versana Premier — Basic Service Manual
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Renewal Parts Lists

9-3-5 Manuals

Table 9-5:  Manuals for Versana Premier

Commercial
Item Part Number Part Number Description Qty
1401 5789132-200 H48252BB Versana Premier Manual CD 1
1402 5789129-100 H48252BE Versana Premier Advanced Reference Manual 1
1403 5789130-100 H48252BC Versana Premier Basic Service Manual 1
1404 5789128-100 H48252BD Versana Premier Basic User Manual 1
1405 5789133-100 H48252BG Versana Premier User Guide English version 1
1406 5789133-101 H48252BH Versana Premier User Guide French version 1
1407 5789133-106 H48252BJ Versana Premier User Guide Spanish version 1
1408 5789133-108 H48252BK Versana Premier User Guide German version 1
1409 5789133-111 H48252BL Versana Premier User Guide Italian version 1
1410 5789133-121 H48252BM Versana Premier User Guide Dutch version 1
1411 5789133-127 H48252BN Versana Premier User Guide Brazilian 1
Portuguese version

1412 5789133-129 H48252BP Versana Premier User Guide Estonian version 1
1413 5789133-131 H48262BN Versana Premier User Guide Slovenian version 1
1414 5789133-140 H48252BR Versana Premier User Guide Japanese version 1
1415 5789133-141 H48252BF Versana Premier User Guide Chinese version 1
1416 5789133-142 H48252BS Versana Premier User Guide Swedish version 1
1417 5789133-144 H48252BT Versana Premier User Guide Korean version

1418 5789133-145 H48252BW Versana Premier User Guide Russian version 1
1419 5789133-150 H48252BY Versana Premier User Guide Polish version 1
1420 5789133-151 H48252BZ Versana Premier User Guide Greek version 1
1421 5789133-153 H48262BR Versana Premier User Guide Hungarian version | 1
1422 5789133-154 H48262BA Versana Premier User Guide Slovakian version 1
1423 5789133-155 H48262BB Versana Premier User Guide Czech version 1
1424 5789133-159 H48262BC Versana Premier User Guide Turkish version 1
1425 5789133-160 H48262BD Versana Premier User Guide Danish version 1
1426 5789133-161 H48262BS Versana Premier User Guide Norwegian version | 1
1427 5789133-162 H48262BE Versana Premier User Guide Finnish version 1

Versana Premier — Basic Service Manual
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Renewal Parts

Table 9-5:  Manuals for Versana Premier

Commercial

Item Part Number Part Number Description Qty

1428 5789133-165 H48262BF Versana Premier User Guide Bulgarian version 1

1429 5789133-167 H48262BG Versana Premier User Guide Romanian version 1

1430 5789133-168 H48262BT Versana Premier User Guide Croatian version 1

1431 5789133-174 H48262BH Versana Premier User Guide Lithuanian version 1

1432 5789133-175 H48262BJ Versana Premier User Guide Latvian version 1

1433 5789133-176 H48262BK Versana Premier User Guide Serbian version 1

1434 5789133-177 H48262BL Versana Premier User Guide European 1
Portuguese version

1435 5789133-180 H48262BW Versana Premier User Guide Ukrainian version 1

1436 5789133-181 H48262BM Versana Premier User Guide Indonesian version | 1

1437 5789133-183 H48262BY Versana Premier User Guide Viethamese 1
version

1438 5789133-184 H48262BP Versana Premier User Guide Kazakh version 1

1439 5789140-100 H48252BG Versana Premier Release Notes English version | 1

1440 5789140-101 H48252BH Versana Premier Release Notes French version | 1

1441 5789140-106 H48252BJ Versana Premier Release Notes Spanish 1
version

1442 5789140-108 H48252BK Versana Premier Release Notes German 1
version

1443 5789140-111 H48252BL Versana Premier Release Notes lItalian version 1

1444 5789140-121 H48252BM Versana Premier Release Notes Dutch version 1

1445 5789140-127 H48252BN Versana Premier Release Notes Brazilian 1
Portuguese version

1446 5789140-129 H48252BP Versana Premier Release Notes Estonian 1
version

1447 5789140-131 H48262BN Versana Premier Release Notes Slovenian 1
version

1448 5789140-140 H48252BR Versana Premier Release Notes Japanese 1
version

1449 5789140-141 H48252BF Versana Premier Release Notes Chinese 1
version

1450 5789140-142 H48252BS Versana Premier Release Notes Swedish 1
version

1451 5789140-144 H48252BT Versana Premier Release Notes Korean version | 1
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Table 9-5:  Manuals for Versana Premier

Commercial

Item Part Number Part Number Description Qty

1452 5789140-145 H48252BW Versana Premier Release Notes Russian 1
version

1453 5789140-150 H48252BY Versana Premier Release Notes Polish version 1

1454 5789140-151 H48252BZ Versana Premier Release Notes Greek version 1

1455 5789140-153 H48262BR Versana Premier Release Notes Hungarian 1
version

1456 5789140-154 H48262BA Versana Premier Release Notes Slovakian 1
version

1457 5789140-155 H48262BB Versana Premier Release Notes Czech version 1

1458 5789140-159 H48262BC Versana Premier Release Notes Turkish version | 1

1459 5789140-160 H48262BD Versana Premier Release Notes Danish version 1

1460 5789140-161 H48262BS Versana Premier Release Notes Norwegian 1
version

1461 5789140-162 H48262BE Versana Premier Release Notes Finnish version | 1

1462 5789140-165 H48262BF Versana Premier Release Notes Bulgarian 1
version

1463 5789140-167 H48262BG Versana Premier Release Notes Romanian 1
version

1464 5789140-168 H48262BT Versana Premier Release Notes Croatian 1
version

1465 5789140-174 H48262BH Versana Premier Release Notes Lithuanian 1
version

1466 5789140-175 H48262BJ Versana Premier Release Notes Latvian version | 1

1467 5789140-176 H48262BK Versana Premier Release Notes Serbian 1
version

1468 5789140-177 H48262BL Versana Premier Release Notes European 1
Portuguese version

1469 5789140-180 H48262BW Versana Premier Release Notes Ukrainian 1
version

1470 5789140-181 H48262BM Versana Premier Release Notes Indonesian 1
version

1471 5789140-183 H48262BY Versana Premier Release Notes Viethamese 1
version

1472 5789140-184 H48262BP Versana Premier Release Notes Kazakh version | 1
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Chapter 10

Care and Maintenance

This chapter describes Care and Maintenance on the

Ultrasound system and peripherals. These procedures
are intended to maintain the quality of the Ultrasound
system’s performance. Read this chapter completely
and familiarize yourself with the procedures before

performing a task.

Versana Premier — Basic Service Manual System view 10-1
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Care and Maintenance

10-1 Overview

10-1-1 Contents in this chapter

* 10-1 ‘Overview’ on page 10-2

* 10-2 ‘Warnings’ on page 10-3

* 10-3 ‘Why do maintenance’ on page 10-4

* 10-4 ‘Maintenance task schedule’ on page 10-6
* 10-5 ‘Tools required’ on page 10-8

* 10-6 ‘System maintenance’ on page 10-12

* 10-7 ‘Electrical safety tests’ on page 10-23

* 10-8 ‘When there's too much leakage current ...’ on
page 10-34

* 10-9 ‘Inspection Paperwork’ on page 10-36
* 10-10 ‘Electrical Safety Tests Log’ on page 10-38
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Warnings

é DANGER

f CAUTION
f CAUTION
é CAUTION

Versana Premier — Basic Service Manual
5789130-100 English Rev.5

10-2 Warnings

BE SURE TO DISCONNECT THE ULTRASOUND SYSTEM
POWER PLUG AND OPEN THE MAIN CIRCUIT BREAKER
BEFORE YOU REMOVE ANY PARTS. BE CAUTIOUS
WHENEVER POWER IS STILL ON AND COVERS ARE
REMOVED.

Practice good ESD prevention. Wear an anti—static strap when
handling electronic parts and even when disconnecting/
connecting cables.

Do not pull out or insert circuit boards while power is on.

Do not operate this Ultrasound system unless all board covers
and frame panels are securely in place. System performance
and cooling require this.

System view 10-3
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Care and Maintenance

10-3 Why do maintenance

10-3-1 Preventive maintenance inspections

It has been determined by engineering that your Versana
Premier does not have any high wear components that fail with
use, therefore no Preventive Maintenance inspections are
mandatory.

However, some customers’ Quality Assurance Programs may
require additional tasks and or inspections at a different
frequency than listed in this manual.
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Why do maintenance

10-3-2 Quality assurance

In order to gain accreditation from organizations such as the
American College of Radiology (USA), it is the customer’s
responsibility to have a quality assurance program in place for
each Ultrasound system. The program must be directed by a
medical physicists, the supervising radiologist/physician or
appropriate designee.

Routine quality control testing must occur regularly. The same
tests are performed during each period so that changes can be
monitored over time and effective corrective action can be
taken.

Testing results, corrective action and the effects of corrective
action must be documented and maintained on the site.

Your GE service representative can help you with establishing,
performing and maintaining records for a quality assurance
program. Contact GE for coverage and/or price for service.

Versana Premier — Basic Service Manual System view 10-5
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Care and Maintenance

10-4 Maintenance task schedule

10-4-1 How often should maintenance tasks be performed?

NOTE:

NOTE:

The Care and Maintenance task schedule (provided in

Table 10-1 on page 10-6) specifies how often your Versana
Premier should be serviced and outlines items requiring special
attention.

It is the customer’s responsibility to ensure the Versana Premier
care and maintenance is performed as scheduled in order to
retain its high level of safety, dependability and performance.

Your GE Service Representative has an in-depth knowledge of
your Versana Premier and can best provide competent, efficient
service. Contact GE for coverage information and/or price for
service.

The service procedures and recommended intervals shown in
the Care and Maintenance Task Schedule assumes that you
use your Versana Premier for an average patient load (10-12
per day) and not use it as a primary mobile Ultrasound system
which is transported between diagnostic facilities.

If conditions exist which exceed typical usage and patient load,
then it is recommended to increase the care and maintenance
frequencies.

Table 10-1:  Customer Care Schedule
Per
Facilities
Service at Indicated QA
Time Daily Weekly Monthly Program Notes
Clean Probes o* * or before each use

Inspect AC Mains Cable

Inspect Cables and
Connectors

Clean Console

Clean Monitor

Clean Filters

10-6 é System view
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Maintenance task schedule

Table 10-1:  Customer Care Schedule (Continued)
Per
Facilities
Service at Indicated QA
Time Daily | Weekly Monthly Program Notes
Console Leakage Current See Notes Twice Annually
Checks
Peripheral Leakage See Notes Twice Annually
Current Checks
Surface Probe Leakage See Notes Twice Annually
Current Checks
Endocavity Probe Leakage See Notes Quarterly Annually
Current Checks
Surgical Probe Leakage See Notes Quarterly Annually
Current Checks
Measurement Accuracy See Notes Twice Annually
Checks
Functional Checks See Notes also after corrective

maintenance

NOTE:

NOTE:

The maintenance may require specialized equipment to
complete.

The care and maintenances are not mandatory. The table above

is for reference only.

Versana Premier — Basic Service Manual
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Care and Maintenance

NOTE:

10-5 Tools required

refer to chapter 8.

10-5-1 Standard GE tool kit

For a list of required tools for servicing the Versana Premier,

The following is a description of the “Standard” GE tool kit in the
USA. Not all tools are required.

Table 10-2:  Overview of GE-1 tool kit contents
Tool ID Description Tool ID Description
9-45358 Pliers Retaining Ring 9-XL9971MM Xcelite-hex Blade 1.27mm
9-4078 Scribe 9-XL9972MM Xcelite-hex Blade 1.5mm
9-44572 Wrench Open End 3/8 - 7/16 9-XL9973MM Xcelite-hex Blade 2 mm
9-44579 Wrench Open End 1/2 - 9/16 9-XL9974MM Xcelite-hex Blade 2.5mm
9-44579 Wrench Open End 1/2 - 9/16 9-XL9975MM Xcelite-hex Blade 3mm
9-45385 Pliers, Arc Joint 7 inch 9-XL9976MM Xcelite-hex Blade 4mm
9-45378 Pliers, Slip Joint 9-XL9977MM Xcelite-hex Blade 5mm
9-4518 Pliers, Long Nose, Miniature 9-XL991CM Handle
9-4518 Pliers, Long Nose, Miniature C2356E Screw starter - Kedman
Quick Wedge

9-44776 Ignition Wrench Set, 10 pc. BLBO Box - 18 Compartment
9-44601 Wrench, Adj., 4 inch DWL4283T Box - 5 Compartment
9-4151 Screwdriver, Blade, Stubby 9-41322 Pickup Tool, Claw type
9-41421 Screwdriver, Blade, Pocket 9-6757 6 pc Needle File Set

clip
9-41594 Screwdriver, Blade 1/8 in. x 4 9-9487 Utility Knife

in.
9-41581 Screwdriver, Blade 3/16in. x4 | 9-45341 Pliers Vice Grip 10 inch

in.
9-39451 20" Steel Tape, locking Spring 9-3001 Xacto Pen Knife

load
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Tools required

Table 10-2:  Overview of GE-1 tool kit contents (Continued)

Tool ID Description Tool ID Description
9-GH807 Ratchet, Offset, Slotted 9-HT62002 Solder Aid, Fork and Hook
68-412 Ratchet, Offset, Phillips 9-4099 Mirror, Round, Telescoping
9-GH130 Tapered Reamer 9-GH3001 Steel Rule Decimal 6 inch
9-41584 Screwdriver, slotted 1/4in. x 6 | 9-GH300ME Steel Rule Metric 6 inch

in.
9-4118 Screwdriver, Phillips #2, 9-XL9920 Xcelite-hex Blade.050 inch
Stubby
9-41293 Screwdriver, Phillips #0 9-XL9921 Xcelite-hex Blade 1/16 inch
9-41294 Screwdriver, Phillips #1 9-XL9922 Xcelite-hex Blade 5/16 inch
9-41295 Screwdriver, Phillips #2 9-XL9923 Xcelite-hex Blade 3/32 inch
9-46677 Hex Keys, 20 pc., Metric 9-XL9924 Xcelite-hex Blade 1/8 inch
9-34701 1/4 in. Standard Socket set (19 | 9-XL9925 Xcelite-hex Blade 5/32 inch
pc)
9-43499 1/2 inch Socket 1/4 inch drive 9-XL9926 Xcelite-hex Blade 3/16 inch
9-4355 Flex Spinner 9-XL99764 Xcelite-hex Blade 7/64
9-43523 Breaker 9-XL99964 Xcelite-hex Blade 9/64
9-43531 6 inch Ext. 9-XLM60 Mini-screwdriver kit
9-65283 Case 8.5in. x4.5in. x 2in. 9-45072 Pliers 6 inch Diagonal
Deep
9-46696 Hex Keys 9-XL100X Wire Stripper/Cutter 5 inch -
100X
9-39829 Torpedo Level, Magnetic 9-XL87CG Pliers - very fine needle
nose-87CG
9-38461 Hammer, Ball Peen, 4 oz. 9-WEWDT-07 Weller-Soldering-Replacem
ent Tip(1)
9-4280 Universal Joint 1/4 inch 9-WS175-E Wiss - Surgical Scissors
9-WEWG60P3 Weller - Soldering Iron, 3 wire KH174 Hemostat 5 inch Straight
9-WECT5B6 Weller - Soldering Iron Tip KH175 Hemostat 5 inch curved
9-WEWDP12 Weller - Desoldering Pump 9-729480121 Alignment tool (red)
93383 Flashlight Mini-Mag Lite (AAA
Bat.)
9-GH408 Tweezers
21576 Brush - Bristle

Versana Premier — Basic Service Manual
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Table 10-2:  Overview of GE-1 tool kit contents (Continued)
Tool ID Description Tool ID Description
9-4516 Pliers 4 1/4 inch Diagonal
10-5-2 GE-2 tool kit
Table 10-3:  Overview of GE-2 tool kit contents
GE-2 Sears Kit (#99034)
Tool ID Description Tool ID Description

9-45381 Pliers, Arc Joint 9 1/2 inch 9-44067 Socket 1 1/16 in. for 1/2 in.
drive

9-45092 Pliers, Linesman 8 1/2 inch 9-42679 Socket 10MM Hex for 1/2 in.
drive (2273333)

9-42882 Punch, Pin 3/32 inch 9-44262 Extension 10 inch for 1/2 in.
drive (2273405)

9-42884 Punch, Pin 5/32 inch 9-4258 3/8 inch to 1/2 inch Adapter

9-42886 Punch, Pin 1/4 inch 9-34374 3/8 inch Metric Socket Set -
12 PT

9-42973 Cold Chisel 1/2 inch 9-44311 16mm Socket 12 pt.

9-GH77 Center Punch Automatic 9-33485 Metal Socket Tray

9-GH890 File Handle, Adj. 9-33484 Metal Socket Tray

9-31276 File, Round, Bastard 8 inch 9-33484 Metal Socket Tray

9-31277 File, Half Round, Bastard 8 9-52068 Tap and Dirill Set

inch

9-31263 File, Flat Mill 8 inch 9-52722 #6 Tap

21045C Close Quarter Saw 9-52723 #8 Tap

9-44604 Wrench, Adj. 10 inch High Speed Drill Set

9-41587 Screwdriver 5/16 inch x 8 inch #36 Drill

9-41586 Screwdriver, Stubby 5/16 inch #29 Drill

9-GH19512 Countersink 1/2 inch 9-44046 3/8 inch Socket Set

9-44741 12 PC Combination Wrench

Set

10-10 é System view
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10-5-3 Special tools, supplies and equipment used for maintenance

Table 10-4:  Overview of tool requirements for periodic maintenance

Tool / kit Comments

Digital Volt Meter (DVM)

Anti Static Kit Kit includes anti—static mat, wrist strap and cables for 200 to
240V system

3M #2204 Large adjustable wrist strap

3M #2214 Small adjustable wrist strap

3M #3051 conductive ground cord

Anti Static Vacuum Cleaner 120V
230V
Safety Analyzer The safety Analyzer tool should be calibrated and compliant

with AAMI/ESI 1993 or IEC 60601 or AS/NZS 3551.

QIQ Phantom RMI Grayscale Target Model 403GS

NOTE! The use of a Phantom is not required during Care
and Maintenance. Customer may use it as part of their
Quality Assurance Program tests.

B/W Printer Cleaning Sheet See printer user manual for requirements

Color Printer Cleaning Sheet See printer user manual for requirements

Disposable Gloves

Versana Premier — Basic Service Manual ; System view 10-11
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10-6 System maintenance

10-6-1 Preliminary checks

The preliminary checks take about 15 minutes to perform. Refer
to the Ultrasound system user documentation whenever

necessary.
Table 10-5:  System preliminary checks
Step Item Description
1. Ask and Listen Ask the customer if they have any problems or questions about the
equipment.
2. Paperwork Fill in the top of Ultrasound Inspection Certificate (see Figure 10-5 on
page 10-36). Record all probes and Ultrasound system options.
3. Power up * Turn the Ultrasound system power on and verify that all fans and
peripherals turn on.
» Watch the displays during power up to verify that no warning or error
messages are displayed.
» Where applicable, confirm that the battery is charged. If no AC Input
present, use the internal battery.
4. Probes Verify that the Ultrasound system properly recognizes all probes.
5. Displays Verify proper display on the monitor.
6. FFA (server) Where applicable, for Warranty and Contract Customers only:
» Verify that InSite is functioning properly.
» Ensure two-way remote communications.
7. Review Error Logs | Where applicable, Error Logs can be reviewed via system diagnostics.
8. Diagnostics Optional.
9. Presets Backup all Customer Presets to an appropriate media.
10. Image Archive Back up the Image Archive onto appropriate media.

Versana Premier — Basic Service Manual
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10-6-2 Functional checks

NOTE:

See also Chapter 4

The functional checks take about 60 minutes to perform. Refer
to the Ultrasound system user documentation whenever
necessary.

10-6-2-1 System checks

Table 10-6:  System functional checks
Step Item Description
1. B-Mode Verify basic B-Mode (2D) operation. Check the basic Ultrasound system
controls that affect this mode of operation.
2. CF-Mode Verify basic CF-Mode (Color Flow Mode) operation. Check the basic
Ultrasound system controls that affect this mode of operation.
3. Doppler Modes Verify basic Doppler operation (PW and CW if available). Check the basic
Ultrasound system controls that affect this mode of operation.
4. M-Mode Verify basic M-Mode operation. Check the basic Ultrasound system
controls that affect this mode of operation.
5. Probe Elements Perform an Element Test on each probe to verify that all the probe
elements and system channels are functional.
6. Applicable Verify the basic operation of all optional modes such as Contrast. Check
Software Options the basic Ultrasound system controls that affect each options operation.
7. Xmit/Recv Use the Visual Channel Utility on the loop connect to verify that all system
Elements xmit/recv channels are functional.
8. Operator Panel Perform the Operator Panel Test Procedure.
test
9. Keyboard Do the interactive keyboard test.
10. Monitor Verify basic monitor display functions. Refer to Chapter 3 of the Basic
User Manual.
11. Software Menu Verify Software Menu display functions. Refer to Chapter 3 of the Basic
check User Manual.
12. Peripherals See: 4-4-33 ‘Peripheral checks’ on page 4-63.
13. Measurements In measurement mode, make distance measurement, get result in result

window. Verify the distance by graduate rule. Distance Accuracy should
be within £5%. (Name result from result window Result A, result from
graduate rule Result B; Distance Accuracy = (Result B-Result A)/Result A)

Versana Premier — Basic Service Manual
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Care and Maintenance

10-6-2-2 Peripheral/option checks

If any peripherals or options are not part of the system
configuration, the check can be omitted.

Refer to the User Manual for a list of approved peripherals/
options.

Table 10-7:  GE approved peripheral/hardware option functional checks

Step Item Description

1. Media Verify media drive(s) read/write properlty. Clean if necessary.

2. B/W Printer Verify hardcopy output of the B/W video page printer. Clean heads and
covers if necessary.

3. Color Printer Verify hardcopy output of the Color video page printer. Clean heads and
covers if necessary.

4. DICOM Verify that DICOM is functioning properly. Send an image to a DICOM
device.

5. ECG Verify basic operation with customer

6. Footswitch Verify that the footswitch is functioning as programed. Clean as necessary.

7. DVD Verify that the DVD is functioning properly. Clean heads and covers if

necessary.

10-6-2-3 Mains cable inspection

Table 10-8: Mains Cable Inspection, As Appropriate

Step Item Description
1. Unplug Cord Disconnect the mains cable from the wall and Ultrasound system.
2. Inspect Inspect it and its connectors for damage of any kinds.
3. Verify Verify that the LINE, NEUTRAL and GROUND wires are properly attached
to the terminals, and that no strands may cause a short circuit.
4. Verify Inlet connector retainer is functional.
10-14 é System view Versana Premier — Basic Service Manual
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10-6-2-4 Cleaning

Table 10-9:  General Cleaning
Step Item Description
1. Console Remove the battery. Use a fluid detergent in warm water on a soft, damp
cloth to carefully wipe the entire system. Be careful not to get the cloth too
wet so that moisture does not enter the console.
2. Probe Holder Clean probe holders. (they may need to be soaked to remove excess gel).
3. Monitor Use a soft, non-abrasive folder cloth. Gently wipe the monitor face. DO
NOT use a glass cleaner that has a hydrocarbon base (such as Benzene,
Methy Alcohol or Methy Ethyl Ketone) on monitor with the filter (anti-glare
shield).
For general cleaning of the system, we recommended to use
non-abrasive soap and water solution.
Table 10-10:  Compatible Chemicals for Cleaning
Sys- Operator | Main Touch | Probe
tem Control display | screen | Holder
Cabinet | Panel
Cleaning agents
PDI Easy Screen Cleaning Wipe X X X X X
70% isopropyl alcohol X X X X X
Disinfectants [']
Tristel Wipes X X X X X
CaviWipes X X X X X
Protex X X X X X
Sono Ultrasound Wipes X X X X X
PDI Sani-Cloth Plus X X X X X
PDI Sani-Cloth HB X X X X X
PDI Super Sani-Cloth Plus X X X X X
Clorox wipes X X X X X
[1]: Effective Disinfection is always a balance between safe inactivation of infectious agents and
undesirable side effects. Due to the generally uneven and irregular surface of Ultrasound consoles, a
comprehensive surface disinfection process cannot be recommended by the manufacturer.

Versana Premier — Basic Service Manual
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10-6-3 Physical inspection
NOTE: These features may not be present on all Ultrasound systems.

Table 10-11:  Physical checks

Step Item Description
1. Labeling Verify that all Ultrasound system labeling is present and in readable
condition.
2. Scratches & Dents | Inspect the exterior for dents, scratches or cracks.
3. Input Power Refer to: 10-6-2-3 ‘Mains cable inspection’ on page 10-14.
4. Cables & Check all internal cable harnesses and connectors for wear and secure
Connectors connector seating. Pay special attention to footswitch assembly and probe

strain or bend reliefs.

5. Shielding & Check to ensure that all EMI shielding, internal covers, air flow panels and
Covers screws are in place. Missing covers and hardware could cause EMI/RFI
problems while scanning.

6. Control Panel Inspect keyboard and control panel. Note any damaged or missing items.

7. Control Panel Check for proper operation of all operator panel and Freeze Key light.
Lighting

8. Monitor Inspect the monitor Display for scratches and bad pixels.

Verify proper operation of Contrast and Brightness controls.
Where applicable, confirm that the monitor arm allows:

+ swivelling the screen to the left and to the right

« folding the screen to the locked position

* release and adjustment backwards and forwards

+ can be adjusted in the up/down positions.

Note: Monitor Arm movement may vary and is not applicable to all
Ultrasound systems.

9. External I/0 Check all connectors for damage.

10. Power and Check for proper operation of all Power and System Status Indicators.
System Status
Indicators

11. Battery Where applicable, check that the battery is not damaged, does not leak,

does not emit an odor, and is not deformed or discolored. Observe all
warnings and cautions for battery handling, recharging, storing, and/or
disposal,

10-6-4 Optional Diagnostic Checks

Optionally you can access the diagnostic software as described
in Chapter 5 or 7. View the error logs and run desired
diagnostics.

10-16 ; System view Versana Premier — Basic Service Manual
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10-6-4-1 View the Log

Versana Premier — Basic Service Manual

5789130-100 English Rev.5

Review the system error log for any problems.

Check the temperature log to see if there are any trends that
could cause problems in the future.

Check the Configuration Log; update if needed.

System view 10-17
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10-6-5 Probe maintenance

10-6-5-1 Probe related checks

Table 10-12:  System preliminary checks

Step Item Description
1. Probe Holder Clean probe holders. (they may need to be soaked to remove excess gel).
2. Probes Thoroughly check the Ultrasound system probe connectors and remove
dust from inside the connector sockets if necessary. Visually check for
bent, damaged or missing pins.
3. Probes Verify that the Ultrasound system properly recognizes all probes.

10-6-5-2 Basic probe care

The Ultrasound system user manuals and various probe
handling cards provide a complete description of probe care,
maintenance, cleaning and disinfection. Ensure that you are
completely familiar with the proper care of GE probes.

Ultrasound probes can be easily damaged by improper
handling. See the User Manual and probe care cards for more
details. Failure to follow these precautions can result in serious
injury and equipment damage. Failure to properly handle or
maintain a probe may also void its warranty.

Any evidence of wear indicates the probe cannot be used.

Do a visual check of the probe pins and Ultrasound system
sockets before plugging in a probe.

The Interoperative probes often have special considerations and
individual probe user manuals. For Interoperative probes also
refer to their separate user manuals.
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10-6-5-3 Basic probe cleaning

f CAUTION
é CAUTION

ﬁ WARNING
f CAUTION

f CAUTION

Versana Premier — Basic Service Manual
5789130-100 English Rev.5

Refer to the User’'s Manual for details on probe cleaning.
To clean the probe:

1. Disconnect the probe from the ultrasound console and
remove all coupling gel from the probe by wiping with a soft
cloth and rinsing with flowing water.

2. Wash the probe with mild soap in lukewarm water. Scrub the
probe as needed using a soft sponge, gauze, or cloth to
remove all visible residue from the probe surface. Prolonged
soaking or scrubbing with a soft bristle brush (such as a
toothbrush) may be necessary if material has dried onto the
probe surface.

Do not submerge the probe above the probe as the strain relief
is not sealed. Do not allow fluid into or onto the connector of
the probe.

Take extra care when handling the lens face of the Ultrasound
transducer. The lens face is especially sensitive and can easily
be damaged by rough handling. NEVER use excessive force
when cleaning the lens face.

3. Rinse the probe with enough clean potable water to remove
all visible soap residue.

4. Air dry or dry with a soft cloth.

To help protect yourself from blood borne diseases, wear
approved disposable gloves. These are made of nitrile derived
from vegetable starch to prevent allergic latex reactions.

Failure to follow the prescribed cleaning or disinfection
procedures will void the probe’s warranty.

DO NOT soak or wipe the lens with any product not listed in the
User Manual. Doing so could result in irreparable damage to
the probe.

Follow care instructions that came with the probe.

Disinfect a defective probe before you return it. Be sure to tag
the probe as being disinfected.

System view 10-19
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10-6-5-4 Disinfecting probes

f CAUTION

Ultrasound probes can be disinfected using liquid chemical
germicides. The level of disinfection is directly related to the
duration of contact with the germicide. Increased contact time
produces a higher level of disinfection.

Review the probe care card that is packed with each probe.
The following website contains the most current and up-to-date
recommendations:

http://www.gehealthcare.com/usen/ultrasound/products/
probe_care.html

Table 10-13:  Probe Disinfectants

Ultrasound Gel
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Disinfectant o -z
Aquasonic 100 X X X X X X X | X | X X X X X X
Clear image X X X X | X | X X | X | X X X X
Haiyin X X X X X X X X
Kendall Life Trace X X X X | X X X | X[ X X X X X X

Scan

Sonogel

Wavelength Multi-

Purpose Ultrasound Gel

CaviCide AF X

PCS 1000 Oxidizing X
Disinfectant/Cleaner

PI-Spray II X
Acryl-Des X X X | X[ X | X | X[|X|X X | X X X
Bacillol 30 Foam X X X | X[ X | X | X[X|X X | X X X

Surfa'Safe Premium

Asepti-Wipe Il X
Transeptic Spray X X X X
Bacillol AF Tissues X [ X [ X | X | X |[X [X|X]|X |[X]|X|X X
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Table 10-13:  Probe Disinfectants
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CaviWipes 1 X X X | X | X | X X | X | X X | X X X | X
Cleanisept Wipes X
Cleanisept Wipes forte X X X X | X | X X | X | X X X X X
Clorox Healthcare Bleach | X X X X | X | X X | X | X X X X X
Germicidal wipes
Matrix Wipes X X X | X | X | X X | X | X X | X X X
Oxivir Tb Wipes X X X | X | X X | X | X X | X
Protex ULTRA X X X | X | X | X X | X | X X | X X X | X
Disinfectant Wipes
Sani-Cloth Active X
Sani-Cloth HB Germicidal X
Disposable Wipe
Sani-Cloth Prime X X X | X | X | X X | X | X X | X X X | X
Germicidal Disposable
Wipe
Septiwipes X
Sono Ultrasound Wipes X X X X | X X X | X[ X X X X X
Super Sani-Cloth X X X X | X | X X | X | X X X X X
Germicidal Disposable
Wipe
Tristel Trio Wipes System | X X X X | X | X X | X | X X X X X
Wet Wipe Triamin X
Disinfection
Wip'Anios Excel X X X | X | X | X X | X | X X | X X X | X
Gigasept pearls X X X
Rely+On PeraSafe X X X
Sekusept Aktiv X X X
Anioxyde 1000 X X X
Cidex X X X | X | X | X X | X | X X | X X X
Cidex OPA X X X | X | X | X X | X | X X | X X X
Gigasept FF neu X X X X | X X | X | X X
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Table 10-13:  Probe Disinfectants
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McKesson OPA 28 X X X [ X [ X [ X | X|X|X X | X X X
OPAL X X X [ X [ X [ X | X|X|X X | X X X
Opaster'Anios X X X X | X | X X | X | X X X X X
Revital-Ox Resert High X X X | X X X X
Level Disinfectant
Wavicide-01 X X | X | X[ X]|X X X
AniosClean Excel D X X X X | X | X X | X | X X X X X
Aniosyme X3 X
Enzyclean Il Dual E X
nzyme Detergent
Pure Enzymatic X
Detergent
Enzol / Cidezyme X X X X | X | X X | X | X X X X X
Intercept Detergent X X X X | X | X X | X | X X X X X
Prolystica X X X [ X [ X [ X | X|X|X X | X X X
Trophon X X X | X [ X [ X | X|X|X X | X X X
Revital-Ox Enzymatic X
Detergents
Valsure Enzymatic X
Cleaner
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10-7 Electrical safety tests

10-7-1 Safety test overview

The electrical safety tests in this section are based on and
conform to IEC 60601-1 Medical Equipment Safety Standards.
They are intended for the electrical safety evaluation of
cord-connected, electrically operated, patient care equipment. If
additional information is needed, refer to the IEC 60601-1
documents

INSPECTIONS ARE PERFORMED AT LEAST EVERY
12 MONTHS ACCORDING TO HISTORICAL DATA.
ONLY TRAINED PERSONS ARE ALLOWED TO
PERFORM THE SAFETY INSPECTIONS MENTIONED
ABOVE.

é WARNING THE USER MUST ENSURE THAT THE SAFETY

DANGER  TO MINIMIZE RISK OF ELECTRICAL SHOCK, ONLY
TRAINED PERSONS ARE ALLOWED TO PERFORM THE

A ELECTRICAL SAFETY INSPECTIONS AND TESTS.

DANGER TO AVOID ELECTRICAL SHOCK, THE ULTRASOUND
SYSTEM UNDER TEST MUST NOT BE CONNECTED TO
OTHER ELECTRICAL EQUIPMENT. REMOVE ALL
INTERCONNECTING CABLES AND WIRES. THE
ULTRASOUND SYSTEM UNDER TEST MUST NOT BE
CONTACTED BY USERS OR PATIENTS WHILE
PERFORMING THESE TESTS.

CAUTION Possible risk of infection. Do not handle soiled or contaminated
probes and other components that have been in patient
contact. Follow appropriate cleaning and disinfecting
procedures before handling the equipment.

Versana Premier — Basic Service Manual
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10-7-1 Safety test overview(continued)

Prior to initiating any electrical test, the Ultrasound system must
be visually inspected. Perform the following visual checks:

»  Check for missing or loose enclosure covers that could
allow access to internal live parts.

» Examine the mains cord, mains plug and appliance inlet for
damaged insulation and adequacy of strain relief and cable
clamps.

* Locate and examine all associated transducers. Inspect the
cables and strain relief at each end. Inspect the transducer
enclosure and lens for cracks, holes and similar defects.

Test the system, peripherals and probes for leakage current.
Excessive leakage current can cause injury or death in sensitive
patients. High leakage current can also indicate degradation of
insulation and a potential for electrical failure. Do not use probes
or equipment having excessive leakage current.

To minimize the risk that a probe may shock someone the
customer should:

* Not use a probe that is cracked or damaged in any way.
*  Check probe leakage current:

* Based on your facilities QA program for surface probes.

* Based on your facilities QA program for endocavitary
probes.

* whenever probe damage is suspected.
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10-7-2 Leakage current limits

ﬁ WARNING

f CAUTION

Energy Control and Power Lockout for Versana Premier.

When servicing parts of the Ultrasound system where there is
exposure to voltage greater than 30 volts:

1. Follow LOCK OUT/TAG OUT procedures.

2. Turn off the breaker.

3. Unplug the Ultrasound system.

4. Maintain control of the Ultrasound system power plug.

5

Wait for at least 30 seconds for capacitors to discharge as
there are no test points to verify isolation.

6. Remove/disconnect the battery, if present.

Ultrasound System components may be energized.

Compare all safety-test results with safety-test results of
previously performed safety tests (e.g. last year etc). In case of
unexplainable abrupt changes of safety-test results consult
experienced authorized service personnel or GE for further
analysis.

The following limits are summarized for IEC 60601-1 Medical
Equipment Safety Standards. These limits are GEMS standards
and in some cases are lower than the above standards listed.

Table 10-14: Chassis Leakage Current Limits - Accessible Metal Surface
Normal Reverse

Country Condition Open Ground Polarity Open Neutral
All (Except USA & | 0.1 mA 0.5 mA 0.5 mA 0.5 mA
Canada)
USA & Canada 0.1 mA 0.3 mA 0.3 mA 0.3 mA

Table 10-15:  Type BF Applied Part Leakage Current Limits - Probes Surface

Normal Open Reverse Open *Mains

Country Condition Ground Polarity Neutral Applied

All 0.1 mA 0.5mA 0.5mA 0.5 mA 5.0 mA
Versana Premier — Basic Service Manual System view 10-25
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10-7-2 Leakage current limits(continued)

Table 10-16: Type CF Applied Part Leakage Current Limits - ECG Connections

Normal Open Reverse Open *Mains
Country Condition Ground Polarity Neutral Applied
All 0.1 mA 0.5 mA 0.5 mA 0.5 mA 5.0 mA

NOTE: *Mains Applied refers to the sink leakage test where mains
(supply) voltage is applied to the part to determine the amount of
current that will pass (or sink) to ground if a patient contacted
mains voltage.

The following tests are performed at the factory and should be
performed at the site. These tests are: chassis leakage current,
and probe leakage current. All measurements are made with an
electrical safety analyzer which should be calibrated and
compliant with AAMI/ESI 1993 or IEC 60601 or AS/NZS 3551.

Table 10-17: Equipment Type and Test Definitions

Applied | Parts or accessories that contact the patient to
Parts perform their function. For ultrasound equipment,
(AP) this includes transducers and ECG leads.

Type BF | Body Floating or r

non-conductive ultrasound

probes which are marked

with the 'man in box' BF

symbol. this includes all

transducers.

Type CF | Cardiac Floating or
non-conductive
intraoperative probes for
direct cardiac contact and
isolated ECG connections
so marked with the 'heart in
box' CF symbol.

Sink The current resulting from the application of mains
Leakage | voltage to the applied part. This test is required
test for Type CF applied parts.
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10-7-3 Outlet test - wiring arrangement

Test all outlets in the area for proper grounding and wiring
arrangement by plugging in the neon outlet tester and noting the
combination of lights that are illuminated. Any problems found
should be reported to the hospital immediately and the

receptacle should not be used.

Ty CORRECT WIRING
e
Toxe REVERSED POLARITY
e
HOT AND GROUND
@0k
{¥} REVERSED
Figure 10-1.

OPEN GROUND WIRE

o:«:&

OPEN NEUTRAL WIRE

oox@
L J

OPEN HOT WIRE

Typical alternate outlet tester

NOTE:  No outlet tester can detect the condition where the Neutral
(grounded supply) conductor and the Grounding (protective
earth) conductor are reversed. If later tests indicate high leakage
currents, this should be suspected as a possible cause and the
outlet wiring should be visually inspected.
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10-7-4 Grounding continuity

DANGER ELECTRIC SHOCK HAZARD. THE PATIENT MUST NOT BE
A CONTACTED TO THE EQUIPMENT DURING THIS TEST.

Measure the resistance from the third pin of the attachment plug
to the exposed metal parts of the case. The ground wire
resistance should be less than 0.2 ohms. Reference the
procedure in the IEC60601-1.

D

GROUND PIN

OHMMETER

Versana Premier

ACCESSIBLE METAL PART:

* MONITOR HOUSING

* PEAR PANEL CONNECTOR

« ANY CASTER/WHEEL SUPPORT

hoN=

Figure 10-2. Ground continuity test
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Electrical safety tests

10-7-5 Chassis leakage current test

f DANGER
f CAUTION

ELECTRIC SHOCK HAZARD. WHEN THE METER'S
GROUND SWITCH IS OPEN, DON'T TOUCH THE
ULTRASOUND SYSTEM!.

Equipment damage possibility. Never switch the Polarity and
the status of Neutral when the Ultrasound system is powered
ON. Be sure to turn the Ultrasound system power OFF before
switching them using the POLARITY switch and/or the
NEUTRAL switch. Otherwise, the Ultrasound system may be
damaged.

10-7-5-1 Generic procedure

POWER

The test verifies the isolation of the power line from the chassis.
The testing meter is connected from accessible metal parts of
the case to ground. Measurements should be made with the unit
ON and OFF, with the power line polarity Normal and Reversed.
Record the highest reading of current.

POLARITY REVERSING
SWITCH

OUTLET V%
H (BLACK! A e )
I
!
N {WHITE) py K -
—K N
N
SACCESSIBLE
MOMENTARY SWITCH METAL
_LG (GREEN} & PARTS

LEAKAGE
TEST
METER

Figure 10-3. Set Up for Chassis Source Leakage Current, IEC 601-1 Clause 19 -
Continuos Leakage Currents and Patient, Auxiliary Currents

Versana Premier — Basic Service Manual
5789130-100 English Rev.5

When using the Microguard or a similar test instrument, its
power plug may be inserted into the wall outlet and the
equipment under test is plugged into the receptacle on the panel
of the meter. This places the meter in the grounding conductor
and the current flowing from the case to ground will be indicated
in any of the current ranges. The maximum allowable limit for
chassis source leakage is shown in Table 10-14 on page 10-25.

System view 10-29
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10-7-5-2 Data Sheet for enclosure Source Leakage Current

The test passes when all readings measure less than the value
shown in Table 10-14 on page 10-25. Record all data on the PM
Inspection Certificate.

Table 10-18:  Typical Data Sheet for enclosure Source Leakage Current

Tester
Neutral
Tester or Test 1 Test 2 Real
Unit Polarity Ground Speaker Panel Metal Optional Optional
Power Switch Switch Cover Parts Test 3 Test 4

Enter Name of tested peripheral here:

ON NORM OPEN
ON NORM CLOSED
ON REV OPEN
ON REV CLOSED
OFF NORM OPEN
OFF NORM CLOSED
OFF REV OPEN
OFF REV CLOSED

10-30 ; System view Versana Premier — Basic Service Manual
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Electrical safety tests

10-7-6 Probe leakage current test

f DANGER

f CAUTION

10-7-6-1 Definition

NOTE:

10-7-6-2 Tools

Versana Premier — Basic Service Manual
5789130-100 English Rev.5

DO NOT USE THE PROBE IF THE INSULATING MATERIAL
HAS BEEN PUNCTURED OR OTHERWISE COMPROMISED.

INTEGRITY OF THE INSULATION MATERIAL AND PATIENT
SAFETY CAN BE VERIFIED BY SAFETY TESTING
ACCORDING TO IEC60601-1.

Equipment damage possibility. Never switch the Polarity and
the status of Neutral when the Ultrasound system is powered
ON. Be sure to turn the Ultrasound system power OFF before
switching them using the POLARITY switch and/or the
NEUTRAL switch. Otherwise, the Ultrasound system may be
damaged.

This test measures the current that would flow to ground from
any of the probes through a patient who is being scanned and
becomes grounded by touching some other grounded surface.

Some leakage current is expected on each probe, depending on
its design. Small variations in probe leakage currents are normal
from probe to probe. Other variations will result from differences
in line voltage and test lead placement. It is abnormal if no
leakage current is measured. If no leakage current is detected,
check the configuration of the test equipment.

For needed tools, see: 10-5 ‘Tools required’ on page 10-8.

System view 10-31
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10-7-6-3 Generic procedure on probe leakage current

Measurements should be made with the ground open and
closed, with power line polarity normal and reversed, and with
the unit Off and On. For each combination, the probe must be
active to find the worst case condition.

POLARITY REVERSING SWITCH

H (BLACK) PROBE
o [D
CONSOLE
POWER N _(WHITE) o =Oﬂ
OUTLET
G (GREEN)
J:' MOMENTARY
SWITCH LEAKAGE TEST
/ METER
Figure 10-4. Set up for probe leakage current
NOTE: Each probe will have some amount of leakage current,

f DANGER

dependent on its design. Small variations in probe leakage
currents are normal from probe to probe. Other variations will
result from differences in line voltage and test lead placement.

TO AVOID PROBE DAMAGE AND POSSIBLE ELECTRIC
SHOCK, DO NOT IMMERSE PROBES INTO ANY LIQUID
BEYOND THE LEVEL INDICATED IN THE PROBE USERS
MANUAL. DO NOT TOUCH THE PROBE, CONDUCTIVE
LIQUID OR ANY PART OF THE UNIT UNDER TEST WHILE
DOING THE TEST.

10-7-6-4 Meter Procedure Using Probe Adapter

Follow the Safety Analyzer tool instruction to test each
transducer for leakage current.

The electrical Safety Analyzer tool should be calibrated and
compliant with AAMI/ESI 1993 or IEC 60601 or AS/NZS 3551.

10-7-6-5 No Meter Procedure Using Probe Adapter

10-32 é System view

Follow the Safety Analyzer tool instruction to test each
transducer for leakage current.

The electrical Safety Analyzer tool should be calibrated and
compliant with AAMI/ESI 1993 or IEC 60601 or AS/NZS 3551.

Versana Premier — Basic Service Manual
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Electrical safety tests

10-7-6-6 Data Sheet for Transducer Source Leakage Current

The test passes when all readings measure less than the values
shown in Table 10-15 on page 10-25. Record all data on the PM
Inspection Certificate.

the status of Neutral when the Ultrasound system is powered
ON. Be sure to turn the Ultrasound system power OFF before
switching them using the POLARITY switch and/or the
NEUTRAL switch. Otherwise, the Ultrasound system may be
damaged.

f CAUTION Equipment damage possibility. Never switch the Polarity and

Table 10-19:  Typical Data Sheet For Transducer Source Leakage Current

Transducer Tested:

Tester Power Polarity Tester GROUND or
Unit Power Switch NUETRAL Switch Measurement
ON NORM OPEN
ON NORM CLOSED
ON REV OPEN
ON REV CLOSED
OFF NORM OPEN
OFF NORM CLOSED
OFF REV OPEN
OFF REV CLOSED

Versana Premier — Basic Service Manual
5789130-100 English Rev.5
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10-8 When there's too much leakage

10-8-1 AC/DC Fails

current ...

Where applicable, check the AC/DC adapter and its cable.
Replace a new one if any portion is defective.

10-8-2 Chassis Fails

NOTE:

Check the ground on the power cord and plug for continuity.
Ensure the ground is not broken, frayed, or intermittent. Replace
any defective part.

Where applicable, tighten all grounds. Ensure star washers are
under all ground studs.

Inspect wiring for bad crimps, poor connections, or damage.

Test the wall outlet; verify it is grounded and is free of other
wiring abnormalities. Notify the user or owner to correct any
deviations. As a work around, check the other outlets to see if
they could be used instead.

No outlet tester can detect the condition where the white neutral
wire and the green grounding wire are reversed. If later tests
indicate high leakage currents, this should be suspected as a
possible cause and the outlet wiring should be visually
inspected.

5789130-100 English Rev.5
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When there's too much leakage current ...

10-8-3 Probe Fails

Test the probe in another connector to isolate if the fault lies with
the probe or the Ultrasound system. Or Change another probe
to confirm if the fail is caused by console.

NOTE: Each probe will have some amount of leakage, dependent on its
design. Small variations in probe leakage currents are normal
from probe to probe. Other variations will result from differences
in line voltage and test lead placement. The maximum allowable
leakage current for body surface contact probe differs from
inter-cavity probe. Be sure to enter the correct probe type in the
appropriate space on the check list.

If excessive leakage current is slot dependent, inspect the
system connector for bent pins, poor connections, and ground
continuity.

If the problem remains with the probe, replace the probe.

10-8-4 Peripheral Fails

Tighten all grounds. Ensure star washers are under all ground
studs.

Inspect wiring for bad crimps, poor connections, or damage.

10-8-5 Still Fails
If all else fails, begin isolation by removing the probes, external

peripherals, then the on board ones, one at a time while
monitoring the leakage current measurement.

10-8-6 New Unit
If the leakage current measurement tests fail on a new
Ultrasound system and if situation can not be corrected, submit

a Safety Failure Report to document the Ultrasound system
problem. Remove Ultrasound system from operation.

10-8-7 ECG Fails

Inspect cables for damage or poor connections.

Versana Premier — Basic Service Manual
5789130-100 English Rev.5
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10-9 Inspection

10-9-1 Ultrasound Inspection Forms

ULTRASOUND INSPECTION CERTIFICATE

Paperwork

Customer Name: System ID: Dispatch Number / Date Performed: Warranty/C ontract/HBS
System Type Model Number: Serial Number: Manufacture Date:
Probe 1: Frequency: Scan Format*: Model Number: Serial Number:

Probe 2: Frequency: Scan Format*: Model Number: Serial Number:

Probe 3: Frequency: Scan Format*: Model Number: Serial Number:

Probe 4: Frequency: Scan Format*: Model Number: Serial Number:

Probe 5: Frequency: Scan Format®: Model Number: Serial Number:

10-36
=

* Scan Format: Phased Array, Linear Array,

5
i

Curved Array, Mechanical Array or Other

Figure 10-5. Ultrasound Inspection Certificate

* Scan Format: Phased Array, Linear Array, Curved Array,
Mechanical Array or Other

System view
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Inspection Paperwork

10-9-1 Ultrasound Inspection Forms(continued)

FUNCTIONAL CHECKS PHYSICAL INSPECTION AND CLEANING
OK? or Physical Inspection and Cleaning
Functional Check  (if applicable) N/A (if applicable) Inspect Clean

B-Mode Function Console

Doppler Modes Function LCD

CF-Mode Function External I/O

M-Mode Function Cables and Connectors

Applicable Software Opti ons GE Approved Peripherals (DVD-RW, Printer)

Applicable Hardware Options Labeling (see User Manual for Labeling)

Control Panel

LCD

Measurement Accuracy

GE Approved Peripherals

COMMENTS:
Figure 10-6. Functional Checks
ELECTRICAL SAFETY
Max Value Value
Electrical Test Performed Allowed Measured OK? Comments
Outlet (correct ground &wiring config.)
Type BF Applied Part Leakage Current
Limits- Probe
enclosure Source Leakage Current -
Chassis Leakage Current Limits
Peripheral 1 Leakage Current
Peripheral 2 Leakage Current
PROBES
Probe Number Max Value Max Value
(from previous page) Allowed Measured OK? Comments
Probe 1:
Probe 2:
Probe 3:

Final Check. All system covers are in place. System scans with all probes as expected.

Accepted by:

Figure 10-7. Electrical Safety

Versana Premier — Basic Service Manual — System view 10-37
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10-10 Electrical Safety Tests Log

Table 10-20:  Electrical safety tests log
Electrical test Max Value OK? Comments
performed value measured
allowed

Outlet (correct ground
and wiring config.)

System ground
continuity

Chassis source
leakage current -
probe

Chassis source
leakage current -
wheel

Chassis source
leakage current -
monitor

Patient lead source
leakage (lead to
ground)

Patient lead source
leakage (lead to lead)

Patient lead source
leakage (isolation)

Peripheral 1 leakage
current

Peripheral 1 ground
continuity

Peripheral 2 leakage
current

10-38 é System view
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Electrical Safety Tests Log

Table 10-20:  Electrical safety tests log (Continued)

Electrical test
performed

Max Value OK? Comments
value measured
allowed

Peripheral 2 ground
continuity

Peripheral 3 leakage
current

Peripheral 3 ground
continuity

Table 10-21:  Electrical safety tests (probes) log

Max Max value OK? Comments
value measured
Probe allowed
Versana Premier — Basic Service Manual ; System view 10-39
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A

abbrevations, 9-3
acclimate time, 2-3
air filter
removing, 4-27
authorized representative in EU, 1-29
average setup time, 3-3

B

before installation (site preparations), 2-1
Boot Up, 3-24
Buttons screen

Connectivity, 3-84

Cc

cable inspection

mains cable inspection, 10-14
Care and maintenance

cleaning the system

operator controls, 4-29

care and maintenance, 10-1

warnings, 710-3
CE compliance, 1-25
change history, i-1
chapter 1

introduction, 7-1
chassis leakage current test, 10-30
cold or hot

if the unit is very cold or hot, 2-3
compatibility

hardware/software, 9-4
completing the setup, 3-20
compliance, 1-25
configuration, 3-25
connect

ethernet, 3-24

probe, 3-24

USB flash card, 3-24
connections

on the rear panel, 3-24
Connectivity

Buttons, 3-84
console environmental requirements, 2-3
console requirements, 2-3
contact information, 7-27
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contents in this manual, 7-3
conventions used in book, 7-7
cooling, 2-5
copyrights, i-16
customer assistance, 1-27

phone numbers, 1-28
customer order

verification, 3-19
customer provided prerequisite, 8-9

D

damage

in transportation, 3-71
damage in transport, i-14
dangerous procedure warnings, 7-22
data network setup requirements, 2-18
desirable features, 2-15
DICOM network function, 2-19
DICOM setup requirements, 2-20
display PDF files

from manual CD-ROM

print PDF files
from manual CD-ROM, 4-24

E

electrical requirements, 2-6
EMI limitations
EMI limitations, 2-9
general requirements, 2-6
site circuit breaker
site circuit breaker, 2-7
site power outlets
site power outlets, 2-6, 2-7
specific requirements for the unit, 2-6
unit power plug
unit power plug, 2-7
electrical safety, 1-20
electrical safety tests, 10-24
electrical specification, 3-21
electromagnetic interference
abatement, 2-10
prevention, 2-10
electrostatic discharge prevention, 1-26
EMC, 1-25
compliance, 1-25
what is EMC?, 1-25
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EMI, 1-25
abatement, 2-10
prevention, 2-10
protection, 3-19
environmental dangers, 2-21
environmental specifications for the unit, 2-4
errors, i-15
ESD, 1-25
ESD prevention, 71-26
ethernet
connect, 3-24
examine packages, 3-8
external 1/O
connections, 3-24

F

facility needs, 2-12

desirable features, 2-15

DICOM network function, 2-19

DICOM setup requirements, 2-20

InSite requirements, 2-18

network setup requirements, 2-18

purchaser responsibilities, 2-13

recommended floor plan suggestion, 2-17

required facility needs, 2-14

suggested floor plan

scanner and EchoPAC in same room, 2-18

flash card

connect, 3-24
floor plan suggestion

recommended, 2-17

scanner and EchoPAC in same room, 2-18
functional checks, 10-13

mains cable inspection, 10-14

system checks, 70-13

G

GE Healthcare leakage current limits, 10-26
general console requirements, 2-3

generic procedure on probe leakage current, 70-33
grounding continuity, 10-29

H

hardware/software compatibility, 9-4
hardware-software

compatibility, 5-3
hot or cold

if the unit is very cold or hot, 2-3
how often should maintenance tasks be performed?,
10-6
human safety, 7-14

icons, 1-7
icons indicating a special procedure to be used, 7-10

Index-2

if the unit is very cold or hot, 2-3
important precautions, i-2
InSite

network requirements, 2-18
installation

see "system setup”, 3-1
installation warnings

see "setup warnings", 3-3
introduction (chapter 1), 1-1

L

labels
transportation box label, 3-71
legal notes, i-16
lighting, 2-5
list of abbrevations, 9-3
loading software, 8-9
lockout/tagout (LOTO) requirements, 7-23
LOTO
lockout/tagout requirements, 7-23

M

mains cable inspection, 10-14
maintenance
physical inspection, 10-16
preliminary checks, 10-12
system maintenance, 10-12
maintenance task schedule, 10-6
manufacturer, 7-28
mass
with monitor and peripherals, 3-20
mechanical safety, 1-17
model designations, 1-7
models covered by this manual, 7-5

N

network setup requirements, 2-18

0

omission and errors, i-15
operational and storage temperature for probes, 2-11
Operator controls, 4-29

P

packing materials
recycling information, 3-18
paperwork
after setup, 3-99
PDF files
display and print, 4-24
periodic maintenance inspection (PM), PM (periodic
maintenance inspection), 10-4
phone numbers
customer assistance, 7-28
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physical dimensions, 3-20
physical inspection
at arrivel, 3-19
position
of tilt and shock indicators, 3-9
Power On, 3-24
precautions
certified electrical contractor statement, i-14
damage in transport, i-14
important precautions, i-2
service safety considerations, i-15
translation policy, i-2
prepeare for setup, 3-19
prerequisite
provided by customer, 8-9
print keys
assigning to a device or dataflow, 3-84
probe
connect, 3-24
probe cleaning, 10-19
probe leakage current test, 10-32
probe maintenance, 10-18
basic probe care, 10-18
basic probe cleaning, 10-19
probe related checks, 10-18
probe related checks, 10-18
probes environmental requirements, 2-11

operational and storage temperature for probes,

2-11
product icons, 1-11
product locator installation card, 3-100
products covered by this manual, 7-5
proprietary to GE Healthcare, i-16
Purchaser responsibilities, 2-13

R

rear panel

connections, 3-24
receiving and unpacking, 3-6
receiving the product, 3-8
recycling information

packing materials, 3-18
removable media

verifying, 3-87
required facility needs, 2-14
requirements, 2-3
requirements verification, 3-20
returning/shipping probes and repair parts, 1-24
revision history, i-1

S

safety

human, 1-14
safety precaution messages, 7-8
safety test overview, 10-24
service safety considerations, i-15
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setup
completion, 3-20
preparations, 3-19
reminders, 3-3
setup time, 3-3
setup warnings, 3-3
shipping/returning probes and repair parts, 7-24
shock and tilt indicators
position, 3-9
shock indicator, 3-7
site preparations, 2-1
time and manpower requirements, 2-11
software loading, 8-9
software/hardware compatibility, 9-4
software-hardware
compatibility, 5-3
specifications, 3-20
electrical specifications, 3-21
physical dimensions, 3-20
standard GE tool kit, 10-8
standard hazard icons, 7-9
statement
certified electrical contractor statement, i-14
system
specifications, 3-20
system checks, 70-13
system maintenance, 10-12
physical inspection, 10-16
preliminary checks, 10-12
system manufacturer, 1-28
system requirements verification, 3-20
system setup, 3-1

T

tilt and shock indicators
position, 3-9
tilt indicator, 3-7
time and manpower requirements
site preparations, 2-11
tools required, 10-8
special tools, supplies and equipment, 70-11
standard GE tool kit, 10-8
trademarks, i-16
translation policy, i-2
transport
damage, i-14
transportation
shock indicator, 3-7
tilt indicator, 3-7
transportation box label, 3-71
typical users of the service manual, 7-4

U

unpacking, 3-6
usB
flash card
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connect, 3-24
\/

verification

system requirements, 3-20
verify customer order, 3-19
verifying

removable media, 3-87
voltage settings, 3-21

w

warnings, 10-3
dangerous procedures, 71-22
receiving and unpacking, 3-6
what is EMC?, 1-25
when there’s too much leakage current, 10-35
chassis fails, 10-35
ECG fails, 10-36
new unit, 10-36
peripheral fails, 10-36
probe fails, 10-36
still fails, 10-36
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